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DISCLAIMER

RED® has made every effort to provide clear and accurate information
in this document, which is provided solely for the user’s information.
While thought to be accurate, the information in this document is
provided strictly “as is” and RED will not be held responsible for issues
arising from typographical errors or user’s interpretation of the language
used herein that is different from that intended by RED. All information is
subject to change as a result of changes in local, federal or other
applicable laws.

RED reserves the right to revise this document and make changes from
time to time in the content hereof without obligation to notify any person
of such revisions or changes. In no event shall RED, its employees or
authorized agents be liable to you for any damages or losses, direct or
indirect, arising from the use of any technical or operational information
contained in this document.

This document was generated on 9/1/2023. To see earlier versions of
this document, submit a Support ticket at https://support.red.com.

For comments or questions about content in this document, send a
detailed email to OpsGuides@red.com.

COPYRIGHT NOTICE

COPYRIGHT® 2023 RED.COM, LLC

All trademarks, trade names, logos, icons, images, written material,
code, and product names used in association with the accompanying
products are the copyrights, trademarks, or other intellectual property
owned and controlled exclusively by RED.COM, LLC. For a
comprehensive list, see www.red.com/trademarks.

TRADEMARK DISCLAIMER

All other company, brand, and product names are trademarks or
registered trademarks of their respective holders. RED has no affiliation
to, is not associated with or sponsored by, and has no express rights in
third-party trademarks. Adobe and Adobe Premiere Pro are registered
trademarks of Adobe Systems Incorporated. DaVinci and DaVinci
Resolve are registered trademarks of Blackmagic Design in the U.S. and
other countries. Leica is a registered trademark of Leica Microsystems.
Canon is a registered trademark of Canon, U.S.A. Apple, iOS,
Macintosh, Final Cut Pro, and QuickTime are registered trademarks of
Apple Inc. in the U.S. and other countries. Windex is a registered
trademark of S. C. Johnson & Son, Inc. Windows is a registered
trademark of Microsoft Corporation. Avid is a registered trademark of
Avid Technology, Inc. FileZilla is a registered trademark of its respective
owners. Nuke™ is a trademark of The Foundry Visionmongers Ltd.
SCRATCH is a registered trademark ® of ASSIMILATE, 2006. SCRATCH
SCAFFOLDS, SCRATCH EXTENSIONS, and SCRATCH Digital
Intermediate Process Solution are all trademarks and registered
trademarks of ASSIMILATE, 2006, All rights reserved. Autodesk, the
Autodesk logo, Flame are registered trademarks or trademarks of
Autodesk, Inc., and/or its subsidiaries and/or affiliates in the USA and/or
other countries.

COMPLIANCE STATEMENTS
INDUSTRIAL CANADA EMISSION COMPLIANCE STATEMENTS

This device complies with Industry Canada license-exempt RSS
standards RSS 139 and RSS 210. Operation is subject to the following
two conditions: (1) this device may not cause interference, and (2) this
device must accept any interference, including interference that may
cause undesired operation of the device.

This Class B digital apparatus complies with Canadian ICES-003.

To comply with FCC and Industry Canada RF exposure limits for general
population/ uncontrolled exposure, the antenna(s) used for this
transmitter must be installed to provide a separation distance of 70 mm
from all persons and operating in conjunction with any other antenna or

COPYRIGHT © 2023 RED.COM, LLC

transmitter, except in accordance with FCC multi-transmitter product
procedures.

Other user manual statements may apply.

Le présent appareil est conforme aux CNR d’Industrie Canada
applicables aux appareils radio exempts de licence. L’exploitation est
autorisée aux deux conditions suivantes : (1) I’appareil ne doit pas
produire de brouillage, et (2) I'utilisateur de I'appareil doit accepter tout
brouillage radioélectrique subi, méme si le brouillage est susceptible
d’en compromettre le fonctionnement.

Cet appareil numérique de la classe B est conforme & la norme NMB-
003 du Canada.

Pour se conformer aux limites d’exposition aux RF de la FCC et
d’industries Canda pour la population générale/ exposition non
controlee, I'antenne(s) utilisée pour ce transmetteur doit étre installé
pour fournir une distance de separation d’au moins 70 mm de toutes les
personnes et fonctionnant conjointement avec une autre antenne ou
émetteur, saufen conformité avec les proceédures de produits multi-
émetteur FCC.

Autres d’eclarations manuel de I'utilisateur peuvent s’appliquer.

FEDERAL COMMUNICATIONS COMMISSION (FCC) STATEMENTS

This equipment has been tested and found to
comply with the limits for a Class A digital device,
pursuant to part 15 of the FCC Rules. These
limits are designed to provide reasonable
protection against harmful interference when the
equipment is operated in a commercial
environment. This equipment generates, uses, and can radiate radio
frequency energy and, if not installed and used in accordance with the
instruction manual, may cause harmful interference to radio
communications. Operation of this equipment in a residential area is
likely to cause harmful interference in which case the user will be
required to correct the interference at his own expense.
To maintain compliance with FCC regulations, shielded cables must be
used with this equipment. Operation with non-approved equipment or
unshielded cables is likely to result in interference to radio and TV
reception. The user is cautioned that changes and modifications made
to the equipment without the approval of manufacturer could void the
user's authority to operate this equipment.
This device complies with Part 15 of the FCC Rules.
Operation is subject to the following two conditions (1) this device may
not cause harmful interference, and (2) this device must accept any
interference received, including interference that may cause undesired
operation.

iz CAUTION: Exposure to Radio Frequency Radiation.

The device shall be used in such a manner that the potential for human
contact is minimized.
This equipment complies with FCC radiation exposure limits set forth for
an uncontrolled environment. This equipment should be installed and
operated with a minimum distance of 20 cm between the radiator and
your body.
CAUTION: Regulations of the FCC and FAA prohibit airborne
operation of radio-frequency wireless devices because their
signals could interfere with critical aircraft instruments.

CAUTION: If the device is changed or modified without
permission from RED, the user may void his or her authority
to operate the equipment.
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AUSTRALIA AND NEW ZEALAND STATEMENTS
RED declares that the radio equipment described in this document

complies with the following international standards:

e |EC 62368-1 — Product Safety

e ETSI EN 300 328 - Technical requirement for radio equipment
RED declares digital devices described in this document comply with
the following Australian and New Zealand standards:

e AS/NZS CISPR 32 - Electromagnetic Interference

e AS/NZS 61000.3.2 — Power Line Harmonics

e AS/NZS 61000.3.3 - Power Line Flicker

SOUTH KOREA STATEMENTS

1. Equipment Name/Model Name: Komodo-X / Komodo-X

2. Registration No.: R-R-DV5-2023KX001, R-R-R3d-2022LSR001

3. Applicant Name:® C|=20|2lAjo| =

4. Manufacture Date: 2023

5. Manufacturer/Country of Origin: RED Digital Cinema, LLC / USA

JAPAN STATEMENTS

This equipment contains specified radio equipment that has been
certified to the Technical Regulation Conformity Certification under the
Radio Law.

ABB L, MPRICKS<ERNEMESERSERT
BIERBRT RAAEZERALTBYET,

The 5GHz band Is limited to indoor use by Radio Law.
WEECLYSGHANIBAER (CRYVET,

@ [R]201-200402
T

EUROPEAN UNION COMPLIANCE STATEMENTS
RED declares that the radio equipment described

c € in this document complies with the EMC Directive
(2014/30/EU) and the Low Voltage Directive
(2014/35/EU) issued by the Commission of the
European Community.

Compliance with this directive implies conformity to the following

European Norms (in brackets are the equivalent international standards).

EN 62368-1 (IEC 62368-1) — Product Safety

ETSI EN 300 328 Technical requirement for radio equipment

ETSI EN 301 489 General EMC requirements for radio equipment

EN 55032 (CISPR 32) Electromagnetic Compatibility

EN 55035 (CISPR 35) Immunity Requirements

EN 61000-3-2 (IEC 61000-3-2) Harmonic Current Emissions

EN 61000-3-3 (IEC 61000-3-3) Voltage changes, voltage fluctuations
and flicker

e EU 2015/863 RoHS Directive

COPYRIGHT © 2023 RED.COM, LLC

WASTE ELECTRICAL AND ELECTRONIC EQUIPMENT (WEEE)

The Waste Electrical and Electronic Equipment
(WEEE) mark applies only to countries within the
European Union (EU) and Norway. This symbol,
on the product and accompanying documents,
means that used electrical and electronic
products should not be mixed with general
household waste. For proper treatment, recovery
and recycling, take this product to designated
collection points where it will be accepted free of
charge. Alternatively, in some countries you may
be able to return your products to your local retailer upon purchase of
an equivalent new product.
Disposing of this product correctly will help save valuable resources and
prevent any potential negative effects on human health and the
environment, which could otherwise arise from inappropriate waste
handling. Contact your local authority for further details of your nearest
designated collection point. Penalties may be applicable for incorrect
disposal of this waste, in accordance with your national legislation.
For business users in the European Union, if you wish to discard
electrical and electronic equipment, contact your dealer or supplier for
further information.

RESPONSIBLE PARTY

RED Digital Cinema

94 Icon

Foothill Ranch, CA 92610
USA
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SAFETY INSTRUCTIONS

This equipment is intended to be used by instructed personnel and is
not intended to be used by children.

DO NOT use the camera or accessories near water. Avoid exposing
your camera to moisture. The unit is not waterproof, so contact with
water could cause permanent damage to the unit as well as electric
shock and serious injury to the user. DO NOT use the camera in the
rain or under other conditions with high moisture without appropriate
protection, and immediately remove power source if camera or
accessories are exposed to moisture.

WARNING: To reduce the risk of fire or electric shock, do not
expose the camera to rain or moisture.

DO NOT point the camera directly into extreme light sources such as
the sun or lasers. Permanent damage to optical path or sensor may
occur, which is not covered by manufacturer’s warranty.

DO NOT expose your camera to excessive vibration or impact
(shock). Be careful not to drop your camera. Internal mechanisms
may be damaged by severe shock. Mechanical alignment of optical
elements may be affected by excessive vibration.
ELECTROMAGNETIC INTERFERENCE: The use of devices using
radio or other communication waves may result in the malfunction or
interference with the unit and/or with audio and video signals.

Clean only using a dry cloth. When cleaning your camera, remember
that it is not waterproof and moisture can damage electronic circuitry.
DO NOT rinse or immerse any element of the camera, lens or other
accessory, keep them dry at all times. DO NOT use soaps,
detergents, ammonia, alkaline cleaners, and abrasive cleaning
compounds or solvents. These substances may damage lens
coatings and electronic circuitry.

Maintain sufficient ventilation—DO NOT block any ventilation
openings or obstruct cooling fan airflow.

CAUTION: Proper camera ventilation requires a minimum

0.5" (1.25 cm) clearance between the camera ventilation
openings and external surfaces. Verify that objects that can
block the fan intake and exhaust ports do not impede airflow.
Failure to permit adequate airflow may result in overheating of
the camera, degraded operation, and in extreme situations,
damage to the camera.

WARNING: Media cards can become very hot during
prolonged recording sessions. When ejecting the media card,
let it cool before touching it with bare fingers.

DO NOT operate or store near any heat sources such as radiators,
heat registers, stoves, or any other apparatuses that produce heat.
Store in a protected, level and ventilated place. Avoid exposure to
temperature extremes, damp, severe vibration, strong magnetic fields,
direct sunlight or local heat sources during storage. Remove any
batteries from the camera before storage. Recommended storage
and usage temperatures for your camera, lenses and other
accessories are:

o Operating range: 32° F to 104° F (0° C to 40° C)

o Storage range: —4° F to 122° F (-20° C to 50° C)

If there are any performance issues with your camera or accessories
when operating within this temperature range, submit a support ticket
to https://support.red.com.

23 RED.COM, LLC

e DO NOT bypass the third prong of the grounding-type plug on the
power cord of the included power adaptor. A grounding-type plug
has two blades and a third “grounding” prong. The third prong is
provided for your safety. You must connect the plug to an outlet with
a protective earth connection. If the grounding-type plug does not fit
into your outlet, do not attempt to modify the plug or outlet, consult a
qualified electrician.

e Protect all power cords from being pinched, walked on, or driven over
by a vehicle. Replace any power cords suspected of sustaining
damage due to crushing or other forms physical damage.

JAN

CAUTION: Install this camera in a proper support system that
can handle the entire weight of the camera and the
accessories. Secure the camera by using the %-20 and/or the
3/8-16 mounting points located on the bottom of the camera.
Always verify that the screws are tightened properly. When
the camera is not properly attached, or is placed on an
unstable surface, the camera can fall and cause injury or be
damaged.

CAUTION: Products marked with this symbol are Class 2
devices. These double insulated devices are not provided
with a grounding type plug.

CAUTION: The power cord plug for the included power
adaptor is used as the power disconnect. To disconnect all
power from the power adaptor, unplug the power cord plug
from the wall outlet. During use, the power cord plug should
remain easily accessible at all times.

[]

e Lithium-ion batteries may be subject to special handling requirements
pursuant to federal and local laws. Refer to specific shipping
instructions included with your battery regarding proper transport of
your battery. Do not handle your battery if it is damaged or leaking.
Disposal of batteries must be in accordance with local environmental
regulations. For example, California law requires that all rechargeable
batteries must be recycled by an authorized recycle center. Storing
batteries fully charged or in high temperature conditions may
permanently reduce the life of the battery. Available battery capacity

may also be temporarily lessened after storage in low temperature
conditions.

WARNING: DO NOT expose the battery to excessive heat.

CAUTION: Refer all service and repair to qualified RED
service personnel. To reduce the risk of electric shock, and
damage to the camera or accessories, DO NOT attempt to
perform any servicing other than any procedures that are
recommended in the operating instructions.

INDOOR USE ONLY: This device is designed primarily for
indoor use.

A
JAN
5

e El aparato no debe quedar expuesto a goteo o salpicadureas por
liquidos.

BATTERY STORAGE AND HANDLING
e Read and adhere to all safety instructions provided by the
manufacturer of the batteries.

WARNING: Failure to read, understand, and follow these
instructions may result in overheating, chemical leakage,
smoke emission, fire, or other potentially harmful results.

WARNING: Only replace the battery with a battery of the
same type, or with a battery that is equivalent.

0218, REVB | vi
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e Always follow proper battery handling and storage practices. e If the battery leaks and the electrolyte reaches the eyes, do not rub
Improper handling and failure to abide by proper storage instructions them. Instead, rinse the eyes with clean running water and
may cause permanent damage to batteries, or degrade battery immediately seek medical attention. Failure to do this may result in
charge holding capacity. Improper handling practices or failure to eye injury.

comply with instructions may also put you at risk.

e Lithium-lon batteries, like the REDVOLT Micro-V, self-discharge over
time. When storing for long periods of time, store batteries separately
from the camera or charger and remember to charge batteries to a
capacity level of 40% to 60%. If batteries will be stored for long
periods of time, RED recommends that you check the charge level at
least once every six (6) months, and recharge batteries to a capacity
level of 40% to 60%.

e When not in use, remove the battery from the camera or charger and
store the battery in a cool, dry place. Avoid extreme hot temperatures
(such as inside a hot car), corrosive gas, and direct sunlight. The
optimal storage temperature for batteries is between
—4° F to 68° F (-20° C to 20° C).

WARNING: Batteries stored in a discharged state for long
periods of time may self-discharge and lose the ability to hold

a charge.

WARNING: If recharging operation fails to complete even
after a specified recharging time has elapsed, immediately
stop further recharging.

e DO NOT store batteries in a fully charged state for extended periods
of time.

e DO NOT store batteries in a fully discharged state for extended
periods of time.

e DO NOT store batteries in the camera or in a charger for extended

periods of time.

DO NOT use batteries for purposes other than their intended use.

DO NOT store batteries in extreme hot or cold temperatures.

DO NOT store batteries in direct sunlight.

DO NOT disassemble or modify the battery.

DO NOT overcharge batteries. Overcharging may increase internal

temperature beyond the recommended limits and cause permanent

damage to the battery.

e DO NOT connect the positive (+) and negative (-) terminals to a metal
object such as a wire.

e DO NOT transport or store the battery together with metal objects
such as jewelry, hairpins, etc. as they may generate heat if they come
into contact with the battery.

e DO NOT discard the battery into fire or heat.

DO NOT store, use, or recharge the battery near a heat source such

as a fire or a heater.

DO NOT allow the battery to get wet.

DO NOT pierce the battery with pointed or other sharp objects.

DO NOT step on, throw, or strike the battery with a hammer.

DO NOT use a battery that appears to be deformed or damaged.

DO NOT directly solder the battery.

DO NOT put the battery into a microwave oven or a pressurized

container.

e DO NOT use or subject the battery to intense sunlight or hot
temperatures such as in a car in hot weather.

e DO NOT use it in a location where static electricity may be present.

e DO NOT exceed the recharging temperature range of 32° F to 104° F
(0° C to 40° C).

e Store the battery in a location where children cannot reach it.

e If the battery leaks or gives off a bad odor, discontinue use
immediately.

e If the battery gives off an odor, generates heat, becomes discolored
or deformed, or in any way appears abnormal during use, recharging
or storage, immediately remove it from the equipment or battery
charger and discontinue use.

e If electrolyte begins leaking from the battery and comes into contact
with your skin or clothing, immediately wash it away with running
water. Failure to do this may result in skin inflammation.

COPYRIGHT © 2023 RED.COM, LLC 955-0218, REV B | vii
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1. INTRODUCTION
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Figure: RED KOMODO-X™ camera

RED KOMODO-X™

KOMODO-X is the next evolution in the KOMODO family, multiplying the frame rates, dynamic range, and usability of
the original KOMODO to break new grounds.

NEXT GENERATION KOMODO SENSOR

KOMODO-X features the same sized 6K S35 Global Shutter sensor as the KOMODO, but with a ground up redesign
and key architecture improvements.

Improved detail and color in shadows, paired with double the frame rates at 6K 80P and 4K 120P makes KOMODO-X
an even more powerful tool for creatives.

ENHANCED BODY AND 1I/0

With key improvements for professional workflows, the KOMODO-X now shares many features with the DSMC3 line
while still maintaining the impressively small KOMODO form factor. An integrated micro V-Lock allows for direct
attachment of professional micro V-Lock batteries without the need for adapters and is also compatible with the
upcoming RED PRO I/0 Module to provide auxiliary power and compatibility with full sized V-Lock and Gold Mount
batteries.

A reinforced RF lens mount with locking mechanism maintains the flexibility of toolless switching between multiple lens
mount types, while providing the stability and rigidity professionals need. KOMODO-X is also fully compatible with /i PL
lenses using the RED RF to PL Adapter.

12G SDI, full sized DC-IN, USB Type-C, and a phantom powered locking audio connector further enables KOMODO-X

to seamlessly integrate into any professional workflow. KOMODO-X is compatible with DSMC3™ RED® 5-Pin to Single

3.5 mm Adapter to support existing KOMODO microphones, or the DSMC3™ RED® 5-Pin to Dual XLR Adapter for
general purpose XLR microphones.

COPYRIGHT © 2023 RED.COM, LLC 955-0218, REVB | 1



KOMODO-X" OPERATION GUIDE

An integrated 2.9” LCD allows for simplified control and image preview in compact setups. For more precise monitoring,
KOMODO-X supports the DSMC3 7” Touch LCD which provides a daylight viewable, high-resolution, camera top
monitor and control solution without the mess of cables.

IP CONNECTED

KOMODO-X is a powerful platform for any IP based workflow, from Virtual Production to Live Broadcast. With
integrated USB Type-C connection and built-in Wi-Fi, remotely control the camera using RED Control or RED Control
Pro, as well as IP media offloading using FTPS or in-camera Cloud Uploading functionality. In addition, KOMODO-X
supports frame-accurate PTP synchronization or tri-level genlock sensor sync with the ability to offset on the fly to
support multi-camera LED volume productions.

KOMODO-X also supports RED Connect, a licensed feature that allows for live broadcasting of 6K images directly from
the camera over IP, expanding RED’s cinematic imagery into boundless new uses.

QUICK REFERENCE

Refer to the Quick Reference section to get familiar with this guide and the camera.

R3D FILE FORMAT AND REDCODE

All videos and frames are recorded to the R3D® file format. The R3D file format was developed by RED to provide an
efficient and manageable RAW video data format that promotes advanced post-production editing capabilities. In the
R3D file format, the digital image received from the sensor is formatted as a pixel-defect corrected (but in all other
aspects unprocessed) 16-bit per pixel RAW data frame. Each RAW frame, or sequence of RAW frames in a clip, is
compressed using proprietary REDCODE® RAW compression, then stored to media.

RAW data is recorded independently of any RGB domain color processing such as ISO, White Balance, or other RGB
color space settings. Instead, color parameters are saved as reference metadata; that is, color is not burned into the
recorded RAW data. This innovative recording technique promotes flexibility in RGB color processing. It allows you to
defer color correction to post-production, or to adjust the image color in the field, without changing the recorded RAW
data image quality or dynamic range.

REDCODE is a compression codec that reduces R3D RAW files down to a manageable size, allowing the media to
record longer. The ability to compress RAW data is one of the significant technological advances that RED has brought
to the motion picture industry.

GLOBAL SHUTTER

This camera employs global shutter technology. This technology exposes all of the sensor's pixels in each frame
simultaneously, unlike a rolling shutter that exposes lines of pixels (each with a delay) causing image artifacts on fast-
moving objects. Global shutter technology not only improves the visual appearance of this camera's images, it also
eliminates tracking and matte-painting distortions during post production.

IMAGE PROCESSING PIPELINE

This camera uses RED's Image Processing Pipeline 2 (IPP2). In IPP2, the advanced RED color space
(REDWideGamutRGB) allows the camera to use every color that the sensor can generate up to the clipping threshold.
Then the camera encodes the image using Log3G10, a gamma curve that retains extreme highlight and shadow detail.
Using the advanced color space and gamma curve, RED IPP2 allows you to grade and make color adjustments in post-
production, instead of in-camera. IPP2 also allows the camera to use a CDL for grading. For more information about
IPP2, refer to the RED IPP2 support page.

SHOOT FOR VIDEO AND STILLS

High resolution video, such as the digital footage captured by the camera, has surpassed the detail necessary to
produce professional full-sized prints. Because the camera is able to record RAW video at high frame rates and
resolution, this camera is ideally suited to capture video and still images simultaneously while still preserving the full
flexibility that RAW still photographers have come to expect.
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POST-PRODUCTION

Many non-linear editing systems (NLEs) can open and edit RED footage, allowing full RAW control and flexibility without
any need to re-transcode. Each NLE version may have specific compatibility requirements, such as camera firmware
version or camera type. Before shooting, make sure you check all of the compatibility requirements.

You can open and/or edit R3D files by using one of the following products:

® REDCINE-X PRO: RED's proprietary application. Download REDCINE-X PRO for Windows or REDCINE-X PRO for
Mac from www.red.com/downloads.

® Adobe Premiere Pro

®* Avid Media Composer

® DaVinci Resolve

® Final Cut Pro X: Requires you to download the RED Apple Workflow Installer from www.red.com/downloads.
® Foundry Nuke

® Assimilate Scratch

® AutoDesk Flame

® ColorFront Transkoder (beta for latest support)

® Pomfort Silverstack

NOTE: Third-party applications may have limited compatibility with R3D files. Third-party developers must use the most
recent R3D SDK to offer compatibility with the latest RED firmware.

POST-PRODUCTION WITH REDCINE-X PRO

REDCINE-X PRO is a professional one-light coloring tool set, equipped with an integrated time line, and with a
collection of post effects software. REDCINE-X PRO provides the ideal environment to review recorded footage, edit
metadata, organize projects, and prepare your R3D files. You can use REDCINE-X PRO or any of the compatible third-
party NLEs to edit R3D files.

ADDITIONAL RESOURCES

* RED.com: Visit the official RED website for the latest information about RED products.

° RE‘tD Downloads: Go to RED Downloads to download the latest firmware, operation guides, and post-production
software.

* RED 101 Articles: RED offers in-depth technical articles about RED cameras, post-production, and digital
cinematography.

* RED TECH Videos: RED offers videos about understanding and using RED cameras.

® RED Support: Visit the RED SUPPORT site for support articles or to file a support ticket.

O
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2. QUICK REFERENCE

Congratulations new RED KOMODO-X™ 6K S35 camera owner. This quick reference topic helps you get familiar with
this guide and the Camera Body. It includes links to topics about configuring the camera to fit your recording
requirements, and for learning the basic operation of the camera.

PREPARING THE CAMERA HARDWARE

Prepare the camera hardware for recording by:

® Attaching accessories (refer to Accessories)

® |nstalling Lenses and Adapters

® |nserting the Media

® Connecting a power source (refer to Power or Accessories)
® Turning On the Camera

PREPARING THE CAMERA SYSTEM

Configure the camera settings to prepare for recording by:

® Configuring the camera system settings (refer to the System Settings Menu)

® Upgrading the Firmware and Upgrading the DSMC3™ RED® Touch 7.0" LCD Firmware

® Calibrating the camera using the Calibrate feature

® Formatting the media (refer to Secure Format)

® Specifying the desired recording resolution (refer to Format)

® Configuring the Recording Frame Rate and Project Time Base

® Setting the exposure (refer to Shutter)

® Configuring the monitoring tools and reviewing the monitored image (refer to the Monitoring Menu)
® Reviewing the camera status (refer to System Status)

RECORDING

Start recording your project.

® Record by pressing the REC button on the Camera Body, Outrigger Handle, or RED® Compact Top Handle
® Record by using the Top LCD (refer to DSMC3™ RED® Touch 7.0" LCD)

® Record by using an external trigger (refer to Extension Port)

® Start, stop, and control the camera by using USB-C (refer to USB-C Configuration)

® Start, stop, and control the camera by using Wi-Fi (refer to How To)

PROCESSING FOOTAGE

Perform post-production using any of the standard applications.
® Adobe® Premiere® Pro

* Avid® Media Composer®
® DaVinci Resolve®

® Final Cut Pro X®

NOTE: Third-party applications may have limited compatibility with R3D files. Third-party developers must use the most
recent R3D SDK (8.3 or later) to offer compatibility with the latest RED firmware.
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3. CAMERA COMPONENTS

CAMERA BODY

This section describes the Front, Top, Left, Right, Back, and Bottom of the camera, and identifies the controls, buttons,
Camera Body LEDs, and the lens mount on the body.

CAMERA BODY CONTROLS AND FEATURES

This section describes the controls and features of the camera.

FRONT

IIE DIGITAL CINEMA

KOMODO -X

Figure: Camera Body Front Controls and Features

# ITEM DESCRIPTION

1 Lens release Press to release RF-type lenses

2 Mic 1 Left Internal Microphone channel

3 Tally light Tally light (refer to Camera Body LEDs and Indicators)

4 Mic2 Right Internal Microphone channel

5 Front REC button Press and release the REC button to toggle between record start and stop
6 Lens locking ring Rotate to lock and unlock lenses
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TOP
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Figure: Camera Body Top Controls and Features

ITEM

DESCRIPTION

LCD Touchscreen

Camera Onboard LCD Touchscreen

MENU (BACK) Button

Menu button, Back button

W IN|[—= |+

Button

Up Arrow (LOCK)

Navigates up in the menu and locks/unlocks the Ul when pressed along with the other
Lock button

4 Down Arrow (LOCK)

Button

Navigates down in the menu and locks/unlocks the Ul when pressed along with the other
Lock button

5 Select Button

Selects the highlighted menu item

Playback Button

Opens the Playback screen

1/4-20 Mounting

Holes

1/4-20 mounting holes for optional accessories (refer to Outrigger Handle, DSMC3™
RED® Touch 7.0" LCD)

8 Accessory Port

Connection port for accessories (refer to Outrigger Handle, DSMC3™ RED® Touch 7.0"
LCD)
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INTAKE: DO NOT OBSTRUCT!
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Figure: Camera Body Left Controls and Features

ITEM DESCRIPTION

M4 Mounting Holes Two (2) M4 mounting points for accessories
Focus Plane Focus plane indicator symbol

Air intake Air intake for thermal management

Media compartment

CFexpress Type B compartment

Access media

Latch for the CFexpress Type B media compartment door

ola|lh|lwWw[N|—=|H

EJECT Button

Micro-V battery eject button
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RIGHT

M E

Figure: Camera Body Right Controls and Features

# ITEM DESCRIPTION
1 Wireless antenna  Wi-Fi antenna mounted to a female RP-SMA connector. Supports dual band 2.4 GHz or 5
GHz
2 Power LED Displays the camera ready status (refer to Camera Body LEDs)
3 ON/OFF switch Slide up to turn on the camera and slide down to turn off the camera
4 Speaker Beep speaker for audible feedback
5 Right REC button Assignable full-press and half-press button
6 Exhaust Exhaust for thermal control
7 Focus plane Focus plane indicator symbol
8 M4 mounting Two (2) M4 mounting points for accessories
holes
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Figure: Camera Body Rear Controls and Features

# ITEM DESCRIPTION
Micro V-Lock battery 14.4 V Micro V-Lock mount(refer to REDVOLT® MICRO-V Battery and REDVOLT®
mount NANO-V Battery)

2 Wireless antenna Wi-Fi antenna mounted to a female RP-SMA connector. Supports dual band 2.4 GHz or

5 GHz

3 USB Type-C port USB Type-C Port for USB-C connection

4 12G-SDI port Full-size 12G-SDI BNC port for SDI monitor connection?:2

5 Headphone port 3.5 mm stereo headphone output

6 Audio port and LED 5-Pin 00B ODU for 2 channel audio (Line, Mic, and +48V)

7 9-pin Extension Port 9-pin 0B ODU port (refer to Extension Port)

8 6-pin DC-IN port and 6-pin 1B ODU for DC-IN (11-17 Volts) and power status LED (refer to 6-pin DC-IN)

LED

1. Use certified 12G-SDI cables.

2. WARNING: Always connect the accessories' DC power cable (or batteries) before connecting the BNC SDI cable. Always remove the BNC SDI
cable before removing the accessories' DC power cable (or batteries). For more information, refer to Preventing Damage to SDI Outputs.
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BOTTOM

Figure: Camera Body Bottom Controls and Features

# ITEM DESCRIPTION

1 Mounting Points One (1) 1/4"-20 mounting hole and one (1) 3/8"-16 mounting hole
2 Registration Points Indented alignment points

3  Service Port For RED service only - DO NOT REMOVE
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CAMERA BODY LEDS

FRONT LED

HE DIGITAL CINEMA

KOMODO -X

Figure: Camera LED, Front

# ITEM COLOR

DESCRIPTION

1 Tally Indicator LED Red

When enabled, this LED is ON when the camera is
recording. For information about enabling this LED, refer to

Indicators.
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LEFT SIDE LED
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Figure: Camera LED, Left Side

# ITEM COLOR/FLASHING DESCRIPTION
1 CFexpress Media LED Off No media mounted
Green Preview; media mounted with > 10% of
media space available
Amber Recording finalizing or playback mode
Amber flashing slow Formatting media
Red flashing slow Media mounted with >5% and <= 10% of
media space available
Red flashing fast Media mounted with <= 5% of media space
available
Red Recording

COPYRIGHT © 2023 RED.COM, LLC 955-0218,REVB | 12



KOMODO-X" OPERATION GUIDE

RIGHT SIDE LEDS

Figure: Camera LED, Right Side

<Sx

# ITEM COLOR/FLASHING DESCRIPTION

1 Power Status (ON) Off Camera OFF
Amber Camera booting
Green Camera ON

Amber flashing

Camera on; 5 to 10 min of battery time available

Red flashing Camera on; < 5 min of battery time available
Red Camera shutting down
2 Record Status (REC) Off No media present
Green Ready to record
Red Recording
Amber Finalizing

Red flashing slow

Media mounted with >5% and <= 10% of media
space available

Red flashing fast

Media mounted with <= 5% of media space
available

3 Power (firmware update)

Flashing green

Firmware update in progress

Flashing red

Firmware update error (refer to Upgrading the
Firmware)
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BACK LEDS

Figure: Camera LEDs, Rear

# ITEM COLOR DESCRIPTION
Phantom Blue Indicates that the +48 V Phantom Power is enabled
power
2 DC-IN Green DC-IN is present and / or the battery is fully charged
Flashing Amber Communicating with, and evaluating the battery
Amber Charging connected batteries
Red Error charging the batteries
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LENSES AND ADAPTERS

This section lists the compatible lenses and adapters for the camera. It also provides the steps for Attaching Lenses
and Removing Lenses.

For more information on a specific lens or adapter, refer to the original manufacturer’s instructions.

WARNING: When the camera is not in use, protect lenses and the camera sensor by attaching the lens caps and
camera mount cap.

4
w4
-
s &

W AOWAY TWO 2D VIGAW LNNOWNN

Y SHhNONTORNNY] MY

%
¢

Figure: Camera with mount cap installed.

Incompatible lenses may not register on the camera Ul or show any Ul lens information or menu controls. The camera
can control compatible lenses electronically, including the following features:

® J|ris - The Ul menu is enabled and the camera can control the lens Iris

® Autofocus - The Ul menu is enabled for lenses that support autofocus

® Image Stabilization - The Ul indicates that image stabilization is present

® Control Ring - The Ul menu is enabled and the camera can use the control ring

For more information, refer to the Lens menu.
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COMPATIBLE LENSES
The latest RED-tested and approved lenses are listed on the KOMODO-X section of RED Support.

LENS WEIGHT AND LENS SUPPORT

Use a lens support system when mounting heavy or long lenses to your camera.

When mounting a heavy or long lens, ensure that the full weight of the lens is never directly on the camera or lens
mount. Mount the lens to the support system first, and then carefully mount the lens to the camera.

COMPATIBLE MOUNT ADAPTERS

RED tested the following adapters and determined that they are compatible with the camera:

®* KOMODO-X™ RF to PL Adapter (refer to KOMODO-X™ RF to PL Adapter Pack)

® Canon Mount Adapter EF-EOS R

® Canon Drop-In Filter Mount Adapter EF-EOS R with Variable ND Filter / Clear Filter / Circular Polarizer

ATTACHING LENSES
1. Unlock the locking ring by rotating it to the fully counterclockwise position.

2. Press and hold the lens release button on the camera. While holding the lens release button, turn the camera lens
mount cap counter-clockwise until it stops, and remove it from the camera. If the lens locking ring rotates while
removing the cap, make sure that you hold the locking ring tab in place while rotating the cap.

3. Remove the rear lens cap from the mount end of the lens.

4. Align the red dot on the lens mount with the red dot on the camera lens mount, and insert the lens mount of the lens
in the camera lens mount opening.

5. Turn the lens clockwise until it clicks in place. If the lens locking ring rotates while attaching the lens, make sure that
you hold the locking ring tab in place while rotating the lens or adapter.

6. Gently tighten the locking ring. DO NOT OVER-TIGHTEN THE LOCKING RING.
7. Store the camera lens mount cap and the rear lens cap together in a dust free location.

REMOVING LENSES
1. Loosen the locking ring gently.

2. Press and hold the lens release button on the camera. While holding the lens release button, turn the lens counter-
clockwise until it stops, and remove it from the camera. If the lens locking ring rotates while removing the lens, make
sure that you hold the locking ring tab in place while rotating the lens or adapter.

3. Align the red dot on the camera lens mount cap with the red dot on the camera lens mount, and attach the cap to the
camera.

4. Gently tighten the locking ring. DO NOT OVER-TIGHTEN THE LOCKING RING.
5. Attach the rear lens cap to the lens.
6. Store the lens with the front and rear caps attached.
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ONBOARD LCD TOUCHSCREEN

This section describes the structure and layout of the graphical user interface
(GUI) for the Onboard LCD touchscreen. Advanced GUI menu controls
enable convenient access to menus, camera features, and critical camera
information.

NOTE: After 1 hour of inactivity, the touchscreen will go to sleep. Tap the
touchscreen or touch any button to wake the touchscreen. The touchscreen
will not sleep while the camera is recording.

15:39:00

CLIP: A023_C001

DUR: 00:00:00

6K 17:9 / R3D MQ

30 FPS CAM

PRESS TO RECORD #

Iy 180° | 5600k
IRIS SHUTTER WB

The Onboard LCD Touchscreen home page contains the following features:

STATUS BAR
P oS
RED)> 30 =1

The Status Bar contains the button for displaying the Home screen and Menu screen. It also contains status icons for
various camera settings and inputs.

When you tap the Home/Menu toggle button (RED logo), the camera toggles the display between the menu page and
the home page:

RED<
MENU

Image / LUT
Project Settings

Audio / TC

15:39:00
CLIP: A023_C001

— DUR: 00:00:00
6K 17:9/ R3D MQ
30FPS

Monitoring

PRESS TO RECORD #

Media

800 /]
1s0 IRIS

Presets
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When you tap the Status bar icons the Status Page displays:

RED Pro CFexpress 4 TB

DC-IN 12,5V N/A N/A 1.0A
BAT N/A N/A 0:00 N/A

KOMODO-X 6K S35
KXBK1000000
1.0.0beta

EXPOSURE
The Exposure section of the Onboard LCD home page displays the RGB exposure levels for the camera.
Exposure Overexposed Underexposed Balanced
Meter Example Example Example
Overexposure
Indicators
Quantity of RGB

Pixels Overexposed

Quantity of RGB
Pixels Underexposed

Underexposure
Indicators

RGB Exposure displays the pixel exposure quantity of the separate RGB channels and indicates when a channel is
underexposed or overexposed. This meter measures the raw image data regardless of the ISO and LUT settings.

The top and bottom RGB lights illuminate when a small number of pixels on the sensor are overexposed or
underexposed. This indicates that a small bright or dark area is in the image.

The level bars show the levels of overexposed and underexposed RGB pixels on the sensor. Adjust the settings on the
camera to compensate.

Tap the Exposure section to toggle between this display and the Monitoring Tools page display.

MEDIA / HISTOGRAM
. ) The Media section of the Onboard LCD home page displays the Timecode or
00.1 3.25 Edgecode, clip ID, clip duration, resolution/format, and frame rate for the camera.
CLIP: A0O01_C003 Tap the Media section to toggle between this display and the Histogram display.
DUR: 00:00:00

6K 17:9 / R3D MQ
23.98 FPS
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The Histogram section of the Onboard LCD home page displays the image color
histogram. Tap this area to toggle between this display and the Media display. For
more information, refer to Histogram.

The Audio section of the Onboard LCD home page displays the audio levels for the camera. Tap the
Audio section to toggle between this display and the Audio Tools display.

The Audio VU meters display the audio levels in decibel (dB) for the selected channels. Refer to the
Audio / TC Menu section for more information about the audio channels.

In this example, channel 2 displays the VU meter clipping at maximum dB.

PRESS TO RECORD #
PRE-RECORDING »
PRESS TO STOP » #

The Camera Designation and Record button on the Onboard LCD touchscreen home page displays the camera letter
assigned to the camera (refer to Slate and Camera ID). You can tap this area to start pre-recording, and to start and
stop recording.

Pre-recording: Recording:

RED#

CLIP: A023_C001

DUR: 00:00:04

6K 17:9 / R3D HQ

23.98 FPS CAM

0:00:00
6K 17:9 / R3D HQ
23.98 FPS

.
A
o
S
2
3
o
2
2
a2
g
=
o

PRE-RECORDING »

23.98 800 5.6 48 5700k 5.6 V48 5700«
Fhs () RIS SHUTTER TINT RIS SHUTTER TN
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QUICK SETTINGS

23.98 800 : 180° 5600k

FPS St SHUTTER

The Quick Settings section of the Onboard LCD home page displays the Quick Settings buttons for changing the most
often used camera settings. These settings include Recording Frame Rate, ISO, IRIS (refer to Lens), Shutter, and White
Balance.

Tap on a Quick Setting button to change the settings.

Swipe the setting left or right to make a selection.

Tap Edit to manually enter a value.

Tap List to manage which values display in this tool.

Tap on the Quick Setting button to close the selection screen.

Tap and hold the Shutter button to quickly toggle between Time and Angle settings.

Tap and hold the White Balance (WB) button to quickly switch between Kelvin and
Presets.

23.98 800 f5.6 180° 5600k
S 150 we

RIS SHUTTER

BUTTON NAVIGATION

Pressing the Menu button next to the Onboard LCD touchscreen opens the main menu page. You can select the
desired menu items by using the Up, Down, and Select (SEL) buttons. Pressing the Menu button also navigates
backwards (BACK) from submenus in the menu tree.

Pressing the Up arrow and the Down arrow simultaneously locks/unlocks the touchscreen and the menu buttons. The
Lock icon in the Status bar displays the lock status. The REC button is not locked and it functions normally.

Pressing the Playback button starts and stops playback (refer to Playback for more information).

Home Screen Menu Screen

RED)> i =),

Image / LUT
Project Settings

Audio / TC

Monitoring

Media

User Settings
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STATUS BAR

The top of the Onboard LCD screen displays the camera status bar.
3D —

H E n > LUT > Y

The Status Bar contains the following button and icons:

i I E D > Home / Menu Button
* - Media Status Icon

¢ Temperature / Exposure lcon
¢ - Timecode Icon

* - Genlock Icon
* BS s\ icon

¢ . Status Bar

& 30 LuT Icon

¢ I Network Activity Icon
. LCD Lock Icon

* 88 wi-Fi Icon

DC-In Icon

¢ I Battery Icon

HOME / MENU BUTTON
RED >

This button toggles the Onboard LCD display between the Home screen and the Menu screen. The arrow on the button
changes direction when toggled.

Home Screen: Menu Screen:
RED

MENU

Image / LUT
Project Settings

Audio / TC
s 15:39:00

CLIP: A023_C001
————  DUR: 00:00:00
6K 17:9 / R3D MQ
30 FPS CAM

Monitoring

PRESS TO RECORD #

Media

Ty 180° | 5600k
IRIS SHUTTER WB

Presets
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MEDIA STATUS ICON

TEMPERATURE / EXPOSURE ICON

This icon displays the status of the CFexpress Type
B media card, and it displays the recording time
remaining for the current camera settings.

The status displayed includes:

. Good

k| \issing

[E Incompatible

This icon displays the temperature (T) and exposure (E)
calibration indicators.

e When T is yellow or red, it indicates that the camera
requires sensor re-calibration at the current ambient
temperature.

e When E is yellow or red, it indicates that the camera
requires sensor re-calibration at the current shutter
speed.

Refer to Calibrating the Sensor.

TIMECODE ICON

GENLOCK ICON

This icon indicates the state of the Timecode
generator connection.

- Gray indicates that no Timecode generator
signal is detected.

J % Green indicates that the Timecode source is
connected and jammed.

- Red indicates that the selected Timecode
Source is not present, or not jammed in the last 12
hours.

White indicates that the selected Timecode

source is not currently connected but was jammed
during the current camera boot.

Yellow indicates that the selected Timecode
source has not been jammed in current camera boot
but has been within the last 12 hours, or that
timecode source is cross-jammed (at a different
Project Time Base).

This icon indicates the state of the Genlock connection.

- Gray indicates that no Genlock signal is detected.

\J 5 ] Green indicates that the camera is receiving a
Genlock signal.

- Red indicates that the camera is receiving and is
not locked to a Genlock signal.
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SYNC ICON

3D LUT ICON

This icon indicates that the Timecode and Genlock
signals are synchronized to the camera's frames per
second (FPS) settings.

- Gray indicates that no synchronization is

detected.

NG Green indicates that the camera is
synchronized with the Timecode and Genlock
signals.

ms Yellow indicates that the camera is

synchronized using Genlock but not Timecode.

This icon indicates the activation status of 3D LUTs.

- Gray indicates that no 3D LUTs are in use.

=]
K111 White indicates that the camera is using a 3D

LUT.

CAMERA STATUS ICON

NETWORK ACTIVITY ICON

This icon indicates the state of the camera hardware.
The different icons and their corresponding status
include:

. Good: Camera operating as expected.

EI Attention Required: Camera's calibration
requires attention or camera is nearing overheated
state.

. Overheating: Camera has reached temperature
threshold and shut down is imminent.

/
& Shutting Down: Camera is shutting down due to
overheating.

This icon indicates the state of FTPS or Cloud data
transfer.

I Gray indicates that no network data transfer is
occurring.

I Green indicates that the camera is transferring
FTPS or Cloud data.
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LCD LOCK ICON

WI-FI ICON

This icon indicates the state of the Onboard LCD
Lock. The states include:

. Gray and open indicates that the camera
Onboard LCD is unlocked.

@ White and closed indicates that the camera
Onboard LCD is locked.

This icon indicates the state of Wi-Fi connection.

- Gray and empty indicates that no Wi-Fi signal is
detected.

a8
ioll \White bars indicate that Wi-Fi signal is detected
(Infrastructure).

Q)
White antenna indicates that Wi-Fi signal is
broadcasting (Ad-hoc).

DC-IN ICON

BATTERY ICON

12.5V.

This icon indicates the state of DC power connection.

Y Gray indicates that no DC power is connected.

il Green indicates that the camera is receiving DC
power and the voltage number is displayed.

This icon indicates the state of the battery connection
and charge level. When the voltage is low, it displays the
voltage in red.

I Gray indicates that no battery is connected.

@ White indicates that the battery is connected and
green shows the relative level of charge remaining.

@ Yellow indicates 10 minutes of power remaining.
E Red indicates less then 5 minutes of power remaining.

Gray question mark indicates no communication with
the battery and no power.

White question mark indicates no communication with
the battery and power.

l Gray exclamation point indicates error communicating
with the battery and no power.

COPYRIGHT © 2023 RED.COM, LLC
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STATUS PAGE

The Status page contains camera status information and shortcuts to the associated camera menus:

RED Pro CFexpress 4 TB

DC-IN 12,5V N/A N/A 1.0A
BAT N/A N/A 0:00 N/A

KOMODO-X 6K S35
KXBK1000000
1.03

6K 17:9
23.98FPS
23.98FPS

100mm
14'9" - 65'8"
1/5.6
Disabled

Disabled

35°C/35°C
47.95/ V/47.95

The camera status and menu shortcuts include:

ITEM DETAILS

Media Displays the media status and a link to the Media Menu

Power Displays the power status and a link to the Power settings menu

System Status Displays the camera temperature status and a link to the System Status menu

Project Settings Displays the project status and a link to the Project Settings Menu

Lens Displays the lens status and a link to the Lens settings menu

Wi-Fi Displays the communication status and a link to the Wi-Fi settings menu

Maintenance Displays the Temperature and Exposure calibration, the external connection status, and a link

to the Maintenance Menu
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MONITORING TOOLS

MAGNIFY EDGE EXPOSURE

E H T = o
Focus ) zesras |B
ONBOARD ONBOARD
< LcD LcD
GUIDES TOOLS

Open the Monitoring tools by tapping on the Exposure section of the Onboard LCD home page.

c 15:39:00 ﬂ - MAGNIFY EDGE EXPOSURE

P: A023_C001
TAP 00:00:00
6K 17:9 / R3D MQ
30 FPS CAM

PRESS TO RECORD

E H PEAKING = TOOLS
Focus ) zesras |8

b/ 0
8.29 mi‘s JRO0 5630'( GUIDES

SHUTTER

Return to the Onboard LCD home page by tapping the arrow button
The Monitoring tools provide an easy way to toggle many of the monitoring features on and off.

When the features are selected, the buttons indicate the selection.
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ONBOARD LCD SWITCHES

The Onboard LCD switches allow you to view or hide the enabled LCD monitor Guides and Tools on the Onboard LCD
screen.

MAGNIFY

GUIDES

GUIDES

When the switches are selected, the gray bar turns green on the left side of the switch.
The Onboard LCD Guides switch displays the Monitoring Guides (frame guides and center guide) on the Onboard LCD.

The Onboard LCD Tools switch displays the Monitoring Tools (false color, peaking, zebra) on the Onboard LCD and on
Live Stream.

SDI SWITCHES
The SDI switches allow you to view or hide the enabled SDI monitor Guides and Tools on the Onboard LCD screen.

B> !

EXPO

LCDs SDI
1 BRA 2
[ONBOAR! [ONBOARI

LCD LCcD
GUIDES TOOLS

SDI SDI
GUIDES TOOLS

When the switches are selected, the gray bar turns green on the left side of the switch.
The SDI Guides switch displays the Monitoring Guides (frame guides and center guide) on the SDI output.
The SDI Tools switch displays the Monitoring Tools (false color, peaking, zebra) on the SDI output.
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MAGNIFY

The Magnify section allows you to enable or disable magnification on the camera's LCDs (Onboard LCD and Top LCD)
and the SDI monitor output. When the switches are selected, the gray bar turns green on the left side of the switch.

B> !

LCDs SDI

[ONBOAR! [ONBOARI
LCD LCcD
GUIDES TOOLS

SDI SDI
GUIDES TOOLS

FOCUS

The Focus section allows you to enable or disable one of the focus tools. The focus tool button you select will turn red.

MAGNIFY EDGE EXPOSURE

PEAKING = TOOLS
LCDs
Focus |B) zeeras |B

GUIDES

GUIDES

For information about using the Focus tools, refer to Tools.
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EXPOSURE
The Exposure section allows you to enable or disable one of the exposure tools. The Exposure tool button you select
will turn red.
1 !
LCDs SDI
ocC! 1 BRA 2
PRI [REL sl spi

GUIDES TOOLS Gll33 WS

For information about using the Exposure tools, refer to Tools.

TOOLS

The Tools section allows you to open the Monitor Tools menu.

TOOLS

False Color

Peaking

Log View

Zebra 1

MAGNIFY EXPOSURE

Zebra 2

= TOOLS

|E) zezras |8

SDI
GUIDES

GUIDES

For information about the Monitor Tools menu, refer to Tools.
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ZEBRA

The Zebra section allows you to enable or disable the Zebra 1 and Zebra 2 modes. When the modes are selected, the
gray bar turns green on the left side of the switch.

MAGNIFY

GUIDES

For information about using the two Zebra modes, refer to Zebra 1 and Zebra 2.

HISTOGRAM

NOTE: The Histogram feature is disabled on Monochrome cameras.

« - 15:39:00
LIP: A023_C001
_— R: 00:00:00
6K 17:9 / R3D MQ
30 FPS (o7.1\Y

PRESS TO RECORD #

)
£
9
S
I
&
o
[
@
a2
&
3
[
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The Histogram area of the LCD home page displays an RGB exposure distribution histogram of the final image as it
appears on screen. The histogram takes into account exposure elements such as ISO, LUTs, and white balance.

The histogram displays the darkest image elements at the far left, the midtones in the middle, and the lightest image
elements at the far right. This provides a quick visual tool you can use to determine your overall image exposure levels.

Overexposed Example Underexposed Example

(o)

~
> 125V

| O | o
12
INTERNAL INTERNAL e
MICROPHONE MICROPHONE
ch1 ch2 ch3 ch4 B

0.0dB 0.0dB 1.0dB 1.0dB

3D
LUT

| O
INTERNAL INTERNAL
MICROPHONE MICROPHONE
ch1 ch2 ch3 ch4

15:39:00
CLIP: A023_C001

)0 00:00:00
6K 17:9 / R3D MQ
30 FPS

PRESS TO RECORD #

75 0.0dB 0.0dB 1.0dB 1.0dB

1, o
a o g s M < =

Return to the LCD home page by tapping the arrow .
The Audio tools provide an easy way to control many of the audio features.
When the features are selected, the buttons indicate the selection.
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HEADPHONE

The headphone section allows you to enable/disable the headphone output, to select input from Internal Microphone, or
External, and to adjust the headphone volume with a slider.

INTERNAL INTERNAL
MICROPHONE I S
Ch1 Ch2 Ch3 Ch4

0.0dB 0.0dB 1.0dB 1.0dB

I LINK

AUDIO SOURCE

The Audio Source section allows you to select the audio source the camera will record to the clip. You can select
Internal Microphone, External, both, or none. Use the sliders to adjust the gain for each channel. You can use the Link
button to link channels 1 and 2, or to link channels 3 and 4. This allows you to adjust both of the internal or external
channels together.

RED>

| O |
INTERNAL INTERNAL
MICROPHONE MICROPHONE R
1 Ch2 ch3 ch4

EXTERNAL
Ch

0.0dB 0.0dB 1.0dB

LINK
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AUDIO VU METER

The Audio VU Meter section displays the audio input received by the camera from the four channels.

RED>

| O
INTERNAL INTERNAL
MICROBHONE I S
h1 Ch2 Ch3 Cha

EXTERNAL
Cl

0

AT

mnnnnnnannnn
T

1

0.0dB 0.0dB 1.0dB 1.0dB

As the input increases, the level indicator changes from green to yellow to orange to red. When the audio input clips,
the channel number at the top of the VU meter turns red:

PLAYBACK

When you press on the Playback button, the Onboard LCD Touchscreen displays the Playback screen.

15:39:00
A023_C001
00:00:00

6K 17:9/R3D MQ

0 FPS

30 800 g 180° 5600«
s 150, wis SHUTTER W

To close the Playback screen, press the Playback button.
NOTE: When you open playback, it disables many of the menu settings.
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PLAYBACK SCREEN

The Playback screen displays the clip image along with the following:
Clip Slider

RGB Exposure

Histogram

Audio VU Meters

Clip Information

Playback Screen Buttons

e © o o o o

CLIP SLIDER

< D>

Use your finger to move forward and backward through the frames by swiping the image to the left and the right. The
Clip Slider shows where in the timeline the displayed frame is located in the clip.

RGB EXPOSURE

Overexposure
Indicators

Quantity of RGB
Pixels Overexposed

Quantity of RGB
Pixels Underexposed

bt

Underexposure
Indicators

RGB Exposure displays the exposure levels of the separate RGB channels and indicates when a channel is
underexposed or overexposed. This meter measures the raw image data regardless of the ISO and LUT settings.
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HISTOGRAM

The histogram displays the darkest image elements at the far left, the midtones in the middle, and the lightest image
elements at the far right. This gives you a quick way to view your overall image exposure levels.

AUDIO VU METERS

The Audio VU meters display the audio levels in the played clip.

CLIP INFORMATION

A002_CO001
01:32:55
30

6K 17:9

The Clip Information displays the name, duration, time base, and format of the clip.

PLAYBACK SCREEN BUTTONS

With the Playback screen buttons you can view the Clip list, move one clip back, move one frame back, play/pause,
move one frame forward, and move one clip forward.
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CLIP LIST
The Clip List button displays the list of clips recorded on the media card.

Each clip displays the first frame of the clip, the clip information, and the clip file format.

(=)

3
LUT sy

= F503_J001
2021-03-18 13:22:38 'V

TC Start: 04:08:41:13

Dur: 00:00:05:11

(R3D] F503_J002

2021-03-18 14:02:21
TC Start: 04:53:41:13
Dur: 00:00:11:01

(R2D] F503_J003
2021-03-18 14:47:01

TC Start: 05:39:09:55

Dur: 00:01:15:01

(R3] F503_J004
2021-03-19 08:00:00

TC Start: 05:40:24:56

Dur: 00:00:30:02

2021-03-17 04:21:18 Recording Frame Rate: 23.98FPS
00:13:16:06 Format: 6K 17:9
R3D R3D Quality: MQ

Project Time Base: 23.98FPS TC Start: 00:13:16:06

Recording Frame Rate: 23.98FPS TC Stop: 00:13:51:16

All Formats: 6K 17:9 Duration: 00:00:35:11

R3D Quality: HQ Frames: 842

TC Start: 00:13:16:06 ISO: 150800

TC Stop: 00:13:51:16 Color Temperature: 5600K

Duration: 00:00:35:11 Tint: 0.000

When you tap the Load button, the camera loads the clip to the Playback screen.
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4. MENUS

This section describes the menus and sub-menus for the camera. To access the menus, navigate to a menu item from
the Onboard LCD Touchscreen.

MENUS

DETAILS

Image / LUT Menu

ISO, Shutter, White Balance, Output Color Space, Output Tone Map, Highlight Roll-Off,
Display Preset, 3D LUT, CDL, Exposure Adjust

Project Settings Menu

Format, Recording Frame Rate, Project Time Base, File Format, R3D Quality,
ProRes Resolution, ProRes Codec, ProRes Color Profile, Pre-Record, Recording Mode,
Timelapse, Frame Limit, Slate

Audio / TC Menu

Audio Source, Internal Mic, External Audio, Headphone, Timecode Source,
Auto-Jam Toggle, Jam Timecode to TOD, Manual Timecode, Timecode Display Mode

Monitoring Menu

Onboard LCD, Top LCD, SDI, Live Stream, Tools, Guides

Media Menu

Eject, Media Info, Secure Format

User Settings Menu

Create Presets and assign User Button functions

Autofocus Menu

Enable AF, Mode, Size, Position, AF Toggle

Communication Menu

Camera, Connections (USB-C, Wi-Fi, Serial), Clients & Services (FTPS, PTP), Cloud
Upload (Frame.io, AWS S3)

System Settings Menu

Date / Time, Licenses, Lens, Power, Sensor, Indicators, GPO, Status Settings, System
Status

Language Menu

English, Chinese, French, German, Japanese, Spanish

Maintenance Menu

Calibrate, Calibration, Save Log, Reset Defaults, Factory Reset, Upgrade FW
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IMAGE / LUT MENU

The Image / LUT menu contains the settings you use to configure your image.
From the Onboard LCD touchscreen menu, tap Image / LUT:

MENU MENU > IMAGE / LUT

Image / LUT ISO 150800 Y

Project Settings Shutter 180° ¥
Audio / TC White Balance >

ND 2 Stop ¥

Monitoring

Media Filter Name Electronic ND

User Settings

Output Color Space Rec. 709 v

Use the Image / LUT menu to configure the camera's image and lookup table (LUT) settings:

ITEM DETAILS

ISO Adjusts the image’s brightness in the monitoring path

Shutter Adjusts the amount of time the sensor is exposed to light

White Balance Adjusts the colors to compensate for the light source temperature

ND When attached, you can adjust the ND value for the RF to PL Adapter w/
Electronic ND

Filter Name When attached, this displays the name of the PL filter.

Output Color Space Adjusts on-set working color space

Output Tone Map Adjusts the image contrast

Highlight Roll-Off Adjusts image highlight compression

Display Preset Select the displayed preview image gamma for the SDI port

3D LUT Manage the camera's look up tables (LUTSs).

CDL Opens the Color Decision List (CDL) menu

Exposure Adjust Manually fine-tunes the midtone exposure level
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ISO

Use the ISO setting to adjust the image’s exposure in the monitoring path.

MENU > IMAGE / LUT MENU > IMAGE / LUT

ISO 1S0800 V¥

Shutter 180° v 1S0500
1S0640

> 1s0800 <

White Balance >
Output Color Space Rec. 709 v 1501000
Output Tone Map Medium Contrast ¥ 1S01280

Highlight Roll-Off Soft ¥ OK  Cancel

The ISO range is ISO 250 to ISO 12,800. The default ISO is ISO 800 for color and ISO 2000 for Monochrome.

Higher ISO values create brighter images in the monitor path, and lower ISO values create darker images in the monitor
path.

When you record, the ISO settings are stored as metadata and you can adjust them non-destructively in post-
processing with REDCINE-X PRO or other editing tools that support R3D files.

RED recommends setting the ISO to the default of 800, then adjusting the aperture and lighting to match. You can
adjust the ISO later for fine-tuning.

NOTE: When you set the File Format to ProRes, the ISO is baked-in the image.
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SHUTTER

Use Shutter to select the exposure time (shutter speed / shutter angle). The camera allows you to change the shutter
settings while recording.

MENU > IMAGE / LUT MENU > IMAGE / LUT

ISO 1S0800 V¥

Shutter 180° ¥

White Balance >
Output Color Space Rec. 709 ¥

Output Tone Map Medium Contrast 'V

Soft v (0]4 Cancel Edit List

Highlight Roll-Off

You can switch between Angle and Time settings by holding down the Onboard LCD Shutter quick setting button on
the main menu, or by changing the Shutter Display mode in the Status Settings menu.

You can tap Edit to change the Shutter You can tap List to choose which values you
menu values manually. want to display on the menu list.

MENU > IMAGE / LUT MENU > IMAGE / LUT
Modify List

144°
172.8°

> 180°

225°
240°

OK CANCEL HIDE HIDEALL ~ RESET
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SHUTTER ANGLE

Enter the exposure value as a shutter angle (xx°). The shutter angle range is 1° to 360°. The default shutter angle is
180°. Click Edit to enter an exact shutter angle or shutter speed.

EXPOSURE CONVERSIONS

The table below lists common shutter angle and shutter speed equivalents. The calculations in the table use a recording
frame rate of 23.98 fps.

SHUTTER  SHUTTER SPEED SHUTTER  SHUTTER SPEED

ANGLE (°) (1/XX SEC) ANGLE (°) (1/XX SEC)
360° 1/23.98 105° 1/82.20
288° 1/29.97 90° 1/95.90
270° 1/31.97 72 1/119.88
240° 1/35.96 45° 1/191.81
225° 1/38.36 22.5° 1/383.62
180° 1/47.95 11.2° 1/770.66
172.8° 1/49.95 8.6° 1/1003.65
144° 1/59.94 & 1/2157.84
135° 1/63.95 T 1/8000 (max)
120° 1/71.93

SHUTTER SPEED
Enter the exposure value as a shutter speed (1/xx sec).

The slowest shutter speed is 1/(recording frame rate). For example, if the recording frame rate is 23.98 fps, the slowest
available shutter speed is 1/23.98 sec. The slowest available shutter speed in the camera is 1/5.99 sec when the
recording frame rate is set to 5.99 fps. The fastest shutter speed is 1/8000 sec. The default shutter speed is 1/47.95
sec.

CONVERT SHUTTER SPEED TO SHUTTER ANGLE

Shutter Angle = (Shutter Speed x Frame Rate x 360)

Example: (1/47.95 x 23.98 x 360) = 180

CONVERT SHUTTER ANGLE TO SHUTTER SPEED
Shutter Speed = 1/(Frame Rate x 360/Angle)
Example: 1/(23.98 x 360/180) = 1/47.95
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WHITE BALANCE

Use the White Balance menu to adjust the Color Temperature, Color Temperature Presets, Tint and execute the Auto
White Balance.

NOTE: Color temperature is disabled on Monochrome cameras.

MENU > IMAGE / LUT MENU > IMAGE / LUT > WHITE BALANCE

(0] 1S0800 V' Color Temperature 6502K ¥

Shutter 180° ¥ Color Temperature Presets >

White Balance > Tint 0v
Output Color Space Rec. 709 'v [l Auto White Balance (6] ¢
Output Tone Map Medium Contrast ¥

Highlight Roll-Off Soft ¥

You can switch between Kelvin and Presets by holding down the Onboard LCD WB quick setting button on the main
menu, or by changing the White Balance List mode in the Status Settings menu.

When shooting in R3D format, the camera stores white balance as metadata, which you can adjust non-destructively in
post-production after filming.

Use the White Balance menu to configure the color temperature and tint settings for your image:

ITEMS DETAILS

Color Temperature Image color temperature correction

Color Temperature Presets Tap a button to select a preset color temperature

Tint Adjust magenta-green color component

Auto White Balance The camera automatically sets the color temperature and tint

NOTE: When you set the File Format to ProRes, White Balance is baked-in the image.

COLOR TEMPERATURE
Use Color Temperature to adjust the image's color temperature in Kelvin units (K) or by selecting presets.
NOTE: Color temperature is disabled on Monochrome cameras.

MENU » IMAGE / LUT » WHITE BALANCE MENU » IMAGE / LUT » WHITE BALANCE

Color Temperature 6502K ¥ Color Temperature

Color Temperature Presets >

Tint 0V

Auto White Balance

(0]1¢ Cancel Edit

0

1

O
N
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When the image's light source color temperature is warm, you can compensate by setting the camera to a warmer color
temperature. When the image's light source color temperature is cool, you can compensate by setting the camera to a
cooler temperature.

The color temperature range is 1,700 K to 10,000 K. The default color temperature is 5600 K.

When the White Balance List Mode (refer to Status Settings) is set to Presets, the Color Temperature menu list uses the
preset temperatures instead of the Kelvin temperatures.

MENU » IMAGE / LUT » WHITE BALANCE

Color Temperature

Fluorescent

Flash

> Daylight <

Cloudy
Shade

(0] 4 Cancel Edit

COLOR TEMPERATURE PRESETS

Use Color Temperature Presets to select a pre-configured color temperature.

NOTE: Color temperature is disabled on Monochrome cameras.

MENU » IMAGE / LUT » WHITE BALANCE ...> WHITE BALANCE » COLOR TEMPERATURE PRESETS

Color Temperature 6502K ¥ Incandescent
Color Temperature Presets > Tungsten
Tint 0¥ Fluorescent
Auto White Balance (6] ¢ Flash
Daylight

Cloudy

The color temperature presets you can select include:

ITEMS DETAILS ITEMS DETAILS
Incandescent 2800 K Daylight 5600 K
Tungsten 3200 K Cloudy 7500 K
Fluorescent 4500 K Shade 9000 K
Flash 5500 K
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TINT
Use Tint to adjust the image's color tint.
NOTE: Tint is disabled on Monochrome cameras.

Color temperature calculations assume a pure light source that may not be true in the specific scene the camera is
imaging. To compensate for any residual colorcast, the Tint setting adjusts the RGB color balance with a compensating
magenta-green color component.

MENU » IMAGE / LUT » WHITE BALANCE MENU » IMAGE / LUT » WHITE BALANCE

Color Temperature 6502k ¥

Color Temperature Presets >
Tint 0v

Auto White Balance (0]¢

(0]3¢ Cancel Edit

Tint range is =100 to 100. The default Tint setting is 0.
Use Edit to open the keypad screen where you can enter a specific Tint value.

MENU » IMAGE / LUT > WHITE BALANCE
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AUTO WHITE BALANCE
Use Auto White Balance to use the camera's automatic white balance adjustment.

MENU » IMAGE / LUT » WHITE BALANCE

Color Temperature 6502K Y

Color Temperature Presets >

Tint 0V

Auto White Balance (0] ¢

When shooting in R3D format, the camera stores white balance as metadata, which you can adjust non-destructively in
post-production after filming.

To use Auto White Balance:
1. Place an 18% gray chart in the center of the image under the correct exposure.

2. From the White Balance menu tap OK next to Auto White Balance.
3. The camera automatically sets the color temperature and tint settings.

NOTE: Place the chart in the same location as your subject, and illuminate it with the same lighting. Make sure that you
center the chart, and that it fills at least 25% of the sensor area.

ND

When the RF to PL Adapter w/ Electronic ND is attached, and the Electronic ND filter is inserted, you can use this menu
to select the density of the ND filter.

MENU > IMAGE / LUT MENU > IMAGE / LUT

ISO 1S0800 V¥

Shutter 180° ¥ 2 Stop
2 5 Stop

> 2% Stop <
3 Stop

White Balance >
ND 2 Stop ¥

Filter Name Electronic ND 3 %5 Stop

Output Color Space Rec. 709 ¥ OK  Cancel

The ND filter range is 2-7 stops or 0.6 to 2.1 density. From the Status Settings menu, you can use the ND Display Mode
submenu to select Stops or Density units, and you can use the ND Increments submenu to select the size of the
ND increments displayed on the camera (refer to Status Settings for more information).

0

1

O
N

COPYRIGHT © 2023 RED.COM, LLC 955- 3, REVB | 45

.



KOMODO-X" OPERATION GUIDE

OUTPUT COLOR SPACE

Use Output Color Space to select the desired color space associated with the clip. When the camera file format is R3D,
it saves this color space as metadata, which you can adjust in post-processing. When the camera uses the ProRes file
format, and the ProRes Color Profile is Image/LUT, the camera bakes the color space in the resulting image.

MENU > IMAGE / LUT MENU > IMAGE / LUT

ISO 150800 ¥ Output Color Space

Shutter 180° ¥

DCI-P3

> Rec. 709 <

White Balance >

Output Color Space Rec.709 ¥ Rec. 2020

Output Tone Map Medium Contrast ¥ REDWideGamutRGB

Highlight Roll-Off Soft ¥ OK  Cancel

The Output Color Space selections include:

® DCI-P3 - Digital Cinema Initiatives theater projector standard color space

® Rec. 709 - Standard Color Space for HDTV (default)

® Rec. 2020 - Standard Color Space for UHD and HDR

®* REDWideGamutRGB - Color space encompassing all of the colors the RED camera can generate without clipping.

OUTPUT TONE MAP

Use Output Tone Map to adjust the image contrast when displaying the camera output.

MENU > IMAGE / LUT MENU > IMAGE / LUT
ISO 150800 ¥ Output Tone Map

Shutter 180° ¥
Low Contrast

> Medium Contrast <

Output Color Space Rec. 709 ¥ High Contrast

White Balance >

Output Tone Map Medium Contrast V¥

Highlight Roll-Off Soft W OK  Cancel

When shooting in R3D format, the camera stores this as metadata, which you can adjust non-destructively in post-
production after filming.

The Output Tone Map selections include:

® Low Contrast - Low contrast is applied to the image

® Medium Contrast - Medium contrast is applied to the image (default)
® High Contrast - High contrast is applied to the image.

0
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HIGHLIGHT ROLL-OFF

Use Highlight Roll-Off to select the desired highlight compression to use when displaying the camera output.

MENU > IMAGE / LUT MENU > IMAGE / LUT

Output Tone Map Medium Contrast 'V Highlight Roll-Off

Highlight Roll-Off Soft ¥

Very Soft
Display Preset SDR ¥ <

Soft

3D LUT Medium

CDL Hard

Exposure Adjust OK  Cancel

When shooting in R3D format, the camera stores this as metadata, which you can adjust non-destructively in post-
production after filming.

The Highlight Roll-Off selections include:

® Very Soft - The lightest compression is applied to the image highlights

® Soft - Soft compression is applied to the image highlights (default)

® Medium - Medium compression is applied to the image highlights

® Hard - The highest compression is applied to the image highlights.
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DISPLAY PRESET

Use Display Preset to select the gamma of the displayed preview image for the SDI port:

MENU > IMAGE / LUT MENU > IMAGE / LUT

Output Tone Map Medium Contrast 'V Display Preset

Highlight Roll-Off Soft ¥

Display Preset SDR ¥ > SDR <

3D LUT HDR

CDL HLG
(0]3¢ Cancel

Exposure Adjust

When shooting in R3D format, the camera stores this as metadata, which you can adjust non-destructively in post-
production after filming.

The Display Preset allows you to select the gamma for the camera preview and monitor output.

Each monitor is designed to display using a specific gamma. Most monitors use SDR. However, some support HDR and
HLG gamma signals. Select the display preset that works best with your monitor.

The selections are:

® SDR - Standard Dynamic Range (default)

®* HDR - High Dynamic Range

® HLG - Hybrid Log-Gamma

Standard-dynamic-range (SDR) video describes images or video using a conventional gamma curve signal.

High-dynamic-range (HDR) video images are recorded using the SMPTE-2084 PQ curve. This technology captures and
outputs a greater range of luminance than images recorded using standard-dynamic-range (SDR) methods.

Hybrid log-gamma (HLG) delivers HDR resolution without the need for metadata. This allows HLG to display well on
SDR and HDR monitors.

0
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N
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3D LUT
Use the 3D LUT menu to apply and manage the camera's Look-Up Tables (LUTSs).

MENU > IMAGE / LUT MENU > IMAGE / LUT > 3D LUT

Output Tone Map Medium Contrast 'V Enable l

Highlight Roll-Off Soft ¥ LUT RED_FilmBias.cube ¥
Display Preset SDR 'V On Media LUTs A
3D LUT In Camera LUTs A

CDL

Exposure Adjust

LUT

MENU > IMAGE / LUT > 3D LUT MENU > IMAGE / LUT > 3D LUT

Enable |

LUT RED_FilmBias.cube ¥
RED_Achromic.cube

> RED_FilmBias.cube <

On Media LUTs v

In Camera LUTs Y RED_FilmBiasBleachBypas...

RED_FilmBiasOffset.cube

(0]4 Cancel

When you are recording in the ProRes format, you can choose to irreversibly encode (bake) the 3D LUT into the
recorded file. For more information, refer to the ProRes Color Profile section.

When you are recording in the R3D format, this LUT will be saved along with each clip on which it is activated during
recording. The output file name format for the LUT is clip_LUT Name.cube.

The LUT is non-destructive, and it is reversible, when recording in the R3D format.

To apply a 3D LUT, follow the instructions below:
1. Go to MENU > IMAGE / LUT > 3D LUT > LUT.

2. Select a LUT from the LUT list.

0

1

O
N
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ON MEDIA LUTS
To import 3D LUTs from media, go to MENU > IMAGE / LUT > 3D LUT > On Media LUTs.

MENU > IMAGE / LUT > 3D LUT MENU > IMAGE / LUT > 3D LUT

Enable i On Media LUTs

RED_FilmBias.cube ¥
LUT -FlimBias.cube RED_PASTEL.cube

On Media LUTs M §)> RED_PROCESS.cube <

In Camera LUTs A4 RED_ST4.cube

Import Import All

3D LUTs can be imported from media to the camera. When importing 3D LUTs from media to the camera, the 3D LUTs
must be saved on the root path of your media, in a folder titled "luts." The camera only supports 33x33x33 LUTs.

From On Media LUTs, you can:
® Import the selected 3D LUT from the media to the camera
® |mport all 3D LUTs from the media to the camera.

When you copy LUTs from a computer to the media, make sure that the card reader is not set to read only.

IN CAMERA LUTS
To export and delete 3D LUTs stored in the camera, go to MENU > IMAGE / LUT > 3D LUT > In Camera LUTs.

MENU > IMAGE / LUT > 3D LUT MENU > IMAGE / LUT > 3D LUT

Enable i In Camera LUTs

LUT RED_FilmBias.cube ¥

On Media LUTSs i B> RED_Achromic.cube <

In Camera LUTs A\ RED_FilmBias.cube

EXPORT EXPORT ALL

You can export 3D LUTs stored on the camera, to media, to use on other cameras. When you export 3D LUTs from the
camera to media, the 3D LUTs are saved to a folder on the media called “luts.”
NOTE: When a LUT is active during record, the camera will automatically save the LUT along with the recorded clip.

From In Camera LUTs you can:

® Delete a selected 3D LUT from the camera

® Export a selected 3D LUT from the camera to the media
® Export all 3D LUTs from the camera to the media.
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CDL

The Color Decision List (CDL) allows you to define the look of the camera's colors in your project.

NOTE: The CDL menu is disabled on Monochrome cameras.

MENU > IMAGE / LUT MENU > IMAGE / LUT > CDL
Output Tone Map  Medium Contrast 'V Enable

Power

Highlight Roll-Off Soft ¥

Display Preset SDR ¥

Slope

3D LUT Offset

CDL Saturation 1.00000 'V

Exposure Adjust On Media CDLs Y

Use the CDL menu to:

® Enable the CDLs

® Configure CDL Power

® Configure CDL Slope

® Configure CDL Offset

® Configure CDL Saturation

MANAGE CDLS

Use the CDLs menu to import and export CDLs.

CDLs can be stored on the camera or transferred to media to be shared with other cameras. When exporting CDLs from
camera to media, the CDLs are saved to a folder on the media called “cdls”. When importing CDLs from media to the
camera, the CDLs must be stored on the media in a folder called “cdls.”

When you record with a CDL in ProRes format, the CDL is baked-in with the ProRes file. When you record with a CDL in
R3D format, the camera automatically saves the CDL file along with the R3D files.

To export selected CDLs from the camera to the media, refer to the In Camera CDLs section.

To import selected CDLs from the media to the camera, refer to the On Media CDL section.

CDL OVERVIEW

A Color Decision List (CDL) is a metadata file format developed by the American Society of Cinematographers (ASC) to
exchange standard color correction information between post production tools. This non-destructive color adjustment
layer simplifies the versioning of looks by updating simple metadata without the need to re-transfer the image data.
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CDLs are very common in VFX workflows because the VFX artist needs both the ungraded shot and the intended look.
The ungraded shot allows the artist to comp in truly linear light, and the intended look is needed to confirm that the
individual plates still hold together after the grade is applied.

SLOPE, OFFSET AND POWER

The three CDL tone curve parameters are Slope, Offset and Power. These algorithms allow the camera to modify the
recorded image.

® Slope multiplies the incoming data

® Offset is sum of the incoming data

® Power is a power function to the incoming data

These three relate to Gain, Lift, and Gamma in the following ways:

® Slope = Gain
Gain Adjusts highlights.
* Offset = Lift

Lift Increases the value of dark colors.

® Power = Gamma
Gamma adjusts midtones.

These three relate to each other in the following ways:
Slope= input x slope
Offset= (input x slope) + offset
Power= ((input x slope) + offset) * power
The formula for ASC CDL color correction is:
out =(( i x 8) + o)?

where

out is the color graded pixel code value

% is the input pixel code value (O=black, 1=white)

s is slope (any number 0 or greater, nominal value is 1.0)

o is offset (any number, nominal value is 0)

P is power (any number greater than 0, nominal value is 1.0)

The formula is applied to the three color values for each pixel using the corresponding slope, offset, and power
numbers for each color channel.

SATURATION

A fourth parameter “Saturation” is achieved by converting the out data in a Luma and Chroma component. The Chroma
Signal is then multiplied by the “Saturation” parameter.

FILM GRADE AND VIDEO GRADE

With Slope and Offset you can produce both a Film Grade “Exposure” and “Contrast” and a Video Grade “Lift” and
“Gain.”

® Exposure is achieved by Offset

® Contrast is achieved by a combination of Offset and Slope

® @Gain is achieved by Slope

® Lift is achieved by a combination of Offset and Slope

® Gamma is achieved by Power
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CDL POWER
The CDL Power settings control the power of the Red, Green, and Blue, color data.
NOTE: The CDL options are disabled on Monochrome cameras.

MENU > IMAGE / LUT > CDL MENU > IMAGE / LUT » CDL >» POWER

Enable = 1.00000 ¥

Power 1.00000 ¥
Slope 1.00000 ¥
Offset

Saturation 1.00000 ¥

On Media CDLs \4

Use the CDL Power menu to adjust the power of the Red, Green, and Blue CDL data.

CDL POWER SETTINGS

MENU > IMAGE / LUT » CDL > POWER MENU > IMAGE / LUT > CDL > POWER

Red

1.20000 1.00000|

1.10000

>  1.00000 <
0.90000

0.80000

(0]1¢ Cancel Edit

The CDL Power settings range from 0.00000 to 4.00000. The default CDL Power setting for each color is 1.00000. The
Edit button opens the keypad where you can enter a specific CDL Power value.
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CDL SLOPE
The CDL Slope settings multiply the incoming RGB data.
NOTE: The CDL options are disabled on Monochrome cameras.

MENU > IMAGE / LUT > CDL MENU > IMAGE / LUT » CDL > SLOPE

Enable = 1.00000 ¥

Power 1.00000 ¥
Slope 1.00000 ¥
Offset

Saturation 1.00000 ¥

On Media CDLs \4

Use the CDL Slope menu to set the slope of the Red, Green, and Blue signals.

SLOPE SETTINGS

MENU > IMAGE / LUT » CDL > SLOPE MENU > IMAGE / LUT > CDL > SLOPE

Red

0.80000 1.00000]

0.90000

>  1.00000 <

1.10000
1.20000

(0]1¢ Cancel Edit

The CDL Slope settings range from 0.00000 to 2.00000. The default CDL Slope settings are 1.00000. The Edit button
opens a keypad where you can enter a specific CDL Slope value.
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CDL OFFSET
The CDL Offset settings control the offset of the RGB color data.
NOTE: The CDL options are disabled on Monochrome cameras.
The Camera LCD Menu for CDL Offset:
MENU > IMAGE / LUT > CDL MENU > IMAGE / LUT > CDL > OFFSET Use the CDL Offset menu to adjust

the offset of the CDL Slope for the

Enable Red, Green, and Blue CDL data.

0.00000 ¥

0.00000 ¥

Power

0.00000 ¥

Slope

Offset

Saturation 1.00000 ¥

On Media CDLs \4

RED GREEN AND BLUE OFFSETS

MENU > IMAGE / LUT > CDL » OFFSET MENU > IMAGE / LUT > CDL > OFFSET

Red

-0.20000 0.00000

-0.10000

> 0.00000 <

0.10000
0.20000

+/-

(0]1¢ Cancel Edit

These CDL Offset settings range from -1.00000 to 1.00000. The default CDL Offset setting for each is 0.00000. The Edit
button opens the keypad, where you can enter a specific CDL Offset value.

CDL SATURATION

MENU > IMAGE / LUT > CDL The CDL Saturation settings control the intensity of the color data.

Enable
Power
Slope

Offset

Saturation 1.00000 ¥

On Media CDLs v
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NOTE: The CDL options are disabled on Monochrome cameras.
Use the CDL Saturation menu to adjust the intensity of the image color.

MENU > IMAGE / LUT » CDL MENU » IMAGE / LUT » CDL
Saturation Saturation

0.80000 1.00000

0.90000

> 1.00000

1.10000
1.20000

(0]1¢ Cancel Edit

The CDL Saturation settings range from 0.00000 to 4.00000. The default CDL Saturation setting is 1.00000. The Edit
button opens a keypad where you can enter a specific CDL Saturation value.

ON MEDIA CDL
Use On Media CDLs to import CDLs from the media to the camera.

NOTE: The CDL options are disabled on Monochrome cameras.

MENU > IMAGE / LUT > CDL MENU > IMAGE / LUT > CDL When importing CDLs from media
. to the camera, the CDLs are saved
Power On Media CDLs to a folder on the camera called
o “cdls”.
ope
P From On Media CDLs you can
Offset import a selected CDL from the
media to the camera, or you can
Saturation 1.00000 ¥ import all of the CDLs from the
media to the camera.
On Media CDLs Y When you copy CDLs from a
computer to the media, make sure
In Camera CDLs Y that the card reader is not set to
Read Only.
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IN CAMERA CDLS

Use In Camera CDLs to export CDLs from the camera to the media. You can also select which stored CDL you want to
apply to the camera.

NOTE: The CDL options are disabled on Monochrome cameras.

MENU > IMAGE / LUT > CDL MENU > IMAGE / LUT > CDL

Power In Camera CDLs

Slope
Offset
Saturation 1.00000 'V
On Media CDLs \4

In Camera CDLs A\

When exporting CDLs from the camera to the media, the CDLs are saved to a folder on the media called “cdls.”

From In Camera CDLs, you can apply the selected CDL to the camera, delete the selected CDL from the camera, export
the selected CDL from the camera to the media, or export all of the CDLs from the camera to the media.

EXPOSURE ADJUST

Use Exposure Adjust to manually fine-tune the midtone exposure level.

MENU> IMAGE / LUT MENU > IMAGE / LUT

Output Tone Map  Medium Contrast ¥ Exposure Adjust

Highlight Roll-Off Soft ¥ 0.000| [x]

Display Preset SDR ¥

+/-
3D LUT

CDL

9

6

3
]

Exposure Adjust OK

The Exposure Adjust range is —8.000 to 8.000. The default is 0.000.

Exposure Adjust allows you to adjust the midtone exposure levels while preserving the highlights and shadows, even
when changed substantially. The Exposure Adjust setting is expressed in terms of relative exposure value (EV), where
each unit represents a 1-stop change in midtone exposure level.
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PROJECT SETTINGS MENU

The Project Settings menu contains the camera's main recording configuration settings.
From the Onboard LCD touchscreen menu, tap Project Settings:

MENU MENU > PROJECT SETTINGS

Image / LUT Format 6K 17:9 »

Recording Frame Rate 23.98FPS ¥

Project Settings

Audio / TC Project Time Base 23.98FPS ¥

Monitoring File Format R3D ¥

Media

R3D Quality MQ ¥

User Settings

Use the Project Settings menu to configure the recording settings:

ITEMS DETAILS

Format Size of the area captured by the sensor
Recording Frame Rate Frames recorded per second

Project Time Base Image playback rate

File Format R3D or ProRes file formats

R3D Quality Compression level of the recorded image file
ProRes Resolution Resolution of the recorded ProRes image file
ProRes Codec ProRes codec selection

ProRes Color Profile RWG / Log3G10 or Image / LUT settings
Pre-Record Enable and configure a pre-record clip
Recording Mode Select Motion or Timelapse mode

Timelapse Interval Time and Frames per Interval

Frame Limit Enable, Frames, and Playback Duration
Slate Enter the Camera ID, Camera Position, Camera Operator, Scene,

Shot, Take, Production, Director, DoP, and Unit

COPYRIGHT © 2023 RED.COM, LLC 955-0218, REVB | 58



KOMODO-X" OPERATION GUIDE

FORMAT

Use the Format setting to designate how much of the sensor the camera should use to capture images.

MENU > PROJECT SETTINGS

Format 6K 17:9 »

Recording Frame Rate 23.98FPs ¥

23.98FPS Y

MENU > PROJECT SETTINGS > FORMAT

Super 35 (6K) v

Super 35 Anamorphic (6K) Y

All Formats 6K 17:9 ¥

Project Time Base

File Format R3D ¥ Dimensions (Pixel) 6144 x 3240

R3D Quality MQ ¥ Dimensions (mm) 27.03mm x 14.26mm

Use the Format menu to configure the camera's sensor capture area settings:

DETAILS

Select from Super 35 sensor capture areas

ITEMS
Super 35 (6K)
Super 35 Anamorphic (6K)

Select from Super 35 anamorphic sensor capture areas

All Formats Select from all sensor capture areas

Dimensions (Pixel) Displays the dimensions of the selected format in pixels

Dimensions (mm) Displays the dimensions of the selected format in millimeters

The available aspect ratios are determined by the selected resolution. The default format setting is 6K 17:9.

When you lower the resolution in the Format menu, only a portion of the sensor is used. The camera does not
downscale from the 6K 17:9 format when recording RAW.
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SUPER 35 (6K)

Use the Super 35 (6K) format setting to designate how much of the sensor the camera should use to capture images.

MENU > PROJECT SETTINGS » FORMAT MENU > PROJECT SETTINGS » FORMAT

Super 35 (6K) v Super 35 (6K)
Super 35 Anamorphic (6K) v

All Formats 6K 179 ¥

> 6K179 <

Dimensions (Pixel) 6144 x 3240 6K 2:1

Dimensions (mm) 27.03mm x 14.26mm 6K 2.4:1

(0] 4 Cancel

The available aspect ratios are determined by the selected resolution.

When you lower the resolution on the camera, only a portion of the sensor is used. The camera does not downscale
from the 6K 17:9 format when recording RAW.

SUPER 35 (6K) FORMAT SPECIFICATIONS

This table contains the dimensions of the sensor area in Pixels and in Millimeters used by each Super 35 (6K) format.
The default format is 6K 17:9.

FORMAT DIMENSION (PIXELS) DIMENSIONS (MM)
Width Height Width Height Diagonal
6K 17:9 6144 3240 27.03 14.26 30.56
6K 2:1 6144 3072 27.03 13.52 30.22
6K 2.4:1 6144 2592 27.03 1140 29.34
6K 16:9 5760 3240 2534 14.26 29.08
6K 1:1 3240 3240 14.26 14.26 20.17
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SUPER 35 ANAMORPHIC (6K)

Use the Super 35 Anamorphic Format setting to designate how much of the sensor the camera should use to capture
images.

MENU > PROJECT SETTINGS >» FORMAT MENU > PROJECT SETTINGS >» FORMAT

Super 35 (6K) v Super 35 Anamorphic (6K)
Super 35 Anamorphic (6K) A

All Formats 6K 179 ¥

> 6K4:32x <

Dimensions (Pixel) 6144 x 3240 6K 65 2x

Dimensions (mm) 27.03mm x 14.26mm 6K 1:1 2x

(0]

The available aspect ratios are determined by the selected resolution.

When you lower the resolution on the camera, only a portion of the sensor is used. The camera does not downscale
from the 6K 17:9 format when recording RAW.

SUPER 35 ANAMORPHIC (6K) FORMAT SPECIFICATIONS

This table contains the effective dimensions of the sensor area in Pixels and in Millimeters used by each Super 35
Anamorphic (6K) format.
The default setting is 6K 4:3 2x.

FORMAT DIMENSION (PIXELS)  DIMENSION DE-SQUEEZED DIMENSIONS (MM)
(PIXELS)
WIDTH HEIGHT WIDTH HEIGHT WIDTH HEIGHT DIAGONAL
6K 4:3 2x 4320 3240 8640 3240 19.01 14.26 23.76
6K 6:5 2x 3888 3240 7776 3240 17.11 14.26 22.27
6K 1:1 2x 3240 3240 6480 3240 14.26 14.26 20.17
6K 3:2 1.8x 4860 3240 8748 3240 21.38 14.26 25.70
6K 4:3 1.8x 4320 3240 7776 3240 19.01 14.26 23.76
6K 3:2 1.6x 4860 3240 7776 3240 21.38 14.26 25.70
6K 16:9 1.5x 5760 3240 8640 3240 25.34 14.26 29.08
6K 17:9 1.3x 6144 3240 8192 3240 27.03 14.26 30.56
6K 17:9 1.25x 6144 3240 7680 3240 27.03 14.26 30.56
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ALL FORMATS

Use the All Formats setting to select from all of the possible formats to designate how much of the sensor the camera
should use to capture images.

The available aspect ratios are

determined by the selected
All Formats resolution.

MENU > PROJECT SETTINGS >» FORMAT MENU > PROJECT SETTINGS >» FORMAT

Super 35 (6K) v

When you lower the resolution on
the camera, only a portion of the
sensor is used. The camera does

. not downscale from the 6K 17:9
> 6K 17:9 << format when recording RAW.
6K 2:1

6K 2.4:1

Super 35 Anamorphic (6K) A
All Formats 6K 17:9 ¥
Dimensions (Pixel) 6144 x 3240

Dimensions (mm) 27.03mm x 14.26mm

(0] 4 Cancel List

FORMAT SPECIFICATIONS

This table contains the dimensions of the sensor area in Pixels and in Millimeters used by all of the camera formats. The
default setting is 6K 17:9.

FORMAT DIMENSION (PIXELS) DIMENSIONS (M)
WIDTH HEIGHT WIDTH HEIGHT DIAGONAL
6K 17:9 6144 3240 27.03 14.26 30.56
6K 2:1 6144 3072 27.03 13.52 30.22
6K 2.4:1 6144 2592 27.03 11.40 29.34
6K 16:9 5760 3240 25.34 14.26 29.08
6K 1:1 3240 3240 14.26 14.26 20.17
6K 4:3 2x 4320 3240 19.01 14.26 23.76
6K 6:5 2x 3888 3240 17.11 14.26 22.27
6K 1:1 2x 3240 3240 14.26 14.26 20.17
6K 3:2 1.8x 4860 3240 21.38 14.26 25.70
6K 4:3 1.8x 4320 3240 19.01 14.26 23.76
6K 3:2 1.6x 4860 3240 21.38 14.26 25.70
6K 16:9 1.5x 5760 3240 25.34 14.26 29.08
6K 17:9 1.3x 6144 3240 27.03 14.26 30.56
6K 17:9 1.25x 6144 3240 27.03 14.26 30.56
5K 17:9 5120 2700 22.53 11.88 25.47
5K 16:9 4800 2700 2112 11.88 24.23
4K 17:9 4096 2160 18.02 9.50 20.37
4K 16:9 3840 2160 16.90 9.50 19.39
2K 17:9 2048 1080 9.01 4.75 10.19
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RECORDING FRAME RATE

Use Recording Frame Rate to select the recording frame rate (also referred to as the capture frame rate).

MENU > PROJECT SETTINGS MENU > PROJECT SETTINGS

Format 6K 17:9 ¥ Recording Frame Rate

23.98FPs ¥ 5.99FPs

11.99FPs
Project Time Base 23.98FPs Y >> <<

Recording Frame Rate

23.98FPs

File Format R3D ¥ 47 .95FPS

R3D Quality MQ ¥ 71.66FPS

(0]4 Cancel Edit List

The recording frame rate is the number of frames per second (FPS) that are recorded. The recording frame rate is
different from the project time base, which is the rate at which the footage will be played back. Lower values than the
project time base will result in under-cranking (fast motion playback) and values larger than the project time base will

result in over-cranking (slow motion playback).
You can tap EDIT to change the Recording Frame Rate menu values manually.

MENU > PROJECT SETTINGS MENU > PROJECT SETTINGS
Recording Frame Rate Recording Frame Rate

5.99FPs
23.98FPS

11.99FPs
> 23.98FPS

47.95FPS
71.66FPS

(0]1¢ Cancel Edit List

You can tap LIST to choose which values you want to display on the menu list.

MENU > PROJECT SETTINGS MENU > PROJECT SETTINGS

Recording Frame Rate Modify List

5.99rpPs 11.99rPs
11.99rPs 14.99rPs

> 23.98FPSs > 23.98FPs <

47.95FPS 29.97FpPs
71.66FPS 47.95FpPs

(0]:4 Cancel Edit 0K CANCEL = HIDE  HIDEALL = RESET

The maximum frame rate for each format is determined by Project Time Base and Format.
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When you select a Project Time Base, the camera automatically selects a matching Recording Frame Rate and an R3D
Quality (when possible). You must change the Recording Frame Rate and R3D Quality after the Project Time Base to
select a different setting.

MENU > PROJECT SETTINGS A Recording Frame Rate highlighted in yellow will result in playback occurring
at a different frame rate than the original recording, and will record varispeed

Format 2K17:9 » audio.

Recording Frame Rate = 239.76FpPs ¥

Project Time Base 23.98FPs ¥

File Format R3D ¥

R3D Quality MQ v

FORMATS AND FRAME RATES

This table lists the camera's maximum recording frame rates. These rates are based on a Project Time Base setting of
24 frames per second (24 FPS).

FORMAT FPS

6K 17:9 80
6K 2:1 84
6K 2.4:1 100
6K 16:9 80
6K 1:1 80
5K 17:9 96
5K 16:9 96

4K 17:9 120
4K 16:9 120
2K 17:9 240

~
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PROJECT TIME BASE

Use the Project Time Base setting to choose the playback rate for the recorded footage.

MENU > PROJECT SETTINGS MENU > PROJECT SETTINGS

Format 6K17:9 ¥ Project Time Base

Recording Frame Rate 23.98FPs ¥

Project Time Base 23.98FPS 'V >> 23.98FpPS <

File Format R3D ¥ 24FPS

R3D Quality MQ ¥ 25FPS
(0]4 Cancel

The following project time bases are available:

® 23.98 FPS (Default) ©25.00 FPS * 30.00 FPS e 59.94 FPS
® 24.00 FPS 2997 FPS ¢ 50.00 FPS * 60.00 FPS
When you select the Project Time Base, it changes the Recording Frame Rate to the same setting (when possible).

When you change the Format, the Recording Frame Rate and Project Time Base do not automatically update. You must
select the Project Time Base after you change the Format setting.

NOTE: When the Recording Frame Rate is set to a higher speed than the Project Time Base setting, audio is recorded
as varispeed audio (refer to Audio / TC Menu).

FILE FORMAT

Use File Format to select the format that the camera uses to record image files.

MENU > PROJECT SETTINGS MENU > PROJECT SETTINGS

Format 6K 17:9 ¥ File Format

Recording Frame Rate 23.98FPs Y
Project Time Base 23.98FPs Y

>

File Format R3D ¥

R3D Quality MQ ¥
(0]4 Cancel
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When you change the file format, a message warns you that the camera must be rebooted to complete the change:

/// /Y

FILE FORMAT

Changing the file format to ProRes will require
a camera reboot. Continue?

S
SIS SIS SSSY

R3D REDCODE FILE FORMAT

The RED R3D file format records images in a compressed RAW format. In comparison to Apple ProRes, REDCODE
RAW data does not bake in image settings like ISO, saturation, or LUTs, allowing more flexibility in post-processing
workflows without reducing image quality or dynamic range. Instead R3D files store the image settings as Metadata.
You can open and process R3D files with REDCINE-X PRO or with non-linear editing (NLE) software that supports the
RED SDK.

R3D is the camera's default file format.

APPLE PRORES FORMAT

This section provides general information about recording Apple ProRes files with the camera, including:

® The maximum recording frame rate in ProRes is 120 frames per second (FPS).
[ ]

QuickTime files have the same metadata as the REDCODE RAW files. The metadata is per clip, and not per frame.

® You can select a Format from the Project Settings Menu and the camera will scale it to the target resolution you

select in ProRes Resolution.

Recording 4K ProRes files requires 4K and above formats in 17:9. When in ProRes, formats below 4K will
automatically be recorded as 2K or HD.

For more information about Apple ProRes, including the data rates for each codec, refer to the Apple ProRes White
Paper.

APPLE PRORES DESCRIPTION
The table below describes each supported Apple ProRes codec.

NAME CHROMA SAMPLING DATA RATE

ProRes 4444 XQ Y' Cp G, +a 4:4:4:4 1697 Mbps at 4K 17:9 and 24 FPS
ProRes 4444 Y' Cp Gy +a 4:4:4:4 1131 Mbps at 4K 17:9 and 24 FPS
ProRes 422 HQ Y'Cp G, 4:2:2 754 Mbps at 4K 17:9 and 24 FPS
ProRes 422 Y' Gy C, 4:2:2 503 Mbps at 4K 17:9 and 24 FPS
ProRes 422 LT Y'Cy C, 4:2:2 350 Mbps at 4K 17:9 and 24 FPS
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FILE STRUCTURE OF RECORDED APPLE PRORES FILES

When you record using R3D + ProRes Proxy, this is the file structure of the recorded files on the media:

®* _RDM Folder
° .RDC Folder
- .mov
- .R3D

= .rtn (RED Thumbnail file)
NOTE: The camera creates multiple .mov files, similar to how the camera creates multiple R3D files.

L NON . ADD3_0103FS
< =v s Bomio =v #- Q
Favorites Name Size Kind
. v A003_0103FS.RDM - Folder
Devices
. v A003_C001_0103GO.RDC - Folder
© Remote Disc & AD03_C001_0103GO_001.mov 1442 MB  QuickTime movie
A003_0103FS = A003_C001_0103G0O_001.R3D 531.2 MB RED Video Clip
[l A003_C001_0103GO.rtn 35 KB Unix Executable File
Shared » [ A003_C002_010348.RDC -~ Folder
@ rouge = > A003_C003_010355.RDC - Folder
All... ! digital_magazine.bin 4 KB MacBinary archive
! digital_magdynamic.bin 4 KB MacBinary archive
Tags

When you record using ProRes format, this is the file structure of the recorded files on the media:

¢ _RDM Folder
° .RDC Folder
- .mov
CXoX ) I A002_010327
< =v s Blmimom mv g Q
Favorites Name Size Kind
Devi [ A002_010327.RDM -- Folder
evices
i ‘ v [ 1 A002_C001_01031H.RDC - Folder
REREED (RED & A002_C001_01031H_001.mov 1449 MB  QuickTime movie
A002_010327 = » [ ] A002_C002_0103P7.RDC -- Folder
» [ 1 A002_C003_0103QR.RDC -- Folder
Shared § digital_magazine.bin 4 KB MacBinary archive
® projects = ¥ digital_magdynamic.bin 4 KB MacBinary archive
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R3D QUALITY

Use R3D Quality to select the R3D data rate the camera uses to record the image files.

MENU > PROJECT SETTINGS MENU > PROJECT SETTINGS

Format 6K 17:9 ¥ R3D Quality

Recording Frame Rate 23.98FPs Y

HQ
Project Time Base 23.98FPs Y >> <

MQ

File Format R3D ¥ LQ

R3D Quality MQ ¥ ELQ
(0]14 Cancel

The R3D Quiality selections include:

®* HQ - High data rate and less recording time

®* MQ - Medium data rate (default) and longer recording time
® |LQ - Low data rate and long recording time

® ELQ - Lowest data rate and longest recording time

For high complexity scenes, VFX, and stills from motion workflows, RED recommends the HQ setting. For cinema (non-
VFX) and high-end TV, RED recommends the MQ setting. For TV, online content, documentary and interviews, RED
recommends the LQ setting. ELQ compression mode provides nearly 50% more recording time than LQ, and RED
recommends using ELQ for scenes where the complexity is low or the final delivery resolution is lower than the
acquisition resolution (downsampling).

R3D QUALITY DATA RATES
FORMAT 24P HQ 24P MQ 24P LQ 24P ELQ
6K 17:9 239 MB/s 168 MB/s 105 MB/s 65 MB/s
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PRORES RESOLUTION

When you enable ProRes as the File Format you can select the ProRes resolution.

MENU > PROJECT SETTINGS MENU > PROJECT SETTINGS

Recording Frame Rate 23.98FPS ¥ ProRes Resolution

2K

Project Time Base 23.98FPs ¥

File Format ProRes ¥

> 4K <

ProRes Resolution 4K ¥

ProRes Codec ProRes 422 HQ ¥ OK  Cancel

The ProRes Resolution selections include:

* HD (16:9)

°* 2K (17:9)

e UHD (16:9)

® 4K (17:9, default).

The camera will downscale to achieve the selected ProRes resolution when the aspect ratios of your format and ProRes
resolution do not match. It is recommended to shoot 4K or 2K ProRes when the format is 17:9, and to shoot UHD or HD
when the format is 16:9.
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PRORES CODEC

When you enable ProRes as the File Format you can select the ProRes Codec.

MENU > PROJECT SETTINGS MENU > PROJECT SETTINGS

ProRes Codec

Project Time Base 23.98FPs ¥

ProRes 4444 XQ
ProRes 4444

>ProRes 422 HQ<

File Format ProRes ¥

ProRes Resolution 4K v ProRes 422

ProRes Codec ProRes 422 HQ ¥ ProRes 422 LT

ProRes Color Profile RWG / Log3G... ¥ OK  Cancel

The ProRes Codec selections include:
® ProRes 4444 XQ

® ProRes 4444

®* ProRes 422 HQ

®* ProRes 422

® ProRes 422 LT

NOTE: Some ProRes codec selections are not available in all frame rates.

PRORES COLOR PROFILE

When you enable ProRes as the File Format you can select the color profile.

MENU > PROJECT SETTINGS MENU > PROJECT SETTINGS

File Format ProRes Color Profile

ProRes Resolution 4K v

»>RWG / Log3G10 <

ProRes Codec ProRes 422 HQ Y

Image / LUT

ProRes Color Profile RWG / Log3G... ¥

Pre-Record > OK  Cancel

The ProRes Color Profile settings include:
®* RWG/Log3G10 - REDWideGamutRGB color space and Log3G10 gamma curve
® Image / LUT - Applies all Image / LUT settings for Output Color Space, Display Preset, 3D LUT, and CDL.

NOTE: All ProRes Color Profile settings bake in both the ISO and the White Balance settings.
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PRE-RECORD

Use the Pre-Record menu to enable or disable Pre-Record, and to adjust the length of the Pre-Recorded clip.

MENU > PROJECT SETTINGS MENU > PROJECT SETTINGS > PRE-RECORD

R3D Quality Enable

Time

Playback Duration

Frames to Record
Pre-Record >

Recording Mode Motion V'

Pre-Record allows you to continually capture images to a small amount of memory while waiting to begin recording.
This allows you to capture unexpected events such as, a whale breaching the water, or an athlete scoring a goal. When
you finish recording, the pre-recorded clip is added to the beginning of the recording.

You can set the Pre-Record clip to record from half a second up to 30 seconds, depending on the format, file type,
resolution, and quality. The default setting is 2 seconds at the default Project Time Base of 23.98 FPS.

MENU > PROJECT SETTINGS MENU > PROJECT SETTINGS > PRE-RECORD

Format 2K17:9 » Enable
Recording Frame Rate = 239.76FpPs ¥ Time
Project Time Base 23.98FPS Y Playback Duration

File Format R3D V¥ Frames to Record

R3D Quality MQ v

When the selected pre-record time is not possible in the selected format, the closest time available will be shown in
yellow.

For more information, refer to Pre-Recording Content.

ENABLE

Select Enable to toggle Pre-Record on and off.

T T

COPYRIGHT © 2023 RED.COM, LLC 955-0218,REVB | 71



KOMODO-X" OPERATION GUIDE

TIME

Select Time to choose or enter the number of seconds to pre-record.

MENU > PROJECT SETTINGS > PRE-RECORD MENU > PROJECT SETTINGS > PRE-RECORD

(0]1¢ Cancel Edit

When you select a Time value larger than the current settings allow, the camera changes the Time value to the
maximum value it can support and highlights the value in yellow.

MENU > PROJECT SETTINGS > PRE-RECORD MENU > PROJECT SETTINGS » PRE-RECORD

Enable
Time

Playback Duration

Frames to Record

(0]1¢ Cancel Edit

PLAYBACK DURATION
Playback Duration displays the duration in seconds that the pre-record clip will last in playback.

MENU > PROJECT SETTINGS > PRE-RECORD

Enable
Time

Playback Duration

Frames to Record
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FRAMES TO RECORD
Frames to Record displays the number of frames the pre-recorded clip will contain at the current settings.

MENU > PROJECT SETTINGS > PRE-RECORD

Enable

Time

Playback Duration

Frames to Record

RECORDING MODE

Use Recording Mode to select between normal motion recording or timelapse recording.

MENU > PROJECT SETTINGS MENU > PROJECT SETTINGS

Recording Mode

>»  Motion

Pre-Record >

Timelapse

Recording Mode Motion ¥

OK

When you select Timelapse, the Timelapse option is enabled on the menu.
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TIMELAPSE

Use Timelapse to select the timelapse settings.

MENU > PROJECT SETTINGS MENU > PROJECT SETTINGS » TIMELAPSE

Interval Time

Frames per Interval

Recording Mode Timelapse ¥
Timelapse >

Frame Limit >

From Timelapse you can select the interval time between the group of frames per interval, and you can select the
number of frames captured per interval.

INTERVAL TIME

Select Interval Time to enter the elapsed time between the group of frames per interval.

MENU > PROJECT SETTINGS > TIMELAPSE

Interval Time

For example:

60s = 1 minute
3600s = 1 hour
86400s = 1 day
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FRAMES PER INTERVAL

Select Frames Per Interval to enter the number of frames to record per interval.

MENU > PROJECT SETTINGS > TIMELAPSE

Frames per Interval

Adding more frames per interval allows you to have more flexibility in post (for example: image stacking).

FRAME LIMIT

Use Frame Limit to limit the total number of frames recorded per clip. Frame limit applies to both Motion and Timelapse
recording modes.

MENU > PROJECT SETTINGS MENU > PROJECT SETTINGS » FRAME LIMIT

Enable
Frames 12

Recording Mode Timelapse ¥ Playback Duration 00:00:00:01

Timelapse

Frame Limit

Slate

The Frame Limit selections include Enable, Frames, and Playback Duration.

ENABLE

Select Enable to toggle the activation of the Frame Limit feature.

CEET T
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FRAMES

Use frames to enter the maximum number of frames the clip can record.

MENU > PROJECT SETTINGS > FRAME LIMIT

Frames

PLAYBACK DURATION

Playback Duration displays the calculated playback duration of the clip with the selected Frame Limit and FPS.
For example, using 1440 Frames as a Frame Limit at 24 FPS results in one minute of playback duration.

SLATE

Use the Slate menu to assign a camera ID and camera position to the clip.

MENU > PROJECT SETTINGS MENU > PROJECT SETTINGS > SLATE

Camera ID
Pre-Record > Camera Position
Recording Mode Motion ¥ Camera Operator
Scene

Frame Limit Shot

Slate Take

The information you can add to a clip includes:

® CameralD ® Scene ® Production * Unit
® Camera Position ® Shot ® Director
® Camera Operator ® Take ®* DoP

NOTE: When you set the Camera ID and Camera Position, they are also set in the Media>Secure Format menu items.
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CAMERA ID

Use Camera ID to assign a camera ID when the camera records clips.

NOTE: You can also change the Camera ID by using Secure Format (refer to Secure Format).

MENU > PROJECT SETTINGS > SLATE

Camera D

OK

The camera IDs you can assign when recording a clip include the letters A-Z.

CAMERA POSITION
Use Camera Position to assign a camera position letter when the camera records clips.

MENU > PROJECT SETTINGS > SLATE

Camera Position

A

B
C
D
E

(0]1¢ Cancel

The camera positions you can assign when recording a clip include the letters A-Z.
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CAMERA OPERATOR
Use Camera Operator to enter the name of the camera operator.

MENU > PROJECT SETTINGS > SLATE

Camera Operator

I -

1 2 3 45 6 7 8 90

QWERTYU I OFP
A S DF GHJ KL
&+ Z X CVBNMG
=\< (0]7¢

SCENE

Use Scene to enter the scene name.

MENU > PROJECT SETTINGS > SLATE

1 2 3 45 6 7 8 90
QWERTYU I OFP
A S DF GHJ KL
&+ Z X CVBNMG
=\< (0]7¢

SHOT
Use Shot to enter the number of the shot.

MENU > PROJECT SETTINGS > SLATE

1 2 3 45 6 7 8 90

QWERTY U I OFP

A S DF GH J K L
Z X €CVBNMUX@
=\< (0] 4
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TAKE

Use Take to enter the number of the take.

MENU > PROJECT SETTINGS > SLATE

PRODUCTION

Use Production to enter the name of the production.

MENU >» PROJECT SETTINGS » SLATE

Production
S
1 2 3 4 5 6 7 8 9 0
QWERTY U I OFP

A S D F GH J KL
+Z X C VB NMCE

=\< (0] 4

DIRECTOR

Use Director to enter the name of the director.

MENU > PROJECT SETTINGS > SLATE

Director
|

1 2 3 4 5 6 7 8 9 0

QWERTYUI OFP

A S D F GH J KL
+ Z X CVBNMGE
=\< (0] 4
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DOP

Use DoP to enter the name of the director of photography.

MENU > PROJECT SETTINGS > SLATE

1 2 3 4 5 6 7 8 9 0

QWERTYU I OFP
ASDFGHJKIL
f+Z X CVBNMGUE
=\< OK

UNIT

Use Unit to enter the name of the production unit.

MENU > PROJECT SETTINGS > SLATE

1 2 3 4 5 6 7 8 9 0

QWERTYU1IOFP
ASDFGHJKIL
f+Z X CVBNMGUE
=\< OK
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AUDIO / TC MENU

The Audio / TC menu contains the settings you use to configure your camera audio and Timecode.
From the Onboard LCD touchscreen menu, select Audio / TC:

MENU MENU > AUDIO / TC

Image / LUT Audio Source Internal Microphone (C ¥
Project Settings Internal Microphone (Ch 1/2) >
Audio / TC External (Ch 3/4) >
Monitoring Headphone >

Media Timecode Source Internal TOD ¥

User Settings Auto Jam |

Use the Audio / TC menu to configure the audio and Timecode settings for the camera:

ITEM DETAILS

Audio Source Audio input source

Internal Microphone Left and right internal microphone levels

External (Ch 3/4) Left and right external audio levels

Headphone Headphone volume level

Timecode Source Timecode source

Auto Jam Button to enable auto-jamming Timecode to time-of-day (TOD) Timecode
Jam Timecode to TOD Button to jam Timecode to time-of-day (TOD)

Manual Timecode Button to jam to the camera's internal Timecode generator and edit the

Timecode starting number

Timecode Display Mode Timecode type to display

AUDIO DETAILS

The camera is equipped with two integrated microphones suitable for scratch-track audio (Ch 1 and 2), and it is
equipped with a 5-Pin ODU audio connector that accepts 2-channel audio, which is configurable for Line or Mic level
inputs, and can provide +48V Phantom power (Ch 3 and 4).

You can link the gain for the two internal channels together and you can link the two external channels together. This
allows you to adjust the two internal (or external) channels together as one.

You can record audio from the internal microphones, from the external audio connector (2-channel recording), or from
internal and external sources combined as four 24-bit 48 kHz uncompressed audio tracks.

You can adjust the external audio by using the appropriate camera gain-settings. The default camera gain setting is 1
dB.

The camera's audio data is synchronized with video and timecode, and it is embedded in the R3D file. You can export
the audio data as separate audio files by using REDCINE-X PRO, if needed. The camera also embeds the audio in the
SDI output.

You can monitor the audio during recording and playback by using the equipped 3.5 mm stereo headphone port.
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SDI AUDIO

When you select Internal Microphone (Ch 1/2) as the audio source, the camera routes the Internal Microphone signals to
SDI channels 1 and 2. When you select External (Ch 3/4), the camera routes the External audio signal to SDI channels 1
and 2. When you select Internal + External, the camera routes the Internal Microphone signal to SDI channels 1 and 2,
and the External Audio signal to SDI channels 3 and 4.

VARISPEED AUDIO

This camera has the ability to record audio when the camera's Recording Frame Rate is set to a higher speed than the
Project Time Base setting (Varispeed mode).

NOTE: The camera records the audio as a separate WAV file and stores it in the clip's RDC folder on the media drive.

A017_03185C : et © v

Name ~ Date Modified ze Kind

v [ A017_03185C.RDM Today at 15:17 -- Folder
> [ A017_A001_0318ID.RDC Today at 09:39 -- Folder
> [ A017_A002_0318CH.RDC Today at 09:49 -- Folder
& A017.03185C v [ A017_A003_03186L.RDC Today at 15:17 - Folder
@ Network @ A017_A003_03186L_001.R3D Today at 15:17 RED Video Clip
Il A017_A003_03186L_001.wav Today at 15:17 Waveform audio
B A017_A003_03186L.rtn Today at 15:17 Document
B RED_FilmBias.cube Today at 15:17 Document
B digital_magazine.bin Today at 15:17 MacBin...archive

TIMECODE DETAILS

Timecode provides a mechanism to reference frames from the camera's recorded clips to external devices, such as
other cameras or audio recorders. Some devices can also gather additional data such as, lens metadata, or camera
orientation, which Timecode can later use for merging the data back together in post-processing.

The camera provides two separate Timecode formats:
® Time Of Day (TOD) - The camera records the time of day as the Timecode for each clip

® Edgecode - The camera records elapsed time as the Timecode for each clip. The time is reset to 01:00:00 when a
new media card is inserted in the camera. All of the clips on the media will have a continuous Timecode track.
However, each new media card will default to a Timecode track starting at 01:00:00. Edgecode is equivalent to RUN
RECORD as used on broadcast cameras. You can change the Edgecode to begin at any desired time by using the
Media Format menu (refer to Edgecode).

The camera synchronizes (jams) the TOD Timecode to an external Timecode generator (when one is connected to the

camera) or it jams the Timecode to its internal real-time clock.

When using Internal TOD, a jam between the running timecode and a real time clock is required. The time at which this
jam occurs will have an effect on the overall timecode drift over a 24-hour period due to the nature of non-drop-frame
(NDF) timecode. By enabling Auto-Jam, the camera automatically jams its timecode, ensuring repeatable drift across
multiple cameras and days.

When Auto Jam is disabled, you can manually pick the instant in which you want to jam timecode to the real time clock.

The camera stores TOD and Edgecode in the R3D file. You can select which one you want to display on the side
Onboard LCD Touchscreen (refer to Timecode Display Mode).
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AUDIO SOURCE

Use the Audio Source settings to select the audio input source.

MENU > AUDIO /TC MENU > AUDIO / TC

Audio Source Internal Microphone (C ¥ Audio Source

Internal Microphone (Ch 1/2)

None

> Internal Microphon <

External (Ch 3/4)

Headphone External (Ch 3/4)

Timecode Source Internal TOD (¥ Internal + External

(9]¢ Cancel

Auto Jam |

The audio input sources include:

®* None

® |nternal Microphone - enables the Internal Microphone channels 1 and 2 (default)

® External - enables the 5-pin 00B Audio Input port for External Audio channels 3 and 4

® Internal and External - enables the Internal Microphone and the 5-pin 00B Audio Port for all channels 1 through 4.
NOTE: The headphones can only monitor two channels. You can either monitor channels 1 and 2 (internal
microphone) or you can monitor channels 3 and 4 (external port). Refer to Audio Tools for more information.
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INTERNAL MICROPHONE

Use the Internal Microphone settings to set the left and right internal microphone levels. This menu is only enabled when
the Audio Source is set to Internal Microphone or Internal and External.

MENU > AUDIO / TC MENU » AUDIO / TC > INTERNAL MICROPHONE (CH 1/2)

Audio Source Internal Microphone ... ¥ Left Gain (Ch 1) 0.0dB ¥

Internal Microphone (Ch 1/2) Right Gain (Ch 2) 0.0dB ¥

External (Ch 3/4) > Link Left & Right Gain |

Headphone >
Timecode Source Internal TOD ¥

Auto Jam [

The Internal Microphone is represented as Channels 1 and 2 on the Ul VU Meters (refer to Playback for more
information). The left channel is channel 1 (Ch 1) and the right channel is channel 2 (Ch 2).

MENU » AUDIO / TC > INTERNAL MICROPHONE (CH 1/2)

Left Gain (Ch 1)

-0.8 dB
-0.4 dB

> 0.0dB <

0.4dB
0.8dB

(0]3¢

You can adjust the internal audio levels for left and right from -52.5 dB to 36.0 dB.
The default setting is 0 dB.

When you enable Link Left & Right Gain, the adjustments you make to either channel of gain will adjust both channels to
the same setting.
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EXTERNAL AUDIO

Use the External Audio settings to set the left and right external audio levels. This menu is only enabled when the Audio
Source is set to External or set to Internal and External.

NOTE: When the Recording Frame Rate is set to a higher speed than the Project Time Base setting, audio is recorded
as varispeed audio.

MENU > AUDIO /TC MENU > AUDIO / TC » EXTERNAL (CH 3/4)

Audio Source External (Ch 3/4) ¥ Ch 3 Gain

Ch 4 Gain

External (Ch 3/4) > Link Ch 3 & Ch 4 Gain

Headphone > Ch 3 Source
Timecode Source Internal TOD ¥ Ch 3 Limiter

Auto Jam |

The External Microphone is represented as Channels 3 and 4 on the Ul VU Meters (refer to Playback for more
information).

MENU > AUDIO / TC > EXTERNAL (CH 3/4) You can adjust the external audio levels for Ch 3 and Ch 4 from -8.0 dB to
. 34.0 dB.
Ch 3 Gain
The default setting is 1.0 dB.
-5.0dB When you enable Link Ch 3 & Ch 4 Gain, the adjustments you make to either
20dB channel of gain will adjust both channels to the same setting.

>  1.0dB <

4.0dB
7.0dB

(0] 4 Cancel

SOURCE
Use Source to select the type of input connected to external audio channel 3 and 4 ports.
MENU > AUDIO / TC > EXTERNAL (CH 3/4) You can select microphone, line, or +48V phantom power.

Cch 3 Source The default setting is microphone (Mic).

(0]1¢ Cancel
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LIMITER
When enabled, use the limiter to place a limit past which the audio level for channels 3 and 4 cannot exceed.
MENU > AUDIO / TC > EXTERNAL (CH 3/4) You can select from -2.0 to -12.0 Decibel Full Scale (dBFS) as the limit.
Cch 3 Limiter Level The default limit is -6.0 dBFS.

-4.0 dBFS
-5.0 dBFS

> -6.0dBFS <

-7.0 dBFS
-8.0 dBFS

(0]3¢

HEADPHONE

Use the Headphone settings to enable the headphone jack and to adjust the headphone volume.

MENU > AUDIO/TC MENU » AUDIO / TC » HEADPHONE

Audio Source External (Ch 3/4) ¥ Enable

Volume

External (Ch 3/4) >
Headphone >
Timecode Source Internal TOD ¥

Auto Jam |

You can enable and disable the headphone audio jack by tapping the Enable toggle to the right (green) and to the left
(red).

TS N

You can adjust the headphone volume from 0 to 100. The default is 75.

MENU » AUDIO / TC » HEADPHONE

73
74

> 75 <
76
77

(0]4 Cancel Edit

an
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TIMECODE SOURCE

Use Timecode source to configure the Timecode source the camera applies to the recordings.

MENU > AUDIO /TC MENU > AUDIO /TC

Audio Source Internal Microphone ... ¥ Timecode Source
Internal Microphone (Ch 1/2) >

External (Ch 3/4) >

> Internal TOD <

Headphone > Internal Manual
Timecode Source Internal TOD ¥ External

Auto Jam & OK  Cancel

You can select the following Timecode sources:
® |nternal Time of Day (TOD)

® Internal Manual

¢ External

® Precision Time Protocol (PTP)

INTERNAL TOD

Use Internal Time of Day (TOD) to JAM to the camera's internal Timecode generator. When using Internal TOD, a jam
between the running timecode and a real time clock is required. The time at which this jam occurs will have an effect on
the overall timecode drift over a 24-hour period due to the nature of non-drop-frame (NDF) timecode.

By enabling Auto-Jam, the camera automatically jams its timecode, ensuring repeatable drift across multiple cameras
and days. When Auto Jam is disabled, you can manually pick the instant in which you want to jam timecode to the real
time clock.

INTERNAL MANUAL

Use Internal Manual to JAM to the camera's internal Timecode generator and edit the Timecode starting number.
Select Manual Timecode OK to open the JAM and editing options:

MENU > AUDIO /TC

Headphone >

Timecode Source Internal Manual Y

Manual Timecode

Timecode Display Mode
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Select JAM to jam to the internal Timecode or select Manual Timecode to open the editing screen:

TIMECODE 00:00:00

Manual Jam

> Manual Timecode 00:00:00

Cancel NE]

Enter the desired Timecode number and select OK. Select JAM to jam to the edited Timecode number.

EXTERNAL

Use External to connect an external Timecode generator to the 9-contact 0B Extension port (refer to Camera Body and
Extension Port for more information).

PRECISION TIME PROTOCOL (PTP)

Precision Time Protocol (SMPTE 2059-1) is a network-based synchronization method which when configured using a
USB-C to Ethernet adapter offers a level of precision that supports frame-accurate camera synchronization over IP. PTP
in the KOMODO-X camera body only offers frame-level precision and therefore cannot be used for sensor scan
synchronization. PTP Timecode can be sent over USB-C through an Ethernet adapter.
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TIMECODE DISPLAY MODE

Use Timecode Display Mode to configure the Timecode display type that the camera applies to the recordings.

MENU > AUDIO/TC MENU > AUDIO / TC

Headphone > Timecode Display Mode
Timecode Source Internal TOD ¥

Auto Jam |

> TOD <

Edge

Timecode Display Mode OK  Cancel

You can set the Timecode Display Mode as Time of Day (TOD) or Edgecode (Edge).

TOD DISPLAY MODE

Time of Day (TOD) display mode displays the Timecode as the time of day that the frame was recorded.

EDGE DISPLAY MODE

Edgecode (Edge) display mode displays the Timecode as the sequential recording time that has elapsed starting with
the first frame. In the Media > Secure Format > Edgecode menu, you can enter a unique edgecode number as the
starting number on the media.

Edgecode is a SMPTE Timecode track, which by default starts at 01:00:00 on the first frame of each media card. It is a
sequential code that is continuous from frame to frame and also between clips. Edgecode is equivalent to RUN
RECORD as used on broadcast cameras.
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MONITORING MENU

The Monitoring menu contains the settings you use to configure your camera monitoring options.
From the Onboard LCD Touchscreen menu, select Monitoring:

MENU MENU > MONITORING

Image / LUT Onboard LCD
Project Settings Top LCD
Audio / TC SDI
Monitoring Live Stream

Media Tools

User Settings Guides

Use the Monitoring menu to configure the monitoring settings:

ITEMS DETAILS

Onboard LCD Onboard LCD Touchscreen settings

Top LCD DSMC3™ RED® Touch 7.0" LCD settings

SDI SDI port resolution, frequency, look, guides, tools, overlay, and overlay mode
Live Stream Enable or disable Wi-Fi live streaming

Tools Various monitoring tools including False Color, Peaking, and Zebra Modes
Guides Frame guides and a center guide
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ONBOARD LCD

Use Onboard LCD to configure the Onboard LCD Touchscreen settings.

MENU > MONITORING MENU > MONITORING > ONBOARD LCD

Onboard LCD Brightness 80% Y

Top LCD Look Image / LUT ¥

SDI
Live Stream Guides
Tools Tools

Guides Magnify LCDs

The LCD settings you can configure include:

ITEMS DETAILS

Brightness Adjust the Onboard LCD touchscreen brightness

Look Select the Image / LUT, RWG, Log3G10, or a Custom Display image preview
Custom Display Configure the Custom Display settings when enabled

Guides Enable or disable the camera guides

Tools Enable or disable the camera tools

Magnify LCDs Enable or disable LCDs magnification

Magnify Position (Global) Select the magnification area position

Prism Finder Mode Enable or disable the prism finder mode (horizontally flip the LCD)
BRIGHTNESS

MENU » MONITORING > ONBOARD LCD

Brightness

(0]1¢ Cancel

You can adjust the camera's top LCD brightness from 10% to 100%. The default is 80%
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LOOK

MENU » MONITORING » ONBOARD LCD

> Image/LUT <

RWG / Log3G10
Custom Display

(0] 4 Cancel

CUSTOM DISPLAY

... > MONITORING » ONBOARD LCD » CUSTOM DISPLAY

Output Color Space Rec. 709 ¥
Output Tone Map Medium Contrast ¥

Highlight Roll-Off Soft v

Display Preset

3D LUT

CDL

GUIDES

You can select the look of the image preview signal sent to the Top
LCD.

The selections include:

¢ Image / LUT (default)

e REDWideGamutRGB / Log3G10

e Custom Display (enables the Custom Display menu)

Use Custom Display (enabled from the Look menu) to select the Onboard
LCD's Image/LUT settings.

Refer to Image / LUT Menu for more information about the specific look
settings and menus.

Use the toggle to enable (default) or disable the camera guides.
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TOOLS

Use the toggle to enable (default) or disable the camera tools.

Tools Tools

MAGNIFY LCDS
Use the toggle to enable or disable (default) Onboard LCD and Top LCD magnification.

Magnify LCDs Magnify LCDs

MAGNIFY POSITION (GLOBAL)

MENU > MONITORING > ONBOARD LCD Use Magnify Position (Global) to select the position of the magnified area for

Magnify Position (Global) all LCD magnification.

Lower Left
Upper Middle

> Center <

Lower Middle
Upper Right

(0]1¢ Cancel

PRISM FINDER MODE
Use the toggle to enable or disable (default) the LCD flip view.
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TOP LCD

Use Top LCD to configure the DSMC3™ RED® Touch 7.0" LCD settings.

MENU > MONITORING

Onboard LCD

Top LCD

SDI

Live Stream

Tools

Guides

MENU > MONITORING » TOP LCD

Resolution Auto ¥

Look Image / LUT ¥

Guides
Tools

Magnify LCDs

The LCD settings you can configure include:

ITEMS DETAILS
Resolution Adjust the RED® Touch 7.0" LCD resolution
Look Select the Image / LUT, RWG, Log3G10, or a Custom Display image preview

Custom Display

Configure the Custom Display settings when enabled

Guides

Enable or disable the camera guides

Tools

Enable or disable the camera tools

Magnify LCDs

Enable or disable LCD magnification

Magnify Position (Global)

Select the LCD magnification area position

Prism Finder Mode

Enable or disable the prism finder mode (horizontally flip the LCD)

RESOLUTION

MENU > MONITORING > TOP LCD

Resolution

(0]1¢ Cancel

You can select the resolution of the Top LCD.

The selections include:
® Auto (default)

* 1080p

e 2K DCI
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LOOK

MENU > MONITORING > TOP LCD You can select the look of the image preview signal sent to the Top LCD.

The selections include:
e Image / LUT (default)
e REDWideGamutRGB / Log3G10

¢ Custom Display (enables the Custom Display menu)

> Image/LUT <

RWG / Log3G10
Custom Display

(0] 4 Cancel

CUSTOM DISPLAY

MENU > MONITORING > TOP LCD > CUSTOM DISPLAY Use Custom Display to configure the Top LCD independently of the
camera's Image / LUT settings or other monitor output configurations.

Output Color Space Rec. 709 ¥ _ .
Refer to Image / LUT Menu for more information about the Image/LUT

Output Tone Map Medium Contrast ¥ settings and menus.

Highlight Roll-Off Soft v

Display Preset

3D LUT

CDL

GUIDES

Use the toggle to enable (default) or disable the camera guides.
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TOOLS

Use the toggle to enable (default) or disable the camera tools.

Tools Tools

MAGNIFY LCDS

Use the toggle to enable or disable (default) LCD magnification.

Magnify LCDs Magnify LCDs

MAGNIFY POSITION (GLOBAL)

Use Magnify Position (Global) to select the position of the magnified area for all LCD magnification.

MENU > MONITORING » TOP LCD

Magnify Position (Global)

Lower Left
Upper Middle

> Center <

Lower Middle
Upper Right

(0]1¢ Cancel

Use Magnify Position to globally select the area of the image you want to magnify.
The selections include:

o Left ¢ Upper Middle ¢ Upper Right
e Upper Left ¢ Center (default) ¢ | ower Right
® L ower Left ¢ L ower Middle ¢ Right

PRISM FINDER MODE
Use the toggle to enable or disable (default) the LCD flip view.

Prism Finder Mode g Prism Finder Mode 0
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SDI
Use SDI to configure the SDI port settings.

MENU > MONITORING MENU > MONITORING > SDI

Onboard LCD Frequency 23.98Hz ¥

Top LCD Resolution 1080p ¥

SDI Look Image / LUT ¥
Live Stream
Tools

Guides

The SDI port settings you can configure include:

ITEMS DETAILS

Frequency Select the SDI port frequency

Resolution Select the SDI port resolution

Look Select the Image / LUT, RWG, Log3G10, or a Custom Display image preview
Custom Display Configure the Custom Display settings when enabled

Guides Enable or disable the monitor guides

Tools Enable or disable the monitor tools

Magnify Enable or disable monitor magnification

Magnify Position (Global) Select the magnification area position

Overlay Enable or disable the monitor overlay

Overlay Mode Select the overlay type

Overlay Opacity Select the opacity of the overlay

Flip / Mirror Flip and mirror the image output to the monitor

WARNING: Under certain circumstances, it is possible for an SDI connector to incur damage when connected to an
accessory and powered without using shielded cables. RED recommends only using high quality, shielded BNC cables
that are rated for 12G-SDI signals and only using shielded power cables for powering SDI accessories.

Make sure power is connected to the SDI accessory at all times before you connect the BNC to the camera.
Ungrounded power from SDI accessories can damage the camera’s SDI port. To avoid this possible damage, attach the
power source to the accessory before attaching it to the BNC cable. When using RED Approved Third Party battery
plates, unplug the BNC cable prior to hot swapping.

When possible, avoid using P-Tap (also known as D-Tap) cables to power accessories. To avoid damage when using P-
Tap/D-Tap, it’s imperative that the connect/disconnect sequence (below) is followed precisely.
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BNC ATTACHMENT INSTRUCTIONS
When attaching SDI accessories:
1. Connect a power source to the SDI accessory; power on the SDI accessory.

2. Ensure a power source is connected to the camera. This ensures both are grounded prior to connecting the BNC.
The camera's power state does not have an impact on SDI attachment sequence.

3. Connect the BNC cable to the accessory, then to the camera.

When detaching an accessory mounted to an SDI output, ensure that you remove the BNC connection to the camera
before removing power to the SDI device:
1. Shutdown the SDI accessory.

2. Disconnect the BNC cable from the camera.
3. Disconnect the power source from the SDI accessory.

When you need to swap out a battery on an accessory mounted to the camera’s SDI port, you must:
1. Shutdown the SDI accessory.

2. Disconnect the BNC cable from the camera.

3. Replace the battery on the SDI accessory.

4. Connect the BNC cable to the camera.

5. Power on the SDI accessory.

For more information, refer to Preventing Damage to SDI Outputs.

FREQUENCY
MENU > MONITORING > SDI Use Frequency to select one of the following SDI port frequency settings:
Frequency ® 23.98 Hz (default)
® 29.97 Hz
® 59.94 Hz

> 2398Hz <

29.97 Hz
59.94 Hz

(0] ¢
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RESOLUTION
MENU > MONITORING > SDI Use resolution to select one of the following SDI port resolution settings:
Resolution * 1080p (default)
* 2K DCI
® 4K UHD
* 4K DCI

The resolution selected here controls the SDI output resolution of the
preview page.

(0] 4 Cancel

SCALING PREVIEW

When monitoring in 1080p or 4K UHD while capturing in a 17:9 format, the entire 17:9 image will be down-scaled to the
16:9 aspect ratio of 1080p or 4K UHD. Small black bars will only appear on the top and bottom of the frame in the
monitor path and not on the recorded image.

LOOK

MENU > MONITORING > SDI You can select the look of the image preview signal sent to the SDI port.

The selections include:

® Image / LUT (default)

®* REDWideGamutRGB / Log3G10

® Custom Display (enables the Custom Display menu)

> Image/LUT <

RWG / Log3G10
Custom Display

CUSTOM DISPLAY

MENU > MONITORING > SDI > CUSTOM DISPLAY Use Custom Display (enabled from the Look menu) to select the SDI's

isolated look settings.
Output Color Space Rec. 709 ¥ . _ -
Refer to Image / LUT Menu for more information about the specific look

TR Y el 4 Settings and menus.

Highlight Roll-Off Soft ¥

Display Preset SDR ¥

3D LUT >

CDL >
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GUIDES

Use Guides to enable or disable (default) the viewing of guides. Tap the switch to toggle between enabled and disabled.

TOOLS

Use Tools to enable or disable (default) the viewing of tools. Tap the switch to toggle between enabled and disabled.

Tools Tools

MAGNIFY

Use Magnify to enable or disable (default) monitor magnification. Tap the switch to toggle between enabled and
disabled.

MAGNIFY POSITION (GLOBAL)

Use Magnify Position (Global) to select the position of the magnified area for all magnification.

MENU > MONITORING » TOP LCD

Magnify Position (Global)

Lower Left

Upper Middle
> Center <

Lower Middle
Upper Right

(0]1¢ Cancel

Use Magnify Position to globally select the area of the image you want to magnify.
The selections include:

o | eft ¢ Upper Middle ¢ Upper Right
¢ Upper Left e Center (default) ¢ | ower Right
e Lower Left ¢ Lower Middle ¢ Right
OVERLAY

Use Overlay to enable (default) or disable the viewing of the overlay. Tap the switch to toggle between enabled and
disabled.

COPYRIGHT © 2023 RED.COM, LLC 955-0218, REVB | 100



KOMODO-X" OPERATION GUIDE

OVERLAY MODE

MENU > MONITORING > SDI Use Overlay Mode to select one of the following SDI port overlay modes:

® Simple - Minimal image information is displayed (refer to Simple Mode)

® Basic - Simple plus time sensitive media and battery information (refer to
Basic Mode)

® Standard - Industry standard image and camera details are displayed (refer
to Standard Mode)

Overlay Mode

. ® Advanced - Standard plus exposure and audio meters (refer to Advanced
> S|mp|e Mode)
Basic ® Technical - Advanced plus lens focus distance and monitor look status

(refer to Technical Mode)
Standard

(0]3¢

SIMPLE MODE

Simple mode displays the clip name and the current Timecode. When the camera is recording, the Timecode turns red,
and a red dot appears in the top right corner.

W006_A003
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BASIC MODE

B002_C319 ) 15:51:51:03

Basic mode displays the following:

¢ Clip Name

® CFexpress Time Remaining (at the current settings)

® Timecode

® Battery percentage remaining (at the current settings)
¢ DC-IN

When the camera is recording, the Timecode turns red, and a red dot appears in the top right corner.

B002_C319
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STANDARD MODE

23.98FPs 1s0800 5600k

6K 17:9 | R3D MQ + 422 HQ DC-IN 15.1V 15:51:56:16

Standard mode displays the following:

TOP BOTTOM

e Camera ID ¢ Clip Name

¢ Recording Frame Rate e CFexpress Time Remaining
e f-Stop ¢ Format, File Type, Rate

* Focus Length ¢ Battery

e Shutter Angle e DC-IN

¢ ISO ¢ Timecode

¢ White Balance

Lens items such as Focal Length and f-Stop will adaptively display depending on whether the lens data is available.
When the camera is recording, the Timecode turns red, and a red dot appears in the top right corner.

B 23.98FPs 112.8 50mm 180° 150800 5600k

6K 17:9 | R3D MQ + 422 HQ DC-IN 15.1V
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ADVANCED MODE
23.98FPs 1s0800 5600k

DC-IN15.1V 6K 17:9
BAT-1 98¢ R3D MQ + 422 HQ

Advanced mode displays the following:

TOP BOTTOM

e Camera Number ¢ Clip Name ¢ Timecode, Genlock, Synch
¢ Recording Frame Rate ¢ Exposure Meter e DC-In, Battery

e {-Stop ¢ Histogram e Format, File Type, Rate

* Focus Length ¢ CFexpress Time Remaining ® VU Meter

e Shutter Angle e Temperature / Exposure e Timecode

¢ ISO Calibration

¢ White Balance

When the camera is recording, the Timecode turns red, and a red dot appears in the top right corner.
B 23.98FpPs 2.8 50mm 180° 150800 5600k

DC-IN 15.1V 6K 17:9
BAT-1 98¢ R3D MQ + 422 HQ
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TECHNICAL MODE

B 23.98FPs 1s0800 5600k

Lens Focus

; CAMERA NAME: DC-IN 15.1V 6K 17:9 EE AL
‘\,, B002.C319  CFx0:28 BKIO00000  bom oen© maome e az2mq 15:55:46:04

Technical mode displays the following:

TOP BOTTOM

e Camera ID e Exposure Meter e Format, File Type, Rate
¢ Recording Frame Rate ¢ Histogram * Timecode

e f-Stop ¢ Clip Name ¢ VU Meter

* Focus Length ¢ CFexpress Time Remaining

e Shutter Angle e Temperature / Exposure

¢ ISO Calibration

¢ White Balance ¢ Timecode, Genlock, Synch

¢ SDI Look e Camera Name

e DC-In, Battery

When the camera is recording, the Timecode turns red, and a red dot appears in the top right corner.

B 23.98Fps 150800 5600k

Lens Focus

I

F CAMERA NAME: DC-IN 15.1V 6K 17:9
B002_C319 CFX0:28 KXBK1000000  BAT-1 98% R3D MQ + 422 HQ
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OVERLAY OPACITY

MENU > MONITORING > SDI

Overlay Opacity

(0]1¢ Cancel

Use Overlay Opacity to select the percentage of opacity you want the overlay to display on the SDI output.

The opacity values the camera can display are between 100% and 0%.

FLIP / MIRROR

Use Flip / Mirror to enable or disable the flipped mirrored orientation of the SDI output. Press SEL to toggle between
enabled and disabled (default).

Flip / Mirror | Flip / Mirror o)

SDI PORT DESCRIPTION

The Serial Digital Interface (SDI) port allows the camera to deliver 12 Gbps of image bandwidth with greater resolution,
frame rates, and color fidelity. This single BNC cable solution makes it ideal for the 4Kp60 format. The output signal bit
depth is 10-bit 4:2:2.

WARNING: Under certain circumstances, it is possible for an SDI connector to incur damage when connected to an
accessory and powered without using shielded cables. RED recommends only using high quality, shielded BNC cables
that are rated for 12G-SDI signals and only using shielded power cables for powering SDI accessories.

Make sure power is connected to the SDI accessory at all times before you connect the BNC to the camera.
Ungrounded power from SDI accessories can damage the camera’s SDI port. To avoid this possible damage, attach the
power source to the accessory before attaching it to the BNC cable. When using RED Approved Third Party battery
plates, unplug the BNC cable prior to hot swapping.

When possible, avoid using P-Tap (also known as D-Tap) cables to power accessories. To avoid damage when using P-
Tap/D-Tap, it’s imperative that the connect/disconnect sequence (below) is followed precisely.

BNC ATTACHMENT INSTRUCTIONS

When attaching SDI accessories:
1. Connect a power source to the SDI accessory; power on the SDI accessory.

2. Ensure a power source is connected to the camera. This ensures both are grounded prior to connecting the BNC.
The camera's power state does not have an impact on SDI attachment sequence.

3. Connect the BNC cable to the accessory, then to the camera.
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When detaching an accessory mounted to an SDI output, ensure that you remove the BNC connection to the camera
before removing power to the SDI device:
1. Shutdown the SDI accessory.

2. Disconnect the BNC cable from the camera.
3. Disconnect the power source from the SDI accessory.

When you need to swap out a battery on an accessory mounted to the camera’s SDI port, you must:
1. Shutdown the SDI accessory.

2. Disconnect the BNC cable from the camera.

3. Replace the battery on the SDI accessory.

4. Connect the BNC cable to the camera.

5. Power on the SDI accessory.

For more information, refer to Preventing Damage to SDI Outputs.

For more information about the SDI standard, refer to the SMPTE (Society of Motion Picture
and Television Engineers) standard SMPTE ST-2082.
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LIVE STREAM

Use Live Stream to enable or disable live streaming over Wi-Fi. The Live Stream image is controlled by the LCD
monitoring tools (the Guides are not displayed). Refer to Monitoring Tools for more information.

NOTE: When live streaming, select 5 GHz as the Wi-Fi band (refer to Ad-Hoc).

MENU > MONITORING MENU » MONITORING » LIVE STREAM

Onboard LCD

Source

Top LCD

Enable

SDI

Live Stream

Tools

Guides

SOURCE

Source displays the source of the Live Stream image. Live stream displays the looks, tools, and magnification enabled
for that source.

MENU » MONITORING » LIVE STREAM

Source

Enable

ENABLE

Use Enable to enable or disable (default) the Live Stream feature.

TS
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QUALITY FACTOR

Use Quality Factor, when Live Streaming is enabled, to control the video quality the camera's output stream. Lower
quality can stream over a longer distance.

MENU > MONITORING » LIVE STREAM MENU » MONITORING > LIVE STREAM

Source Quality Factor

Enable

Low

>  Medium

Quality Factor Medium ¥

High

(0]14 Cancel

TOOLS

The Tools menu provides access to the monitoring tools you use to monitor image exposure and focus.

MENU > MONITORING MENU > MONITORING » TOOLS

Onboard LCD False Color
Top LCD Peaking
SDI Log View

Live Stream Zebra 1

Tools Zebra 2

Guides

The monitoring tools that you can use include:

ITEMS DETAILS

False Enable and configure the False Color Exposure Mode, False Color Video Mode, and the False Color Video
Color Mode

Peaking Enable and configure focus indicating modes

Log View Enable or disable (default) Log View

Zebra 1 Enable and configure Zebra 1 settings

Zebra 2 Enable and configure Zebra 2 settings
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FALSE COLOR

Use False Color to configure the False Color tool settings.

MENU > MONITORING > TOOLS MENU > MONITORING » TOOLS > FALSE COLOR

False Color Enable

Peaking

Log View
Zebra 1

Zebra 2

The False Color tool settings you can configure include:

ITEMS DETAILS

Enable Enable or disable the False Color tool modes

False Color Mode Select the False Color tool mode

False Color Gio Scope Identify 16+ increments within the dynamic range of the RAW sensor image.
Mode

ENABLE

Use Enable to enable or disable the False Color tool.

TS CETY
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FALSE COLOR MODE

MENU > MONITORING > TOOLS > FALSE COLOR MENU > MONITORING » TOOLS > FALSE COLOR

Enable |

Mode Exposure ¥

> Exposure <

Video
Gio Scope

(0]

False Color Modes include:

ITEMS DETAILS

False Color Exposure Mode Use false colors to determine an optimal balance between overexposure and
underexposure.

False Color Video Mode Access scene exposure in varying light without relying on the LCD image brightness.

False Color Gio Scope Identify 16+ increments within the dynamic range of the RAW sensor image.

Mode

NOTE: False Color modes display on video recorded through SDI to an external recorder when the Tools are enabled in
the Monitor menu. When recording through SDI, use False Color modes only to help determine scene exposure
settings, and then disable the mode before recording.

FALSE COLOR EXPOSURE MODE
When this monitoring False Color mode is activated, most of the tonal range will appear in monochrome.

The Exposure Mode is able to indicate exactly where middle gray is falling, and indicate which highlights or shadows
are problematic in the logarithmic representation of the image. Exposure mode is judging the exposure after ISO and
White Balance adjustments are made, and before any sort of LUT or transform is applied to the Log3G10 image.

RED FALSE COLOR OVERLAY

When the False Color Mode overlays the color red within the subject of interest, or anywhere except bright lights and
direct reflections, then the image is likely overexposed. When the False Color Mode does not overlay the color red on
the image, then the exposure is likely okay for the selected I1SO.

PURPLE FALSE COLOR OVERLAY

When the False Color Mode overlays the color purple on key image detail that is not located in the shadows, then the
scene is likely underexposed. When the False Color Mode does not overlay the color purple on the image, then the
exposure is likely okay for the selected ISO.

For more information, refer to Exposure in the How To section.
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FALSE COLOR VIDEO MODE

NOTE: For best results, Video Mode should be viewed at or above ISO 800.

Video Mode displays a color overlay that indicates the video level of the RGB monitor path (calibrated to the SMPTE
test signal).

The colors used are based on the RGB levels of the video out signal (that is, the “cooked” look, and not RAW data). The
camera's RGB settings can change the appearance of the Video Mode colors.

The Video Mode colors represent the following IRE values (at all other values, the desaturated image represents the
luminance value of the ISO adjusted image):

e Purple: IRE 04 o Green: IRE 41-48 e Yellow: IRE 94-95
e Blue: IRE 5 e Pink: IRE 61-70 « Orange: IRE 96-98
e Teal: IRE 10-12 « Straw: IRE 92-93 e Red: IRE 99-100

For more information, refer to Exposure in the How To section.

Green Pink Straw Yellow Orange

Green is where you will want 18% gray, Pink is typically the brightness of Caucasian skin tones, Straw, Yellow, and
Orange are strong highlights and increasingly closer to white, Teal is deep shadows and Blue is on the verge of
becoming untextured black. In general, Pink and Green are most helpful when calibrating based on a known reference,
whereas the other colors indicate the extremes of a tonal range.

A potential disadvantage of False Color Video mode is that all the false colors can distract from the underlying preview.
Many prefer to use this mode only during initial set-up, and then they use False Color Exposure Mode under a wider
range of scenarios.

IN PRACTICE

In False Color Exposure Mode, use the purple and red indicators to adjust your lighting or lens aperture. Use this
strategy to achieve an optimal balance between clipping from overexposure and image noise from underexposure. With
most scenes, you can often have a surprising range of exposure latitude before excessive red or purple indicators begin
to appear.

If necessary, use False Color Video mode or Zebra Modes to fine-tune how the scene will appear over SDI, or use it to
adjust your suggested look when sending footage for post-production.

The Zebra and Video modes are also an objective way to assess the scene exposure under varying ambient light
without relying on the LCD image to evaluate brightness.

FALSE COLOR GIO SCOPE MODE

Gio Scope mode displays a color overlay on top of a desaturated RAW sensor image, identifying 16 increments within
the dynamic range of the sensor. The RGB settings (color temperature, ISO, LUT, etc.) are not used by this mode.

Each number (1 to 16) indicates a different increment of dynamic range. Number 16 represents the top increment, and is
broken up into 1/8th sub-increments to show highlight roll-off. Each 1/8th increment is represented by a different shade
of red, ranging from light red (less light) to dark red (most light, clipping).
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PEAKING
The Peaking tools display contrast, outlines, or colors to assist with focusing.

MENU > MONITORING » TOOLS MENU > MONITORING » TOOLS > PEAKING

Peaking ¥

False Color

Peaking

Log View
Zebra 1

Zebra 2

MENU > MONITORING > TOOLS » PEAKING

Focus
Edge

> Peaking <

(0]1¢ Cancel

The Peaking modes you can use include:

ITEMS DETAILS

Focus Use enhanced contrast and edges for focusing
Edge Show outlines of focused objects

Peaking Select a colored overlay to indicate objects in focus

FOCUS PEAKING MODE

Focus Peaking mode emphasizes contrast and edges in the image without changing the brightness or the image
content. This mode makes it easier to judge focus. Adjust the zoom and focus to easily see which objects are coming
into focus.
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EDGE PEAKING MODE

When you enable Edge Peaking mode, the display shows the edges or outlines of objects that are in focus.

PEAKING PEAKING MODE

The Peaking Peaking mode displays a color overlay on top of in-focus edges. Select a Level of 1 to 10 (weak to strong)
for the intensity of the color overlay. The RGB settings can change the appearance of the selected color overlay.

The Peaking Peaking mode indicator is applied after the image is scaled to a monitor, making the indicators appear
differently on various monitors.

For more information about Peaking, refer to Focus in the How To section.

LOG VIEW

Use Log View to display camera images in REDWideGamutRGB and Log3G10 for the ISO, Exposure Adjust, Color
Temperature, and Tint settings. This allows you to quickly see ungraded footage that remains unaffected by creative
decisions such as the choice of 3D LUT or CDL.

Log View is passed through the SDI port when recording to an external recorder. You can view the Log image in
playback on the LCD and on the monitor. However, Log View is not recorded to the file recorded on the media card.

NOTE: Log View is only enabled on R3D files and not on ProRes files.

MENU > MONITORING > TOOLS

False Color

Peaking

Log View

Zebra 1

Zebra 2

Use the toggle to switch from Enabled to Disabled:

Log View | Log View (O]
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ZEBRA 1

Use Zebra 1 to display one set of diagonal stripes to indicate highlight exposure levels. For more information, refer to
Zebra Modes.

Zebra 1 is disabled by default.

MENU > MONITORING » TOOLS MENU > MONITORING » TOOLS > ZEBRA 1 MENU > MONITORING > TOOLS > ZEBRA 1

Enable & Low IRE

High IRE 100 IRE |#

False Color

Peaking

Log View
Zebra 1

Zebra 2

9

(]

3
(&

(0].¢

The Zebra 1 mode includes:

ITEMS DETAILS

Enable Enables red zebra stripes to indicate highlight exposure
Low IRE Sets the lower threshold for the indicator

High IRE Sets the higher threshold for the indicator

ENABLE

The Enable toggle switch allows you to enable or disable the Zebra 1 stripes.

LOW IRE
Provides a keypad that allows you to set the low threshold for the Zebra stripe. The default setting is 98 IRE.

HIGH IRE
Provides a keypad that allows you to set the high threshold for the Zebra stripe. The default setting is 100 IRE.

NORMAL VIEW ZEBRA 1 VIEW
i .. | B I ] k.
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ZEBRA 2

Use Zebra 2 to display a second set of diagonal stripes to indicate mid-tone and shadow levels. For more information,
refer to Zebra Modes.

Zebra 2 is disabled by default.

MENU > MONITORING » TOOLS MENU > MONITORING » TOOLS > ZEBRA 2 MENU > MONITORING > TOOLS » ZEBRA 2

Enable & Low IRE

False Color

Low IRE 40 IRE | #

Peaking

Log View High IRE 48 IRe |/
Zebra 1

Zebra 2

The Zebra 2 mode includes:

ITEMS DETAILS

Enable Enables green zebra stripes to indicate mid-tone and shadow exposure
Low IRE Sets the lower threshold for the indicator

High IRE Sets the higher threshold for the indicator

ENABLE

The Enable toggle switch allows you to enable or disable the Zebra 2 stripes.

LOW IRE
Provides a keypad that allows you to set the low threshold for the Zebra stripe. The default setting is 40 IRE.

HIGH IRE
Provides a keypad that allows you to set the high threshold for the Zebra stripe. The default setting is 48 IRE.

NORMAL VIEW ZEBRA 1 VIEW ZEBRA 2 VIEW
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GUIDES

Use Guides to enable and configure the camera's monitoring guides.

MENU > MONITORING MENU > MONITORING > GUIDES

Onboard LCD Frame Guide 1

Top LCD Frame Guide 2

SDI Frame Guide 3

Live Stream Center Guide

Tools

Guides

The monitoring Guides that you can use include:

ITEMS DETAILS
Frame Guides Guides you can configure to aid in framing a shot
Center Guide A center cross hair or dot you can use to center your shot

FRAME GUIDES

Use Frame Guides to frame the scene using various shapes and sizes. You can configure up to 3 Frame Guides to
display on your monitor.

MENU > MONITORING > GUIDES MENU > MONITORING > GUIDES > FRAME GUIDE 1

Frame Guide 1 Enable
Frame Guide 2 Mode

Frame Guide 3

Center Guide Scale

Offset X

Offset Y

Configure the Frame Guides using the following:

ITEMS DETAILS

Enable Enables the Frame Guide

Mode Select aspect ratios, User, and Absolute modes

User Aspect Ratio Enabled by selecting User mode

Scale Percentage of the image the Frame Guide occupies

Offset X, Y Percentage of horizontal and vertical offset

Absolute X, Y, W, H Absolute mode - set the exact number of size and offset pixels
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ITEMS DETAILS

Line Style Select the Frame Guide line type - solid, dashed or bracket
Line Color Select the Frame Guide line color

Line Opacity Select the Frame Guide line opacity percentage

Shade Outside Enables shading outside of the Frame Guide

Shade Color Select the shading color

Shade Opacity Select the shading opacity

MODE

Use Mode to select the Frame Guide mode you want to use to configure the frame guide.

MENU > MONITORING > GUIDES > FRAME GUIDE 1 MENU > MONITORING > GUIDES » FRAME GUIDE 1

Scale 100.00%

Offset X

Offset Y _ (0]4 Cancel

The modes you can select include aspect ratios from Full to 2.4:1, User, and Absolute. The User and Absolute modes
enable settings that are specific to those modes.

USER ASPECT RATIO
This item is enabled when the User mode is selected.

MENU > MONITORING > GUIDES > FRAME GUIDE 1 MENU > MONITORING > GUIDES > FRAME GUIDE 1

Enable = User Aspect Ratio

Mode 1.0000]: 1

User Aspect Ratio
Scale

Offset X

9
6
3
&

Offset Y (0] ¢

Use the keypad to enter your desired aspect ratio.
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SCALE
Use scale to configure the percentage of the image area that the Frame Guide will frame.

MENU > MONITORING > GUIDES > FRAME GUIDE 1 MENU > MONITORING > GUIDES > FRAME GUIDE 1

Enable

Mode

User Aspect Ratio

Scale

Offset X

Offset Y

Use the keypad to enter the percentage of the image the Frame Guide contains.

OFFSET X, Y
Use offset to configure the X and Y offset of the Frame Guide.

MENU > MONITORING > GUIDES > FRAME GUIDE 1 MENU > MONITORING > GUIDES > FRAME GUIDE 1

Enable & Offset X
Mode

User Aspect Ratio

Scale

Offset X

Offset Y

Use the keypad to enter the percentage of offset from center you want to apply to the Frame Guide.
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ABSOLUTE X, Y, W, H
Use the Absolute settings to configure the absolute dimensions and position of the Frame Guide.

MENU > MONITORING > GUIDES > FRAME GUIDE 1 MENU > MONITORING > GUIDES > FRAME GUIDE 1

Absolute Offset X Opx | Absolute Offset X

Absolute Offset Y Opx |/
Absolute Width 3240px |#
Absolute Height 3240px |#
Line Style Solid ¥

Line Color White ¥

Use the keypad to enter the number of pixels for X/Y offset and for the width and height of the Frame Guide. The
Absolute items are only enabled when you select Absolute Mode.

LINE STYLE
Use Line Style to select the type of line the Frame Guide uses.

MENU > MONITORING > GUIDES > FRAME GUIDE 1 MENU > MONITORING > GUIDES » FRAME GUIDE 1

Absolute Offset Y Opx /' Line Style
Absolute Width 3240px |#
Absolute Height 3240px |# .
> Solid <

Line Style Solid ¥ Dashed

Line Color White ¥ Bracket

Line Opacity % OK  Cancel

Select Solid (default), Dashed, or Bracket for the Frame Guide line style.
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LINE COLOR
Use Line Color to select the color of the Frame Guide line.

MENU > MONITORING > GUIDES > FRAME GUIDE 1 MENU > MONITORING > GUIDES » FRAME GUIDE 1

Absolute Offset Y Opx |2 Line Color

Absolute Width 3240px |# Cyan
Dark Gray

> White <

Absolute Height 3240px |#
Line Style Solid ¥
Line Color White ¥

Line Opacity 50% Y

Use Line Color to select one of the following colors for the Frame Guide line:

e Black o Green e Cyan
e Red e Yellow e Dark Gray
e Blue e Magenta e White (default)

LINE OPACITY
Use Line Opacity to select how transparent the Frame Guide line appears.

MENU > MONITORING > GUIDES > FRAME GUIDE 1 MENU > MONITORING > GUIDES » FRAME GUIDE 1

Absolute Width 3240px 2/ Line Opacity
Absolute Height 3240px |#
Line Style Solid ¥
Line Color White ¥

Line Opacity 50% Y

Shade Outside i OK  Cancel

Use Line Opacity to select the percentage of opacity for the Frame Guide line:
* 25%

®* 50% (default)

* 75%

® 100%
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SHADE COLOR
Use Shade Color to select the color of shading to use outside of the Frame guide.

MENU > MONITORING > GUIDES > FRAME GUIDE 1 MENU > MONITORING > GUIDES » FRAME GUIDE 1

Line Style Solid ¥ Shade Color

Line Color White ¥
Line Opacity 50% ¥
Shade Outside |
Shade Color

Shade Opacity

Use Shade Color to select one of the following colors for the outside shading:

« Black (default) e Green e Cyan
e Red e Yellow e Dark Gray
o Blue « Magenta  White

SHADE OPACITY
Use Shade Opacity to select the opacity of the shading outside of the Frame guide.

MENU > MONITORING > GUIDES > FRAME GUIDE 1 MENU > MONITORING > GUIDES » FRAME GUIDE 1

Line Style Solid ¥ Shade Opacity
Line Color White ¥

Line Opacity 50% ¥

Shade Outside |

Shade Color

Shade Opacity OK  Cancel

Use Shade Opacity to select the percentage of opacity for the shading outside of the Frame Guide:
® 25% (default)

* 50%

®* 75%

®* 100%

COPYRIGHT © 2023 RED.COM, LLC 955-0218, REVB | 122



KOMODO-X" OPERATION GUIDE

CENTER GUIDE

Use Center Guide to enable and configure the Center Guide.

MENU > MONITORING > GUIDES

Frame Guide 1

Frame Guide 2

Frame Guide 3

Center Guide

MENU > MONITORING > GUIDES > CENTER GUIDE

Enable |

Type Cross ¥
Color White ¥

Opacity 50% Y

Configure the Center Guide by using the following:

ITEMS DETAILS

Enable Enables the Center Guide

Type Select Center Guide type - dot or cross
Color Select a color for the Center Guide
Opacity Percentage of opacity of the guide color
TYPE

Use Type to select the type of Center Guide to display.

MENU > MONITORING > GUIDES > CENTER GUIDE

Enable

Type

Color

Opacity

MENU > MONITORING > GUIDES > CENTER GUIDE

Cross ¥

White ¥

> Cross <

50% v Small Dot
Medium Dot

(0]4 Cancel

Use Type to select a center dot or cross (default) for the Center Guide.
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COLOR
Use Color to select the color used by the Center Guide.

MENU > MONITORING > GUIDES > CENTER GUIDE MENU > MONITORING > GUIDES > CENTER GUIDE

Enable |

Type Cross ¥ Cyan
Dark Gray

> White <

Color White ¥

(0] : 1114 50% ¥

Use Color to select one of the following colors for the Center Guide:

« Black « Green e Cyan
« Red e Yellow e Dark Gray
e Blue « Magenta o White (default)

OPACITY
Use Opacity to select how transparent the Center Guide appears.

MENU > MONITORING > GUIDES > CENTER GUIDE MENU > MONITORING > GUIDES > CENTER GUIDE

Enable |
Type Cross ¥

Color White ¥

Opacity 50% ¥

(0]4 Cancel

Use Opacity to select the percentage of opacity for the Center Guide:
* 25%

®* 50% (default)

®* 75%

®* 100%
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MEDIA MENU

The Media menu contains the settings you use to configure your media.
From the Onboard LCD touchscreen menu, tap Media:

MENU MENU > MEDIA

Image / LUT

Eject

Media Info

Project Settings

Audio / TC Secure Format
Monitoring
Media

User Settings

Use the Media menu to configure the camera's storage media settings and to view the media information:

ITEMS DETAILS

Eject Eject the media card

Media Info View the media card information

Secure Format Performs a secure format of the media card
EJECT

Use Eject to safely unmount the media card electronically from the camera before removing it physically.
WARNING: The media can get extremely hot. Use caution when removing media.

WARNING: Do not attach a label to the media card. The heat generated by the media can weaken the label's adhesive,
causing the label to detach inside of the camera. Labels can also diminish heat dissipation and cause excessive wear to
the internal components. Removing a label from a media card can possibly deform the card body.

Access Eject from the Onboard LCD Touchscreen Media menu:

MENU >» MEDIA
Eject
Media Info

Secure Format

For more information, refer to Media Management.
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MEDIA INFO

Use Media Info to display the media card information.
Access Media Info from the Onboard LCD Touchscreen Media menu:

MENU > MEDIA MENU » MEDIA > MEDIA INFO

Eject

Status Ready
Media Info Model Number AV PRO CFexpress XT ...
Secure Format Serial Number GO9DNCFA9NA0445

Firmware Version

Capacity

Available

Media Info displays the following:

SETTING DETAILS

Status Displays the media card status

Model Number Displays the media card model humber

Serial Number Displays the media card serial number

Firmware Version Displays the media card firmware version

Capacity Displays the media card total capacity

Available Displays the media card's remaining storage

Time Remaining Displays the recording time remaining on the media card

SECURE FORMAT

Use Secure Format to format the media card down to the file system level.
A secure format allows you to rebuild the card file system.

WARNING: Secure Format permanently deletes all information from the media card. Data cannot be recovered after a
Secure Format.

MENU > MEDIA MENU > MEDIA > SECURE FORMAT

Camera ID

Eject

Media Info Camera Position

Secure Format Reel Number 2

Edgecode 01:00:00 |/

Format (0]14
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Use the Secure Format menu to update the following information:

SETTING DETAILS

Camera ID Select the camera ID (default is A)
Camera Position Select the camera position (default is C)
Reel Number Select the reel number (default is 1)
Edgecode Enter the time number (default is 01:00:00)
Format Starts the Secure formatting process

For more information, refer to Secure Format.

CAMERA ID

Use Camera ID to assign a camera ID letter to the media.

MENU » MEDIA > SECURE FORMAT MENU » MEDIA > SECURE FORMAT

Camera ID Camera ID

Camera Position
Reel Number
Edgecode 01:00:00 |#

Format OK

(0] 4 Cancel

The Camera ID letters you can assign range from A-Z. For more information, refer to Secure Format.

CAMERA POSITION
Use Camera Position to select the camera position label for the media card.

MENU » MEDIA > SECURE FORMAT MENU > MEDIA > SECURE FORMAT

Camera ID Camera Position
Camera Position A

Reel Number

Edgecode 01:00:00 |/

B
C
D
Format (0] 4 E

(0]3¢ Cancel

The Camera Position letters you can assign range from A-Z. For more information, refer to Secure Format.
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REEL NUMBER

Use Reel Number to assign a reel number to the media.

MENU » MEDIA > SECURE FORMAT MENU » MEDIA » FORMAT > SECURE FORMAT

Camera ID Reel Number

Camera Position
Reel Number
Edgecode 01:00:00 |#

Format (0] ¢

Use the keypad to enter a unique reel number to the media.

NOTE: It is best practice to keep your reel numbers to no longer than seven characters in length to conform with all edit
decision list (EDL) formats.

For more information, refer to Secure Format.

EDGECODE

Use Edgecode to assign an edgecode to the media.

MENU » MEDIA > SECURE FORMAT MENU » MEDIA » FORMAT > SECURE FORMAT

Camera ID Edgecode
Camera Position
Reel Number

Edgecode 01:00:00 |

Format OK

9

6

3
&

(0],4

Use the keypad to enter a unique edgecode number to the media.

Edgecode is a SMPTE Timecode track, which by default starts at 01:00:00 on the first frame of each media card. It is a
sequential code that is continuous from frame to frame and also between clips. Edgecode is equivalent to RUN
RECORD as used on broadcast cameras.

For more information, refer to Secure Format.
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FORMAT

Use Format to execute a secure format of the media.

WARNING: Formatting permanently deletes all information from the media card. Data cannot be recovered after a

format.

e W‘

Camera D

Camera Position
SECURE FORMAT

Formatting will erase all data. This may take
Reel Number several minutes. Continue?

o K

v/ /Y
Y T

MEDIA FORMAT
Formatting media... MEDIA FORMAT

Media was successfully reformatted and is
_ ready forimmediateise

For more information, refer to Secure Format.

Edgecode 01:00:00 |#

Format (0] ¢
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USER SETTINGS MENU

The User Settings menu contains the settings you use to create presets and assign User button functions.

From the Onboard LCD touchscreen menu, select User Settings:

MENU MENU > USER SETTINGS

Project Settings Presets

Audio / TC User Buttons

Monitoring

Media
User Settings

Autofocus

Use the User Settings menu to configure presets and User buttons:

ITEMS DETAILS

Presets Configure and manage presets
User Buttons Assign functions to the user buttons
PRESETS

Use Presets to build and select pre-configured settings for the camera.

MENU > USER SETTINGS MENU > USER SETTINGS » PRESETS

Presets Create Preset

User Buttons On Media Presets

In Camera Presets

The Presets menu contains the following:

ITEMS DETAILS

Create Preset Create camera setting presets

On Media Presets Manage presets stored on the media
In Camera Presets Manage presets stored in the camera

COPYRIGHT © 2023 RED.COM, LLC

955-0218,REVB | 130



KOMODO-X" OPERATION GUIDE

CREATE PRESET

MENU > USER SETTINGS > PRESETS MENU > USER SETTINGS > PRESETS

Image / LUT

> >[image/Lut

On Media Presets > [ ] Project Settings

Create Preset

In Camera Presets > [ ] Audio/ TC
> D Monitoring
> D User Settings

> J Autofocus

Cancel Expand

Use Create Preset to select the current camera settings you want to use to create a preset list of settings.
You can select settings individually:
MENU > USER SETTINGS > PRESETS

Project Settings >Format List
> "2 Image / LUT
v = Project Settings
>> D Format

> >> Format List

>> D Recording Frame Rate 23.98Fps

>> [:] Recording Frame Rate Lists

You can also use the menu checkmark button to select all of a menus settings as a preset:
MENU > USER SETTINGS > PRESETS

Communication

> 4 Audio / TC
> Monitoring
> User Settings

> i Aut
> > Communication

> D System Settings

(0] 14 Cancel
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Click OK to create the preset. The Create Preset screen opens. Enter your Preset name and tap OK. The Preset is
saved to the camera.

MENU > USER SETTINGS > PRESETS

Create Preset

. ©

1 2 3 45 6 7 8 9 0

QWERTYU I O°FP
A S DF GH J KL
Z X €CVBNMGE

=\< (0] ¢

Enter your Preset name and tap OK. The Preset is saved to the camera (refer to In Camera Presets).

MENU > USER SETTINGS > PRESETS

Create Preset

T -

1 2 3 4 5 6 7 8 9 0 CREATE PRESET
q W e r t y u i o p My Preset.preset created successfully.
a s dfgh j kI

+ 2z x ¢ v b n m &

=\< (0] ¢

ON MEDIA PRESETS

MENU > USER SETTINGS > PRESETS You can import presets from the media to the camera. When importing
presets from the media to the camera, the presets are saved to a folder on

On Media Presets the camera called “presets”.

From On Media Presets, you can import the selected preset from the media
to the camera or import all of the presets from the media to the camera.

COPYRIGHT © 2023 RED.COM, LLC 955-0218, REVB | 132



KOMODO-X" OPERATION GUIDE

IN CAMERA PRESETS

MENU > USER SETTINGS > PRESETS You can export presets from the camera to the media. When exporting
presets from the camera to the media, the presets are saved to a folder on
the media called “presets”.

In Camera Presets

From In Camera Presets, you can apply the selected preset to the camera,
delete the selected preset from the camera, export the selected preset from
the camera to the media, or export all of the presets from the camera to the

> My Preset.preset<{ | media.

APPLY DELETE EXPORT EXPORTALL

USER BUTTONS

Use User Buttons to assign functions to the front and side user buttons.

MENU > USER SETTINGS MENU > USER SETTINGS » USER BUTTONS

Presets Front Button Record Toggle ¥
User Buttons Front Button Half Press None ¥

Side Button Record Toggle ¥

Side Button Half Press None ¥

The User Buttons menu contains the following:

ITEMS DETAILS

Front Button Assign functions to the front user button

Front Button Half Assign functions to the front button half press
Press

Side Button Assign functions to the side user button

Front Button Half Assign functions to the side user button half press
Press
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FRONT BUTTON

MENU » USER SETTINGS » USER BUTTONS MENU > USER SETTINGS > USER BUTTONS Use Front Button to select the
function you want assigned to the

Front Button front camera button.

Front Button Record Toggle ¥

Pre-Record Stop The default setting is Record
Toggle.

Front Button Half Press None ¥

Playback/Camera Toggle
Side Button Record Toggle ¥

Refer to User Button Assignable
> Record TOggle << Functions for the options.

Side Button Half Press None ¥ False Color Toggle

Peaking Toggle

(0]3¢ Cancel

FRONT BUTTON HALF PRESS

MENU > USER SETTINGS > USER BUTTONS MENU > USER SETTINGS > USER BUTTONS Use Front Button Half Press to
select the function you want
assigned to the front camera
button for a half press.

Front Button Record Toggle Front Button Half Press

Front Button Half Press None
The default setting is None.

Side Button Record Toggle Refer to User Button Assignable

None Functions for the options.
Auto WB

Eject Media

Side Button Half Press None

(0]3¢ Cancel

SIDE BUTTON

MENU > USER SETTINGS > USER BUTTONS MENU > USER SETTINGS > USER BUTTONS Use Side Button to select the
s function you want assigned to the
Side Button y 9

Front Button Record Toggle side camera button.

Pre-Record Stop The default setting is Record
Toggle.

Front Button Half Press None

Playback/Camera Toggle

Side Button Record Toggle Refer to User Button Assignable

> Record Toggle <P Functions for the options.

Side Button Half Press None False Color Toggle

Peaking Toggle
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SIDE BUTTON HALF PRESS

MENU > USER SETTINGS > USER BUTTONS Use Side Button Half Press to
select the function you want
assigned to the side camera button

for a half press.

MENU » USER SETTINGS » USER BUTTONS

Front Button Record Toggle ¥ Side Button Half Press

Front Button Half Press None ¥

The default setting is None.

Side Button Record Toggle ¥ Refer to User Button Assignable

Functions for the options.

None

Side Button Half Press

None ¥ Auto WB

Eject Media

USER BUTTON ASSIGNABLE FUNCTIONS

ITEM

DETAILS

None

Nothing is assigned to the User Slot

Apply Preset

Apply the presets stored on the camera

Auto WB

Camera automatically adjusts the White Balance

Eject Media

Unmount the media in preparation for removal

Secure Format

Format the media

Eject USB-C Drive

Eject device connected to USB-C port

Jam TC to TOD Jam Timecode to time of day

AF Toggle Toggle the selected autofocus mode
AF Hold Activates autofocus while pressed
Save Log Save the log file to the media

LCDs Magnify Toggle

Toggle the magnification feature on and off for all LCDs

SDI Magnify Toggle

Toggle the SDI port magnification feature on and off

Pre-Record Toggle

Toggle the Pre-Record feature on and off

Pre-Record Stop

Stop the Pre-Record feature

Playback/Camera Toggle

Toggle between camera output and clip playback

Record Toggle (default)

Toggle record on and off

False Color Toggle

Toggle the False Color tools on and off

Peaking Toggle

Toggle the Peaking tools on and off

Log View Toggle

Toggle Log view on and off

Zebra 1 Toggle

Toggle Zebra 1 on and off

Zebra 2 Toggle

Toggle Zebra 2 on and off

LCD Guides Toggle

Toggle the Guides on and off on the Onboard LCD
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ITEM

DETAILS

LCD Tools Toggle

Toggle the Tools on and off on the Onboard LCD

SDI Guides Toggle

Toggle the Guides on and off on SDI output

SDI Tools Toggle

Toggle the Tools on and off on the SDI output

SDI Overlay Toggle

Toggle between the simple and advanced Overlay on the SDI output

Top LCD Guides Toggle

Toggle the Guides on and off on the DSMC3™ RED® Touch 7.0" LCD

Top LCD Tools Toggle

Toggle the Tools on and off on the DSMC3™ RED® Touch 7.0" LCD

Frame Guide 1 Toggle

Toggle Frame Guide 1 on and off

Frame Guide 2 Toggle

Toggle Frame Guide 2 on and off

Frame Guide 3 Toggle

Toggle Frame Guide 3 on and off

Center Guide Toggle Toggle the Center Guide on and off
Iris Open Open the iris
Iris Close Close the iris

ND Increment

Increase the ND setting by one increment

ND Decrement

Decrease the ND setting by one increment

Shutter Decrement

Decrease the shutter setting by one increment

Shutter Increment

Increase the shutter setting by one increment

Sync Shift Increment (1)

Increase the sync shift setting by one increment

Sync Shift Decrement (1)

Decrease the sync shift setting by one increment

Sync Shift Increment (100)

Increase the sync shift setting by 100 increments

Sync Shift Decrement (100)

Decrease the sync shift setting by 100 increments

Sync Shift Increment (1000)

Increase the sync shift setting by 1000 increments

Sync Shift Decrement (1000) Decrease the sync shift setting by 1000 increments
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AUTOFOCUS MENU

Use Autofocus to enable and configure the camera's Autofocus feature. The lens must support autofocus for this

feature to work.

MENU

Audio / TC

Monitoring

Media
User Settings
Autofocus

Communication

MENU > AUTOFOCUS

Enable |

Mode Single ¥
Size Small ¥
Position Center ¥

AF Toggle (0]3¢

Use the Autofocus menu to perform camera autofocus tasks:

ITEM DETAILS

Enable Enable/Disable the Autofocus feature

Mode Select the Autofocus mode

Size Select the size of the Autofocus area

Position Select the position of the Autofocus area

AF Toggle Toggle the selected Autofocus mode off and on
ENABLE

Use Enable to enable or disable the Autofocus Menu feature. The lens must support autofocus for the camera to use

this feature.

MENU > AUTOFOCUS

Enable

Mode

Size

Position

AF Toggle

I
Single ¥
Small ¥
Center ¥

OK
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MODE

Use Mode to select the autofocus mode for the camera. The lens must support autofocus for the camera to use this

feature.

MENU > AUTOFOCUS

Enable |

Mode Single ¥
Size Small ¥
Center v

Position

AF Toggle (0]3¢

SIZE

MENU > AUTOFOCUS

>  Single

Continuous

<

SINGLE MODE (DEFAULT)

Use single mode to autofocus and
then stop at that focus position.

CONTINUOUS MODE

Use Continuous mode to continue
to change focus to keep a moving
subject in focus.

Use Size to choose what size area you want the camera to use for the autofocus feature. The lens must support
autofocus for the camera to use this feature.

MENU > AUTOFOCUS

Enable

Mode Single ¥
Size Small ¥
Center ¥

Position

AF Toggle (0]3¢

POSITION

MENU > AUTOFOCUS

(0]4 Cancel

The Size selections for the
autofocus area are Small (default),
Medium, Large, Wide, and Vertical.

Use Position to specify the position of the autofocus area on the sensor. The lens must support autofocus for the

camera to use this feature.

MENU > AUTOFOCUS

Enable |
Mode Single ¥
Size Small ¥

Position Center ¥

AF Toggle (0]1¢
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MENU » AUTOFOCUS
Position
Lower Left
Upper Middle

>  Center
Lower Middle

Upper Right

(0]4 Cancel
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The Position selections include:

e Left o Upper Middle e Upper Right
o Upper Left o Center (default) o Lower Right
e Lower Left o Lower Middle « Right

The Autofocus Position rectangle displays on the screen:

15:39:00

CLIP: A023_C001

DUR: 00:00:00

6K 17:9 / R3D MQ

30 FPS CAM

PRESS TO RECORD #

180° 5600«
WB

SHUTTER

You can move the position manually on the LCD screen. The menu will change to display Custom.

MENU > AUTOFOCUS

Enable I

Mode Single ¥
Size Small ¥
Position Custom ¥

AF Toggle (0]:¢

AF TOGGLE

AF Toggle will have different behaviors depending on the Autofocus Mode.

MENU > AUTOFOCUS Single Mode: AF Toggle activates a single autofocus command to focus on

Enable | B8 the subject in the Autofocus box, and then it stops. Each activation of AF
Toggle repeats this process.

Mode SR Continuous Mode: Continuous mode continuously focuses the camera on
the subject in the Autofocus box. AF Toggle allows you to stop and start this
Size SINEUR A  feature. This control is helpful when you are moving the camera, such as
when panning from one subject to another. Tap AF Toggle to disable
Position NEA  Continuous autofocus during the pan, to ensure the camera does not attempt
to focus during the panning action, and then tap AF Toggle again once the
AF Toggle OK AF Box is over the subject on which you want focus.
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COMMUNICATION MENU

The Communication menu contains the settings you use to configure your camera to communicate with other devices.
From the camera LCD menu, navigate to, and tap, Communication:

MENU MENU > COMMUNICATION

Monitoring Camera

Media Connections

User Settings Clients & Services

Autofocus Cloud Upload
Communication

System Settings

Use the Communication menu to configure the camera's communication settings:

ITEM DETAILS

Camera Setting for the camera name

Connections Settings for USB-C, Wi-Fi, and Serial communication
Clients & Services Settings for FTPS and PTP communication

Cloud Upload Settings for Frame.io and AWS S3 communication
CAMERA

Use the Camera menu to view and edit the camera name. Select Camera Name to open the Camera Name editor.

MENU > COMMUNICATION MENU > COMMUNICATION >» CAMERA MENU > COMMUNICATION >» CAMERA

Camera Camera Name 000-000-000 |# Camera Name

) 000-000-000
Connections

Clients & Services 1 2 3 45 6 7 8 90
QW EWRTY UI OFP

Cloud Upload

A S D F GH J KL
+Z X C VB NMOUX
=\< (0] ¢
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CONNECTIONS

Use the Connections menu to select the connection you want to configure.

MENU > COMMUNICATION MENU » COMMUNICATION > CONNECTIONS

Camera USB-C

Connections Wi-Fi

Clients & Services Serial

Cloud Upload

Use the Connections menu to configure the camera's connection settings:

ITEM DETAILS

USB-C Select the camera USB-C connection settings

Wi-Fi Configure the camera Wi-Fi connection settings

Serial Configure the camera serial connection settings
USB-C
Use USB-C to configure the connection to the USB-C port.

MENU » COMMUNICATION >» CONNECTIONS MENU » COMMUNICATION » CONNECTIONS > USB-C

USB-C IP Assignment

Wi-Fi Configure IP

Serial IP Address
Netmask

Gateway

Advanced Settings

The settings you can configure for the USB-C port include:

ITEM DETAILS

IP Assignment Displays the IP address assignment method
Configure IP IP Address modes and configuration settings
IP Address View or enter the network IP address
Netmask View or enter the network Netmask

Gateway View or enter the network Gateway

Advanced Settings Change the MTU size
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CONFIGURE IP

MENU > COMMUNICATION » CONNECTIONS » USB-C

IP Assignment

USB-C
Configure IP | Configure IP
IP Address )> IP Assignment  Automatic {2

Netmask P Address

Gateway Natmack
NelMaSK

Advanced Settings

When connected to an Ethernet network, this allows you to automatically detect an IP address or to manually enter an
IP address, Netmask address, and Gateway (router) address.

IP ADDRESS

When connected to an Ethernet network and Automatic IP Assignment is enabled, IP Address displays the network IP
address.

UsB-C

Configure IP
|

2> IP Assignment  Automatic

When Manual IP Assignment is enabled, you can select IP Address and manually enter a static IP address.

UsB-C uUsB-C

Configure IP 192.168.1.22 Configure IP

IP Assignment Manual

]
2> IP Assignment Manual

IP Address > IP Address  192.168.1.22 [

Netmask  255.255.255.0@ Netmask  255.255.255.0(@
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NETMASK

When connected to an Ethernet network and Automatic IP Assignment is enabled, Netmask displays the network

Netmask address.

UsB-C

Configure IP
|

2> IP Assignment  Automatic

Netmask 255.255.255.0

When Manual IP Assignment is enabled, 255.255.255.0 is automatically populated as the Netmask address.

USsB-C
Configure IP

IP Assignment Manual
IP Address  192.168.1.22 3

> Netmask  255.255.255.0 [

GATEWAY

When connected to an Ethernet network and Automatic IP Assignment is enabled, Gateway displays the network

Gateway address (router address).

2> IP Assignment  Automatic

IP Address 192.168.1.22

Netmask 255.255
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When Manual IP Assignment is enabled, you can select Gateway and manually enter a Gateway (router) address.

Gateway

193.68.1.1
IP Address  192.168.1.22 @ _ x] IP Address  192.168.1.22 @

Netmask 255.255.255.0 3 Netmask 255.255.255.0 @

)> Gateway 193.68.1.1

)> Gateway
I

ADVANCED SETTINGS
The USB-C Advanced Settings menu allows you to change the MTU size.

... » CONNECTIONS » USB-C » ADVANCED SETTINGS ... » CONNECTIONS » USB-C » ADVANCED SETTINGS

Auto MTU

The Auto setting MTU size is 1500 bytes. You can set the MTU to a size larger than the standard 1500 bytes. This
works best on fast Ethernet connections like Gigabit LAN. These large MTUs are known as Jumbo frames (as large as
9000 bytes) and they can increase data transmission efficiency and reduce overhead. However, Jumbo frame error
correction is slower as a result of re-sending larger packets.
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WI-FI
Use Wi-Fi to configure the camera to work with a Wi-Fi connection.

MENU » COMMUNICATION > CONNECTIONS MENU > COMMUNICATION » CONNECTIONS > WI-FI

USB-C Disabled ¥

Wi-Fi

Serial

02:00:00:00:00:01

Use the Wi-Fi menu to configure the camera's Wi-Fi settings:

ITEM DETAILS

Mode Disable Wi-Fi or select the camera Wi-Fi settings
Ad-Hoc Configure the camera as a Wi-Fi hot spot

Infrastructure Settings for connecting to an existing Wi-Fi network
MAC Displays the camera device MAC address
MODE

MENU >» COMMUNICATION » CONNECTIONS > WI-FI MENU >» COMMUNICATION >» CONNECTIONS > WI-FI

Disabled ¥

> Disabled

02:00:00:00:00:01 Ad-Hoc

Infrastructure

(0]14 Cancel

From Mode you can disable the Wi-Fi network, or you can enable the camera's Ad-Hoc or Infrastructure Wi-Fi settings.

The default setting is Disabled.
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AD-HOC
Use Ad-Hoc to configure the camera as a Wi-Fi hot spot.
NOTE: The Ad-Hoc menu is enabled when the Wi-Fi Mode is set to Ad-Hoc.

MENU >» COMMUNICATION » CONNECTIONS > WI-FI ... > CONNECTIONS » WI-FI > AD-HOC

Ad-Hoc ¥ SSID 000-000-000

> Passphrase 000-000-000 [,

Band 5GHz v
02:00:00:00:00:01 Channel
Encryption

Status

Use the Ad-Hoc menu to configure the Wi-Fi hot spot settings:

ITEM DETAILS
SSID Enter the name of the Wi-Fi network the camera generates
Passphrase Enter the password for the Wi-Fi network
Band Select the Wi-Fi frequency band
Channel Select the optimal channel for the Wi-Fi band
Encryption Displays the encryption type
Status Displays the connection status
IP Address Displays the IP address
Netmask Displays the Netmask
SSID
... > CONNECTIONS » WI-FI » AD-HOC ... > CONNECTIONS > WI-FI » AD-HOC

SSID 000-000-000 SSID
000-000-000 X
Pastvase | D0GUD0

Band 5 GHz 1 2 3 45 6 7 8 9 0
QWERTYUI OFP
A S D F GH J KL
+Z X C VB NMX

Channel

Encryption

Status i = OK

Use the keypad to enter the camera's Wi-Fi network name.
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PASSPHRASE

... > CONNECTIONS > WI-FI > AD-HOC ... > CONNECTIONS > WI-FI > AD-HOC ... > CONNECTIONS > WI-FI > AD-HOC

SSID 000-000-000 |# Passphrase Passphrase

. 000-000-000|
Passphrase 000-000-000 &% 000-000-000

Band 5GHz V¥ 1 2 3 4 5 6 7 8 9 0

Channel QWERTYUI OFP
anne

A S D F GH J K L

Encrypti
neryption 4 Z X CVBNM@

Status i =\< (0] ¢

Use the keypad to enter the camera's Wi-Fi passphrase. The camera creates a QR code version of the passphrase.

BAND

... > CONNECTIONS » WI-FI > AD-HOC ... > CONNECTIONS » WI-FI > AD-HOC

SSID 000-000-000 |
Passphrase 000-000-000 (&<
RN 5GHz v
Channel

Encryption

Status i (0] ¢ Cancel

Select the camera's Wi-Fi network frequency band.
® Use 5 GHz for optimal wireless video streaming performance (default)
® Use 2.4 GHz for extended range remote control (when not utilizing wireless video streaming)

CHANNEL

... > CONNECTIONS > WI-FI > AD-HOC ... > CONNECTIONS > WI-FI > AD-HOC

SSID 000-000-000 |#
Passphrase 000-000-000 &

Band 5GHz ¥

> 36 <

Channel 40

Encryption 44

Status i OK  Cancel

Select the optimal channel for the selected band, one which receives the least interference from the surrounding Wi-Fi
signals.
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ENCRYPTION

... > CONNECTIONS » WI-FI > AD-HOC

SSID 000-000-000 |#

Passphrase 000-000-000 [

Band 5GHz ¥
Channel
Encryption

Status

The camera uses WPA2 security encryption.

STATUS

... > CONNECTIONS > WI-FI > AD-HOC

Passphrase 000-000-000 &
Band 5GHz ¥

Channel

Encryption

Status

IP Address

Status displays the camera's Ad-Hoc Wi-Fi connection status.
The Ad-Hoc status includes Offline and Online.

IP ADDRESS
When online and broadcasting a network, the camera displays an IP address.

NETMASK
When online and broadcasting a network, the camera displays the Netmask for the IP address.
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INFRASTRUCTURE
Use Infrastructure to configure the camera to connect to an existing Wi-Fi network.

NOTE: The Infrastructure menu is enabled when the Wi-Fi Mode is set to Infrastructure. Refer to the Wi-Fi section for
more information.

MENU > COMMUNICATION » CONNECTIONS > WI-FI ... > CONNECTIONS » WI-FI > INFRASTRUCTURE

Infrastructure ¥ SSID

Networks

Infrastructure > Status

MAC 02:00:00:00:00:01 IP Assignment
Configure IP

IP Address

Use the Infrastructure menu to configure the Wi-Fi settings to connect to an existing Wi-Fi infrastructure:

ITEM DETAILS

SSID Displays the name of the connected Wi-Fi network
Networks Scan for, select, or enter the Wi-Fi network

Status Displays the Wi-Fi connection status

IP Assignment Displays the IP assignment method

Configure IP Select the IP Assignment mode and manually enter IP, Netmask, and Gateway addresses
IP Address View or enter the Wi-Fi network IP address

Netmask View or enter the Wi-Fi network Netmask

Gateway View or enter the Wi-Fi network Gateway
SSID

MENU » COMMUNICATION > WI-FI > INFRASTRUCTURE MENU » COMMUNICATION » WI-FI> INFRASTRUCTURE

SSID SSID Network 1

Networks Networks

Status i Status

IP Assignment i IP Assignment

Configure IP Configure IP

IP Address .168.1. IP Address

When a network is selected, the SSID displays the Wi-Fi network name (SSID).
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NETWORKS

MENU > COMMUNICATION > WI-FI > INFRASTRUCTURE MENU » COMMUNICATION » WI-FI > INFRASTRUCTURE

SSID Networks

Networks

L ' » Network1 <

IP Assignment ' Network 2

Configure IP

CONNECT FORGET SCAN  OTHER
IP Address

Use Networks to select an existing network, scan for an available network, or to configure a new network.

® CONNECT: The CONNECT button connects the camera to the selected network.

® FORGET: The FORGET button erases the connection information for the selected network.

® SCAN: The SCAN button searches for available networks.

° (P)THEE: The OTHER button opens the OTHER NETWORKS screen where you can manually enter an SSID and a
assphrase.

Tap SSID to open the SSID editing screen and enter the desired network SSID:

OTHER NETWORKS OTHER NETWORKS
Enter Network Information Enter Network Information
» ssip 12 3 45 6 7 8 9 0 RED 5
QW EIRTY U I OFP
Passphrase Passphrase

A S D F GH J KL

=\< OK

Tap Passphrase to open the Passphrase editing screen and enter the desired passphrase for the network:

ARFT6U7Y5E2W1|
OTHER NETWORKS OTHER NETWORKS

Enter Network Information Enter Network Information

)> ssip YA 1 2 3 4 5 6 7 8 9 0 SSID RED 5

QWEIRTY UI OFP

Passphrase ASDFoGHUJKLL )> Passphrase

=\< OK
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Tap Connect to connect to the new network:

MENU » COMMUNICATION » WI-FI > INFRASTRUCTURE

SSID

Networks

Status

IP Assignment
Configure IP

IP Address

STATUS
Displays the connection status of the camera to the selected Wi-Fi network.

MENU » COMMUNICATION » WI-FI > INFRASTRUCTURE MENU » COMMUNICATION » WI-FI > INFRASTRUCTURE

SSID SSID Network 1

Networks Networks
Status Status
IP Assignment IP Assignment

Configure IP

Configure IP

IP Address IP Address

IP ASSIGNMENT

IP Assignment displays the IP assignment mode. In Automatic mode, the camera automatically discovers the
Infrastructure IP Address. In Manual mode, you can manually enter the network addresses in the camera.

MENU » COMMUNICATION » WI-FI > INFRASTRUCTURE

SSID
Networks

Status

IP Assignment

Configure IP

IP Address
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CONFIGURE IP
Tap OK to Open the Infrastructure Configure IP screen.

WIFI
Configure IP

l . .
2> IP Assignment  Automatic (2
Address N/A
Netmask N/A

Catownay N/A
GdlCwdady —

You use the Configure IP screen to select the IP Assignment mode, and to manually enter the IP, Netmask, and
Gateway addresses in Manual mode.

IP ASSIGNMENT SELECTION
IP Assignment allows you to select the Infrastructure IP Assignment mode.

WIFI
Configure IP
' . 3
2> IP Assignment  Automatic[§2 » Automatic <
IP Address N/A Manual
Netmask N/A
(0] ¢
Gateway N/A

The Automatic mode detects the available Infrastructure IP address. The Manual mode allows you to manually enter the
desired Infrastructure network addresses.
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IP ADDRESS

When connected to a Wi-Fi network and Automatic IP Assignment is enabled, IP Address displays the Wi-Fi network IP
address.

WIFI

Configure IP
|

2> IP Assignment  Automatic

Netmask 255.255.255.0

When Manual IP Assignment is enabled, you can manually enter a static IP address.

WIFI — WIFI
Configure IP 192.168.1.1 Configure IP
]

2> IP Assignment Manual

IP Assignment Manual
IP Address > IP Address  192.168.1.1

Netmask  255.255.255.0(@ Netmask  255.255.255.0

NETMASK

When connected to an Ethernet network and Automatic IP Assignment is enabled, Netmask displays the network
Netmask address.

WIFI

Configure IP
|

2> IP Assignment  Automatic
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When Manual IP Assignment is enabled, 255.255.255.0 is automatically populated as the Netmask address.

WIFI
Configure IP

IP Assignment Manual
IP Address 192.168.1.1

> Netmask ~ 255.255.255.0 [

GATEWAY

When connected to a Wi-Fi network and Automatic IP Assignment is enabled, Gateway displays the Wi-Fi network
Gateway address (router address).

2> IP Assignment  Automatic {3

TmevIg e TvraroreoT gy

193.168.1.1 X

Netmask  255.255.255.0 (@

Netmask  255.255.255.0(@

Gateway

)> Gateway 193.168.1.1
1
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SERIAL
Use Serial to configure the serial connection to the Extension Port.

MENU » COMMUNICATION > CONNECTIONS MENU > COMMUNICATION » CONNECTIONS > SERIAL

USB-C Baud Rate 115200 ¥

Wi-Fi IP Address 169.254.1.1 2

Serial

The settings you can configure for the serial connection through the Extension Port include:

ITEMS DETAILS

Serial Select the serial port baud rate

Serial Enter the IP address for the PPP protocol

BAUD RATE

MENU » COMMUNICATION » CONNECTIONS > SERIAL MENU » COMMUNICATION » CONNECTIONS > SERIAL
Baud Rate 115200 ¥ Baud Rate
IP Address 169.254.1.1 /' 38400

57600

> 115200 <

230400
460800

(0]4 Cancel

The Baud rate controls how fast data is transmitted over the serial connection. The higher the speed, the more likely
that errors can occur. The Baud rates you can choose include:

BAUD RATES

9600 115200* 576000 1500000

19200 230400 921600 2000000

38400 460800 1000000 2500000

57600 500000 1152000 3000000
* Default
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IP ADDRESS

MENU > COMMUNICATION » CONNECTIONS > SERIAL MENU > COMMUNICATION » CONNECTIONS > SERIAL

Baud Rate 115200 ¥ IP Address

IP Address 169.254.1.1 7/

Use the keypad to enter the internet provider's IP address.

CLIENTS & SERVICES

Use the Clients & Services menu to configure the client and service communications for the camera.

MENU > COMMUNICATION MENU » COMMUNICATION > CLIENTS & SERVICES

Camera FTPS
Connections PTP

Clients & Services

Cloud Upload

Use the Clients & Services menu to configure the camera's client and service settings:

ITEM DETAILS
FTPS Configure the camera FTPS communication settings
PTP Configure the camera PTP communications settings
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FTPS
Use FTPS to configure the camera to work with a secure File Transfer Protocol (FTPS) connection.

MENU » COMMUNICATION > CLIENTS & SERVICES MENU > COMMUNICATION > CLIENTS & SERVICES > FTPS

FTPS Username ftp1

PTP Password 4zfhefggvdz3 (B,

Settings Access
Media Access
Data Encryption

Connection Status

Use the FTPS menu to configure the camera's FTPS settings:

ITEM DETAILS

Username Static username ftp1

Password User-editable password and QR code
Settings Access Enable FTP access to the camera settings
Media Access Enable read-only access to the media
Data Encryption Encrypts the data stream

Connection Status Displays the FTPS actions occurring
PASSWORD

Use Password to enter an FTPS password. When you select Password, the FTPS Password QR code screen appears.

MENU > COMMUNICATION > CLIENTS & SERVICES » FTPS MENU » COMMUNICATION > CLIENTS & SERVICES » FTPS MENU » COMMUNICATION > CLIENTS & SERVICES » FTPS

Username ftp1 Password Password

- 4zfh6fggvdz3 [X]
Password 4zfhefggvdz3 4zfh6fggvdz3

1 2 3 4 5 6 7 8 9 0

Settings Access

. QWEWIRTYUI OFP
Media Access

A S DF GH J KL
{Z X €C VB NMX

Data Encryption

Connection Status i =\< OK

Select EDIT to open the FTPS Password editing screen. The password must contain a minimum of 8 characters. The
screen displays passwords shorter than 8 characters in a red font.
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PTP
Use PTP to view the precision time protocol status and configure the precision time protocol IP domain.
Enable PTP in Audio/ TC > Timecode Source (refer to Timecode Source).

MENU » COMMUNICATION > CLIENTS & SERVICES MENU > COMMUNICATION > CLIENTS & SERVICES » PTP

FTPS PTP State

PTP PTP Domain

The settings you can configure for PTP include:

ITEM DETAILS

PTP State Displays the current status of the precision time protocol
PTP Domain Allows you to select the precision time protocol domain
PTP DOMAIN

Use PTP Domain to select the precision time protocol domain for the camera. The camera will only receive precision
time protocol communications addressed to the selected IP domain.

MENU >» COMMUNICATION > CLIENTS & SERVICES » PTP MENU > COMMUNICATION > CLIENTS & SERVICES » PTP

PTP State PTP Domain
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CLOUD UPLOAD

Use the Cloud Upload menu to configure the cloud upload communications for the camera.

MENU > COMMUNICATION

Camera

Connections

Clients & Services

Cloud Upload

MENU » COMMUNICATION » CLOUD UPLOAD MENU » COMMUNICATION > CLOUD UPLOAD

Enable |

Service Frame.io ¥
Upload File Types >
Status Disconnected

Frame.io >

Use the Cloud Upload menu to manage the camera's cloud uploading features:

ITEM DETAILS
Enable Enable or disable the Cloud Upload features
Service Select Frame.io or AWS S3 as the cloud upload service

Upload File Types

Enable or disable the uploading of R3D, MOV, WAV, and CDL/LUT files

Status

Displays the status of the cloud connection

Frame.io

Configure the Frame.io settings when this service is selected

S3

Configure the AWS S3 settings when this service is selected

Clips Remaining

Displays the number of clips remaining to upload

Time Remaining

Displays the time remaining to upload

Upload Remaining

Displays the size of the remaining upload

Upload Speed

Displays the speed of the upload
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SERVICE
Use Service to select the type of cloud upload service the camera uses.

MENU » COMMUNICATION > CLOUD UPLOAD MENU » COMMUNICATION > CLOUD UPLOAD

Enable i Service

Service Frame.io ¥

Upload File Types > .
Frame.io <
Status Disconnected s3

Frame.io >

(014

The types of cloud upload services you can select for the camera include:

ITEM DETAILS
Frame.io Selects the Frame.io cloud collaboration service
S3 Selects the AWS S3 cloud data management service

UPLOAD FILE TYPES

Use Upload File Types to select the file types you want the camera to upload to the cloud.

MENU » COMMUNICATION » CLOUD UPLOAD ... » CLOUD UPLOAD > UPLOAD FILE TYPES

Enable |
Service Frame.io ¥
Upload File Types

Status

Frame.io

The Upload File Types menu only allows you to enable the file types avalable on the camera. When they are not on the

camera they are grayed-out on the menu.

The Upload File Types you can select include:

ITEM DETAILS

R3D REDCODE RAW video file format
MOV ProRes video file

WAV Standard Waveform audio data file
CDL/LUT In camera CDL and LUT files
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FRAME.IO
Use Frame.io to connect to, and disconnect from, your Frame.io project.

MENU » COMMUNICATION > CLOUD UPLOAD MENU > COMMUNICATION » CLOUD UPLOAD » FRAME.IO

Enable |

Service Frame.io ¥
Upload File Types Offline
Status Disconnected

Frame.io >

When you select Connect, the screen displays a time sensitive 6-digit code. Use this code to sync the camera to the
desired project on the Frame.io website.

S3
Use S3 to configure the camera S3 communications.

MENU » COMMUNICATION » CLOUD UPLOAD MENU > COMMUNICATION > CLOUD UPLOAD > S3

Service S3 v Bucket
Upload File Types > Key Prefix

Status Disconnected i Endpoint

Virtual Addressing

On Media AWS Config

In Camera AWS Config

The S3 communications setting you can configure include:

ITEM DETAILS

Bucket Enter the S3 Bucket name

Key Prefix Enter the S3 Key Prefix (optional)

Endpoint Override the the default S3 Endpoint address (optional)
Virtual Addressing Enable or disable Virtual Addressing

On Media AWS Config Select the AWS configuration stored on the media

In Camera AWS Config Manage the AWS configurations saved to the camera
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BUCKET
Use Bucket to enter the name of the S3 Bucket you want to use to upload your data to the cloud.

MENU > COMMUNICATION > CLOUD UPLOAD » S3 MENU > COMMUNICATION > CLOUD UPLOAD > S3 MENU > COMMUNICATION > CLOUD UPLOAD > S3

Bucket Bucket Bucket my-s3-bucket [#*

X
| my-s3-bucked JEI IO

Key Prefix

123 456 7 8 9 0 Endpoint

Endpoint

q w e r ty u i op

Virtual Addressing Virtual Addressing

a s d f g h j k I

On Media AWS Config rEEEERRE

On Media AWS Config

In Camera AWS Config =\< oK In Camera AWS Config

KEY PREFIX

When specified, the camera adds a prefix to the key (or path) of the uploaded objects to create a subfolder in the
bucket (optional).

MENU > COMMUNICATION » CLOUD UPLOAD » S3 MENU > COMMUNICATION » CLOUD UPLOAD > S3

Key Prefix e
I

1 2 3 4 5 6 7 8 9 0

Bucket
Key Prefix

Endpoint

) . QWERTVYU I O°FP
Virtual Addressing
A S D F GH J KL
+ Z X CVBNMOU®

=\< (0] 4

On Media AWS Config

In Camera AWS Config

ENDPOINT
Use Endpoint to override the default S3 endpoint address (optional).

MENU > COMMUNICATION > CLOUD UPLOAD » S3 MENU > COMMUNICATION > CLOUD UPLOAD > S3 MENU > COMMUNICATION » CLOUD UPLOAD > S3

Endpoint Bucket my-s3-bucket (¢

https://S3_add X

1 2 3 45 6 7 8 9 0 Endpoint https://S3_address (¢
q w e r t y u i o p

Bucket my-s3-bucket |#*
Key Prefix
Endpoint

Virtual Addressing Virtual Addressing |

a s d f g h j k I
On Media AWS Config

 z x ¢ Vb nm On Media AWS Config

In Camera AWS Config =\< oK In Camera AWS Config

VIRTUAL ADDRESSING

Virtual Addressing is typically enabled. However, you must disable it when interfacing with some S3-compatible storage.
Contact your S3 administrator for more information.
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ON MEDIA AWS CONFIG
Use On Media AWS Config to select an AWS configuration stored on the media card in the aws folder (/aws).

MENU > COMMUNICATION » CLOUD UPLOAD » S3 MENU > COMMUNICATION » CLOUD UPLOAD » S3

On Media AWS Config

Bucket my-s3-bucket (¢

Key Prefix /s

Endpoint https://S3_address |#
Virtual Addressing |
On Media AWS Config

In Camera AWS Config

IN CAMERA AWS CONFIG
Use In Camera AWS Config to export or delete AWS configurations stored on the camera.

MENU > COMMUNICATION » CLOUD UPLOAD » S3 MENU > COMMUNICATION » CLOUD UPLOAD > S3

Bucket my-s3-bucket |# In Camera AWS Config
Key Prefix /

Endpoint https://S3_address (¢

Virtual Addressing |

On Media AWS Config

In Camera AWS Config

AWS Configuration and Credentials files contain important information for connecting to the AWS bucket, such as
region, and access ID / key. AWS CLI tools generate these files when you enter "aws configure". You can also create
AWS Configuration and Credentials files manually.

Examples of the AWS configuration and credentials files:

config:

[default]

region = us-west-2

credentials:

[default]

aws_access_key id = AKIAIOSFODNN7EXAMPLE

aws_secret access_key = wJalrXUtnFEMI/K7MDENG/bPxRfiCYEXAMPLEKEY
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SYSTEM SETTINGS MENU

The System Settings menu contains the camera system configuration settings.

MENU MENU > SYSTEM SETTINGS

Date / Time

Media

User Settings Licenses
Autofocus Lens
Communication Power
System Settings Sensor

Indicators

Language English ¥

Use the System Settings menu to configure the camera system settings:

ITEMS DETAILS

Date / Time Date and time settings

Licenses Manage camera licenses

Lens View lens status information and access the lens adjustments
Power DC and battery status

Sensor Adjust sensor timing

Indicators Enable or disable the record sounds and the front Tally LED

GPO Function Select the General Purpose Out function

Status Settings Shutter mode, aperture increments, and focus length units settings
System Status Information about the camera's type, PIN, FW, and runtime

COPYRIGHT © 2023 RED.COM, LLC 955-0218, REVB | 164



KOMODO-X" OPERATION GUIDE

DATE / TIME

Use the Date / Time menu to reset the internal clock of the camera. The time and date are timestamped on R3D® files
when recording to the media. The camera uses the 24-hour clock convention (military time). For example, enter 2:35
p.m. as 14:35:00.

MENU > SYSTEM SETTINGS MENU > SYSTEM SETTINGS > DATE / TIME

Date / Time Date 2023-04-19 |/

Licenses Time 18:03:47 |

Lens Time Zone Greenwich Mean Time ¥
Power

Sensor

Indicators

The Date / Time menu items include:

ITEMS DETAILS

Date Date in YYYY-MM-DD format
Time 24-hour format

Time Zone Global time zones
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DATE

Use Date to enter the date using the touchscreen keypad:

MENU > SYSTEM SETTINGS > DATE / TIME

Date 2023-04-19 |#

Time 18:03:47 |#

Time Zone Greenwich Mean Time ¥

TIME

Use Time to enter the time in 24-hour military format using the touchscreen keypad:

MENU > SYSTEM SETTINGS > DATE / TIME

Date 2023-04-19 |#

Time 18:10:29 |#

Time Zone Greenwich Mean Time ¥

MENU > SYSTEM SETTINGS > DATE / TIME

Date

2023-04-19|

MENU > SYSTEM SETTINGS > DATE / TIME

TIME ZONE

Use Time Zone to select the local time zone for where the camera is located.

MENU > SYSTEM SETTINGS > DATE / TIME

Date 2023-04-19 |#

Time 18:53:40 |/

Time Zone Greenwich Mean Time ¥

COPYRIGHT © 2023 RED.COM, LLC

MENU » SYSTEM SETTINGS » DATE / TIME
Time Zone

Argentina Standard Time

Central African Time

> Greenwich Mean Ti <

European Central Time

Eastern European Time
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LICENSES

Use the Licenses menu to manage your RED camera licenses.

MENU > SYSTEM SETTINGS MENU > SYSTEM SETTINGS > LICENSES

Date / Time On Media Licenses

Licenses In Camera Licenses
Lens

Power

Sensor

Indicators

You can manage the licenses stored on the media card, and you can manage the licenses stored in the camera.

MENU > SYSTEM SETTINGS > LICENSES MENU > SYSTEM SETTINGS > LICENSES

On Media Licenses In Camera Licenses
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LENS

Use Lens to view information about the attached lens.

MENU > SYSTEM SETTINGS MENU > SYSTEM SETTINGS > LENS

Date / Time Focal Length 100mm

Licenses Focus Distance 14'9"- 65'8"
Lens Iris 2.8 w
Power Image Stabilization

Sensor RF Iris Compensation

Indicators Control Ring

The information you can view from Lens includes:

ITEMS DETAILS

Focal Length Displays the lens focal length value

Focus Distance Displays the lens focal distance value

Iris Lens Iris menu

Image Stabilization Displays the lens image stabilization status
RF Iris Compensation Enables RF Iris Compensation

Control Ring Enables the lens control ring

Control Ring Mode Control Ring Mode settings

/i Data View the PL mount lens /i Data information
IRIS

Use the Iris menu to select the camera lens f-stop. Tap Edit to open the keypad and enter the f-stop manually.

MENU > SYSTEM SETTINGS > LENS MENU > SYSTEM SETTINGS > LENS

(0]1¢ Cancel Edit
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RF IRIS COMPENSATION

Use RF Iris Compensation to compensate for iris position shifting that can occur with certain RF zoom lenses as you
change the focal length. This compensation keeps the iris reasonably maintained when the focal length is changed after
you set the iris. When enabled, a small iris fluttering may be visible during zooming. You can disable RF Iris
Compensation to stop the iris fluttering.

CONTROL RING MODE
Use Control Ring Mode to select the camera setting you want the Control Ring to adjust.

MENU > SYSTEM SETTINGS > LENS MENU > SYSTEM SETTINGS > LENS

Focus Distance 14'9"- 65'8" Control Ring Mode
Iris 28 v

Image Stabilization

> Aperture <

RF Iris Compensation & Shutter
Control Ring i ISO

Control Ring Mode Aperture ¥ OK  Cancel

The modes you can select include Aperture (Iris, default), Shutter, ISO, White Balance, LCD Magnify, SDI Magnify, LCDs
+ SDI Magnify, False Color Cycle, Peaking Cycle, and Tools Cycle.

/i DATA

Use /i Data to view the PL mount lens /i Data information.
NOTE: This menu item is only available when using a /i Data capable PL mount and lens.

MENU > SYSTEM SETTINGS > LENS MENU > SYSTEM SETTINGS > LENS > /I DATA

Brand
Image Stabilization Serial

Owner

Control Ring |

Control Ring Mode Aperture ¥

/i Data >

You can view the lens Brand, Serial number, and Owner name.
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POWER

Use the Power menu to view the various camera power status indicators:

MENU > SYSTEM SETTINGS MENU > SYSTEM SETTINGS >» POWER

Date / Time

DC-IN Voltage
Licenses DC-IN Amperage
Lens BAT Voltage

Power

BAT % Remaining

Sensor BAT Time Remaining

Indicators BAT Amperage

The Power indicators you can view include:

ITEMS DETAILS

DC-IN Voltage When DC is connected, this displays the DC Voltage

DC-IN Amperage When DC is connected, this displays the DC Amps

BAT Voltage When a battery is connected in the left #1 slot, this displays the battery Voltage

BAT % Remaining When a compatible battery is connected in the left #1 slot, this displays the % of battery
charge remaining

BAT Time Remaining When a battery is connected in the left #1 slot, this displays the camera operating time
remaining

BAT Amperage When a battery is connected in the left #1 slot, this displays the battery Amps

Low Voltage Warning Set the DC-IN low voltage warning threshold

Power Out Enables or disables the 5 V / 500 mA power out of the Extension Port

LOW VOLTAGE WARNING

Use Low Voltage Warning to set the desired voltage level to trigger the low voltage warning. The warning displays on
the LCD and across Overlay Modes that contain power status (refer to the Status Bar section for more information
about the status icons).

MENU > SYSTEM SETTINGS >» POWER MENU > SYSTEM SETTINGS >» POWER

Low Voltage Warning

BAT Voltage
BAT % Remaining
BAT Time Remaining

BAT Amperage

Low Voltage Warning

Power Out (9]¢ Cancel Edit
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SENSOR

Use Sensor to shift the sync signal.

MENU > SYSTEM SETTINGS MENU > SYSTEM SETTINGS > SENSOR

Date / Time Sync Shift 0l

Licenses Sync Shift Time 0.000us

Lens Sync Shift Time Unit 0.013481us
Power

Sensor

Indicators

The Sensor menu includes:

ITEM DETAILS
Sync Shift Enter the desired amount of sync shift
Sync Shift Time Displays the Sync Shift time in microseconds (us)

Sync Shift Time Unit Displays the units of microseconds (us) used for the Sync Shift setting

SYNC SHIFT

Use Sync Shift to open the keypad and enter the number of Sync Shift Time Units you want to offset the sensor from
the external sync signal. Use this setting to resolve synchronization issues on set such as when working with LED
Volumes.

MENU > SYSTEM SETTINGS > SENSOR MENU > SYSTEM SETTINGS > SENSOR

Sync Shift
Sync Shift Time

Sync Shift Time Unit

In this example, the Sync Shift is 2 x 0.013481 microseconds ~0.026 microseconds.
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INDICATORS

Use the Indicators menu to enable or disable sound and the tally light (refer to the Camera Body section for more
information about the camera LEDs), and to select the record start indicator and record stop indicator sounds.

MENU > SYSTEM SETTINGS MENU » SYSTEM SETTINGS > INDICATORS

Licenses

Enable Sound
Lens Rec Start Sound

Power

Rec Stop Sound

Sensor Tally Light
Indicators

GPO Function Sync Out v

ENABLE SOUND

Use Enable Sound to allow the selected sounds to play.

Enable Sound T Enable Sound 0

REC START SOUND

Rec Start Sound allows you to select the sound to play when you begin a recording.

MENU > SYSTEM SETTINGS > INDICATORS MENU » SYSTEM SETTINGS > INDICATORS

Enable Sound T Rec Start Sound
Rec Start Sound Money 'V

Rec Stop Sound Beep Descending ¥ >>

None <

Tally Light g Beep

Double Beep

(0] 4 Cancel

The sounds you can select include:
® None

®* Beep

® Double Beep

® Beep Ascending

® Beep Descending

®* Money

® Shutter
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REC STOP SOUND

Rec Stop Sound allows you to select the sound to play when you end a recording.

MENU > SYSTEM SETTINGS > INDICATORS MENU > SYSTEM SETTINGS > INDICATORS

Enable Sound T Rec Stop Sound
Rec Start Sound Money ¥

Rec Stop Sound Beep Descending ¥
None

Tally Light | Beep

Double Beep

The sounds you can select include:
®* None

® Beep

® Double Beep

® Beep Ascending

® Beep Descending

®* Money

® Shutter

TALLY LIGHT
Use Tally Light to enable or disable the front recording tally LED.

Tally Light | W Tally Light o

For more information, refer to the Camera Body LED section.
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GPO FUNCTION

Use the GPO Function menu to select the General Purpose Out function of the Extension port.

MENU > SYSTEM SETTINGS MENU > SYSTEM SETTINGS

Lens GPO Function

Power

Recording Indicator Out

Sync Out <

Sensor
Indicators
GPO Function Sync Out ¥

Status Settings > OK  Cancel

You can select the following General Purpose Out functions for the Extension port:
® Recording Indicator Out
® Sync Out

RECORDING INDICATOR OUT

The Recording Indicator Out function sends a signal out of the Extension port GPO pin when the camera is recording.

SYNC OUT
The Sync Out function sends a Sync signal out of the Extension port GPO pin.

For more information, refer to Extension Port.
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STATUS SETTINGS

Use the Status Settings menu to select the shutter display mode, aperture increment, and focus distance units
displayed in the camera's menus.

MENU > SYSTEM SETTINGS MENU » SYSTEM SETTINGS » STATUS SETTINGS

Power Shutter Display Mode Angle ¥
Sensor Aperture Increments /3 Stop ¥
Indicators Focus Distance Imperial ¥

GPO Function Sync Out ¥ White Balance List Mode Kelvin ¥

Status Settings >

System Status >

The Status Settings that you can configure include:

ITEMS DETAILS

Shutter Display Mode Select a time-fraction or an angle for the shutter menu display unit
Aperture Increments Select 1/4 or 1/3 f-stop increments

Focus Distance Select the focus distance units (Metric or Imperial)

White Balance List Mode Select Kelvin or White Balance Presets

ND Display Mode When attached, select ND filter Stops or Density display modes
ND Increments When attached, select the ND increment size
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SHUTTER DISPLAY MODE
Use Shutter Display mode to select the way that the camera displays the Shutter setting in the menu.

When select Angle, the Shutter menu displays the choices in degrees. When you select Time, the Shutter menu displays
the choices in fractions of a second.

MENU » SYSTEM SETTINGS > STATUS SETTINGS MENU » IMAGE / LUT MENU > IMAGE / LUT

Shutter Display Mode Shutter Shutter

Time

> Angle <

(0]1¢ Cancel  Edit List (0]4 Cancel  Edit List

APERTURE INCREMENTS

Use Aperture Increments to select one fourth increments or one third increments for the camera f-stop settings. The
default is 1/3 Stop.

MENU » SYSTEM SETTINGS » STATUS SETTINGS

Aperture Increments

(0]4 Cancel
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FOCUS DISTANCE
Use Focus Distance to select Imperial or Metric units for the Lens Focus Distance display. The default is Imperial.

MENU » SYSTEM SETTINGS > STATUS SETTINGS

Focus Distance

Metric

> Imperial <

(0]3¢

WHITE BALANCE LIST MODE

Use White Balance List Mode to select Kelvin or Presets for the White Balance Color Temperature menu. The default is
Kelvin.

MENU » SYSTEM SETTINGS > STATUS SETTINGS

White Balance List Mode

> Kelvin <

Presets

OK Cancel
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ND DISPLAY MODE
Use ND Display Mode to select Stops or Density display modes when displaying ND settings.

MENU > SYSTEM SETTINGS > STATUS SETTINGS

ND Display Mode

> Stops <

Density

(0]3¢

ND INCREMENTS
Use ND Increments to set the increment size for increasing or decreasing the ND stop.

MENU > SYSTEM SETTINGS > STATUS SETTINGS

ND Increments

Ya Stop

>  WBStop <

1 Stop

(0]3¢
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SYSTEM STATUS

Use the System Status menu to view camera information and to view temperature readings.

MENU > SYSTEM SETTINGS MENU » SYSTEM SETTINGS > SYSTEM STATUS

Power Camera Info

Sensor

Temperature

Indicators
GPO Function Sync Out ¥
Status Settings >

System Status >

The system status information you can view includes:

ITEMS DETAILS
Camera Info Camera information
Temperature Camera temperatures

CAMERA INFO

MENU » SYSTEM SETTINGS > SYSTEM STATUS ... » SYSTEM STATUS > CAMERA INFO

Camera Info Camera Type KOMODO-X 6K S35

Temperature Camera PIN KXBK1000000

Version 1.0.3

4.3 Hours

Runtime

The camera information you can view includes:

ITEMS DETAILS

Camera Type Displays the camera description

Camera PIN Displays the camera personal identification number (PIN)
Version Displays the firmware version number installed on the camera
Runtime Displays the total number of hours that the camera has run
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TEMPERATURE

MENU > SYSTEM SETTINGS > SYSTEM STATUS ...> SYSTEM SETTINGS » SYSTEM STATUS > TEMPERATURE

Camera Info

Temperature

Camera Status

Logic Board 0

Logic Board 1

Power Board

STM

Sensor

The camera temperatures you can view include:

ITEMS

DETAILS

Camera Status

Displays Good (green) or Overheating (yellow)

Logic Board 0

Displays the Celsius temperature of Logic Board 0

Logic Board 1

Displays the Celsius temperature of Logic Board 1

Power Board

Displays the Celsius temperature of the power IC board

STM

Displays the Celsius temperature of the power STM IC

Sensor

Displays the Celsius temperature of the sensor

Calibration Temperature

Displays the Celsius temperature of the sensor at the last calibration
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LANGUAGE MENU

The Language menu contains the languages you can select for the user interface (Ul).

From the Onboard LCD touchscreen menu, tap Language:

MENU

User Settings

Autofocus

Communication

System Settings

English ¥

Language

Maintenance >

MAINTENANCE MENU

MENU

include:
Language .
¢ English

* French

e German

English

Simplified Chinese

French

(014

e Spanish

The languages you can select

¢ Simplified Chinese

* Japanese

The Maintenance menu contains the settings you use to perform various maintenance tasks on your camera.

From the Onboard LCD touchscreen menu, tap Maintenance:

MENU

User Settings
Autofocus

Communication

System Settings

Language English ¥

Maintenance >

MENU > MAINTENANCE

Calibrate
Calibration
Save Log
Reset Defaults
Factory Reset

Upgrade

Use the Maintenance menu to perform the following camera maintenance tasks:

ITEM DETAILS

Calibrate Performs calibration

Calibration List of calibration options

Save Log Saves the camera log files to the media

Reset Defaults

Resets the camera settings to their default settings

Factory Reset

Restores the camera to the factory settings

Upgrade

Updates the firmware
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CALIBRATE

Use Calibrate to start the camera calibration process and create your User calibration profile.

Only calibrate the camera after it has reached its operational temperature. This occurs usually within ten minutes after
you turn on the camera in the filming environment. Do not calibrate immediately after powering on.

MENU > MAINTENANCE

Calibrate
Calibration
Save Log
Reset Defaults

Factory Reset

Upgrade

NOTE: Make sure that the mount cap is installed on the camera before you calibrate the camera.

Tap OK on the touchscreen to begin calibrating the camera.

CALIBRATION

You are about to calibrate your camera at CALIBRATION
47.95.

This process will take approximately 30
seconds.
Ensure body cap is attached before continuing.

Calibration in progress.
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When the camera is finished calibrating, the touchscreen displays the Calibration status message:

CALIBRATION CALIBRATION

Calibration successful. Calibration failed.

CALIBRATION

Use Calibration to select the active camera Calibration.

MENU > MAINTENANCE MENU > MAINTENANCE

Calibrate (0]7¢ Calibration
Calibration Factory ¥

Save Log OK

> Factory <

Reset Defaults (0]14

Factory Reset OK
OK  Cancel

Upgrade (0]1¢

You should always select User calibration. The first time you calibrate the camera, the only choice is Factory. After you
perform a calibration, the User calibration profile is added to the list and the camera makes it the default calibration.
Every time you calibrate the camera, the User profile is updated. The only time the User profile is removed, is when you
perform a Factory Reset.

If User calibration is not available, the camera defaults to Factory calibration. Calibrate the camera to generate the new
User calibration profile.
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SAVE LOG

Use Save Log to save the camera log to the media.

MENU > MAINTENANCE

Calibrate (0]:¢
Calibration Factory 'V
Save Log (0] ¢

Reset Defaults (0]14

Factory Reset OK

Upgrade OK

When the media is full, or missing, the camera will display an error message. When there is no error, the success
message is displayed.

Error: Success:
LOG LOG
Error saving log file to media. Log saved to media.
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RESET DEFAULTS

Use Reset Defaults to reset the camera to the factory default settings.

Calibrate (0]:¢
Calibration Factory 'V RESET DEFAULTS
Delete all user settings and restore the factory
defaults?

Save Log (0] ¢

The camera will require a reboot.

OK ﬁ
Upgrade . y/////////l

NOTE: Resetting the camera will delete all of your menu settings.

Reset Defaults (0]14

NOTE: The camera turns off, and then back on to complete the reset process.
Tap Yes on the touchscreen to reset the camera menus to the default settings.

FACTORY RESET

Use Factory Reset to reset the camera to the factory settings.

Calibrate (0]¢
. . FACTORY RESET
Calibration Factory ¥ Delete all user settings, calibration files, 3D
LUT files, CDL files, and restore the factory
defaults?
Save Log OK

The camera will require a reboot.

o K

Reset Defaults (0]14

Factory Reset OK

Upgrade OK 7/////////1

NOTE: Resetting the camera will delete all of your settings and remove all imported files. The camera turns off, and then
back on to complete the reset process.

Tap Yes on the touchscreen to reset the camera to the factory settings.
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UPGRADE

Use Upgrade to perform a camera firmware update.

Calibrate OK

Calibration Factory ¥ FIRMWARE UPGRADE

Preparing for firmware upgrade; this may
Take several minutes.

Save Log (0] ¢

Do not power down during this process.
Reset Defaults (0] ¢

Factory Reset oK _
Upgrade ok y/////////l

For more information about upgrading the firmware, refer to Upgrading the Firmware.
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5. HOW TO

This section describes how you can use the camera features.

WI-FI CONFIGURATION

The camera offers a wireless (802.11g) connection that provides communication support for third-party applications. As
with all wireless devices, the communication range varies with the environment and any radio frequency (RF)
interference that may be present. You can select a wireless frequency of 2.4 GHz or 5 GHz. For optimal performance,
do not obstruct the antenna with any accessory, mounting plate, or mounting rail.

The camera uses Ad-Hoc mode to set up the camera as a Wi-Fi hot spot.
The camera uses Infrastructure mode to connect to existing Wi-Fi infrastructure.

CONNECTING WIRELESSLY TO AN EXISTING WI-FI NETWORK

This camera uses the WPA2 Wi-Fi protocol.
1. Navigate to the Wi-Fi menu MENU > COMMUNICATION > Wi-Fi.

MENU » COMMUNICATION > CONNECTIONS > WI-FI

Disabled ¥

02:00:00:00:00:01

2. From the Mode option, select Infrastructure.

MENU » COMMUNICATION > CONNECTIONS > WI-FI

> Disabled <

Ad-Hoc

Infrastructure

(0]1¢ Cancel
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3. From the Infrastructure menu, select Networks:
MENU » COMMUNICATION » CONNECTIONS » WI-FI ... » CONNECTIONS » WI-FI » INFRASTRUCTURE ... » CONNECTIONS » WI-FI » INFRASTRUCTURE

Infrastructure v | SSID Networks
Networks

Infrastructure > | Status

> Network1 <

MAC 02:00:00:00:00:01| IP Assignment Network 2

Configure IP Network 3

IP Address CONNECT FORGET  SCAN  OTHER

4. Select the network name from the Networks list menu:
... » CONNECTIONS » WI-FI » INFRASTRUCTURE

Networks

> Network1 <

Network 2

Network 3

CONNECT FORGET SCAN OTHER

or tap SCAN to scan for available networks and update the Networks list:

Networks

WI-FI

Scanning...

> RED 5

Network 1
Network 2
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5. Tap CONNECT. The CONNECT screen displays:

CONNECT

Enter passphrase for:

RED 5

)> Passphrase

Cancel Connect

6. Tap Passphrase. The Passphrase entry screen displays:

Passphrase

1 2 3 4 5 6 7 8 9 0
QWERTY U I OFP
A S D F GH J KL
+ Z X C VB NM

=\<

7. Enter the passphrase for the selected network. The passphrase must use a minimum of 8 characters.

Passphrase 104
®

1 2 3 4 5 6 7 8 9 0
QWEWRTY U I OFP
A S D F GH J K L

 Z X CVBNMSX

=\< OK
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8. Tap OK on the completed Passphrase entry screen. The completed CONNECT screen displays.

CONNECT

Enter passphrase for:

RED 5

> Passphrase Fkkkkkkk

Cancel Connect

9. Tap the Connect button. The camera connects to the selected network:

... » CONNECTIONS » WI-FI > INFRASTRUCTURE

SSID

Networks

Status

IP Assighment

Configure IP

IP Address 192.168.1.1

FTPS CONFIGURATION

The File Transfer Protocol Secure (FTPS) offers a fast and secure system for transferring data to and from the camera.
FTPS is supported by firmware versions 1.5 and higher. FTPS is available when the camera is enabled and connected
to a network over WiFi or through the USB-C port to an Ethernet adaptor.

The settings for using FTPS on the camera include:
® Protocol: FTP or FTPS

® Host: [IP address of the camera]

® Port: 21

® Encryption: TLS/SSL Explicit encryption

® Username: [Username in FTPS menu settings]
® Password: [Password in FTPS menu settings]

® Logon Type: Normal

NOTE:

® File transfer speeds may vary depending on the strength of the signal (when using WiFi) and the amount of network
traffic. For the fastest and most reliable data transfer, we recommend using a hard-wired connection.

® Steps may differ depending on which FTP software you wish to use, consult your software’s user guide for additional
assistance.

® When setting up FTP, make sure you use FTP or FTPS and not SFTP as these are different protocols.
® For security reasons, the FTPS host name and password are only displayed on the camera FTPS menu.
® Disabling encryption can increase transmission speeds.
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CAMERA SET-UP

1. Connect your camera to the network with the desired connection method (Ad-Hoc, Infrastructure or USB-C) and
verify the connection. A successful connection is confirmed when the camera displays an IP address in the WiFi or
USB-C settings menus.

... » CONNECTIONS » WI-FI > INFRASTRUCTURE

SSID

Networks

Status
IP Assignment
Configure IP

IP Address 192.168.1.1

2. Navigate to Menu > Communication > Clients & Services > FTPS. Take note of the username and password. You can
also enter a new password QR code.

MENU > COMMUNICATION > CLIENTS & SERVICES > FTPS

Username ftp1
Password d2qtbdu94hjw &=
Settings Access

Media Access

Data Encryption

Connection Status

3. Enable the permissions you want users to have access to by toggling Settings Access or Media Access to the on or
off position. The media folder will display as an empty folder on the FTP App when Media Access is disabled (off).

4. The camera is now set-up on FTPS.
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SOFTWARE SET-UP (FILEZILLA)

[ Filezila — O
File Edit View Transfer Server Bookmarks Help

TR OROLIFA2S
Host: Username: Password: l ‘ Port: ’

igd v
4Ll

oo~

Local Site:[\ v |Remote site:

= Desktop

= Documents
SR his pc|

oo A (Fast)
#H8& C
+':> ~ D: (My Book)
o R (C-Plus)
+- . Z: (SSD2)

- A: (Fast)
&G

~ D: (My Book)
- R: (C-Plus)
~-Z: (SSD2)

Not connected to any server

Filename Filesize |Filename  Fi.. Filetype  Last modified Per...

<

5 directories

> <

Not connected.

Own.,

Server/Local fi... Dir.. Remote file

Size Pri...

Status

Queued files | Failed transfers

Successful transfers

@ Queue: empty

(XS]

1. In FileZilla, enter the following settings:
o Host: ftp://Camera's IP Address - Example: ftp://192.168.1.93
o Username: Username displayed in the camera's FTPS menu
e Password: Password displayed in the camera's FTPS menu
o Port: leave blank
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2. Press Quickconnect. Depending on the permissions you will now have access to the desired folders.

[F tp1@192.168.1.93 - FileZilla — O X
File Edit View Transfer Server Bookmarks Help
=== = [ - | 35 3
Y| E OO/ TAse
ﬂost:[ ‘ Username: Password: l Port: [ ‘ Quickconnect
Status: Logged in ~
Status: Retrieving directory listing...
Status: Directory listing of “/* successful v
Local site:|\ v |Remote site: [/ v
=} Desktop =] /

“= Documents ? cdis

= 8 This PC ? luts

oo A (Fast) 7 media

H8& C 7 presets

+- oo D (My Book) 7 uploads

+ o R (C-Plus)

+ o Z: (SSD2)
Filename . Filesize |Filename  Fi.. Filetype Last modified Per.. O~
~- A (Fast) "
ec cdls File folder 12/17/2020 3:06:00 PM drwx... 0!
~- D: (My Book) luts File folder 12/17/2020 3:06:00 PM drwx... 0
~~R: (C-Plus) presets File folder 12/17/2020 3:06:00 PM drwx... 0
~-Z: (SSD2) uploads File folder 3/23/2021 10:29:00 AM dr-xr... 01 v
< > < >
5 directories 5 directories
Server/Local fi... Dir.. Remote file Size Pri.. Status
Queued files | Failed transfers | Successful transfers

DE @ Queue: empty [P RY]

The camera FTPS menu Connection Status displays Connected:

MENU > COMMUNICATION > CLIENTS & SERVICES » FTPS

Username
Password
Settings Access
Media Access
Data Encryption

Connection Status

ftp1

d2qtbdu94hjw (B2

ADDITIONAL INFORMATION

When uploading files to the camera make sure that you use the ‘upload’ folder & then the desired sub-directory of luts,
cdls, presets or upgrade. Media cannot be uploaded to the camera.

The data rate of the FTPS transfer with encryption maxes out at roughly Gigabit Ethernet speeds.
Estimated download time for a full 256 GB is approximately 47 minutes when using a wired connection.
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USB-C CONFIGURATION

KOMODO-X offers a USB-C 3.0 protocol connection that provides communication support for Android devices, Apple
devices, Ethernet devices, and R3D streaming with the RED Connect License (with 5 Gb/s Ethernet adapter).

For more information about RED Connect refer to: RED Connect.

This section includes instructions for:
® USB-C Android Configuration

® USB-C Apple Configuration

® USB-C Ethernet Configuration
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USB-C APPLE CONFIGURATION

The KOMODO-X offers a USB-C 3.0 protocol connection that provides communication support for Apple devices.

CONNECTING TO AN APPLE DEVICE
1. From the Apple store, download the RED Control Apps to the Apple device.

Note: Scroll to the bottom of the user agreement to accept the agreement.

a1 Verizon =

il Verizon = 1:54 PM (-

< Search "4

REDCONT...

RED_CONTROL
Take control of your KOMODO™

-

= M
4.7 4+
kK kk Years Old
What's New

Version History

2. Connect the Apple device to the camera with a USB-C cable. If the "Trust This Computer?" message displays, skip to
step 6.
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3. Open the Apple device settings by tapping the Settings icon.

wil Verizon & 12:04 PM 7 &%)

N oMY 5

News Google Maps Gmail Calendar

¢ A £173

Photos Maps Clock Weather

COPYRIGHT © 2023 RED.COM, LLC

! Verizon = 4:27 PM

Settings
RED User

Apple ID, iCloud, Media
& Purchases

Airplane Mode

Wi-Fi
Mai Tai

Bluetooth
On

€D Cellular

Personal Hotspot

/

S
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4. Select Personal Hotspot.

| |

9

! Verizon = 4:27 PM

Settings
RED User

Apple ID, iCloud, Media
& Purchases

Airplane Mode

Wi-Fi
Mai Tai

Bluetooth
On

€D Cellular

Personal Hotspot

u /e I

S
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5. Allow others to join.

/'//; ® /’/";/ .
[ ] D [ ] D
i I |
' Verizon 4:27 PM - w1’ Verizon 4:27 PM -
{ Settings Personal Hotspot < Settings Personal Hotspot
lJI UVIUCT ITILTIHTITL aLULTOO VU VL iIcl lJl UVIUCT ITITITITL auLULTOO VU UL iITI
devices signed into your iCloud  f devices signed into your iCloud
account without requiring you to account without requiring you to
enter the password. l enter the password.
Allow Others to Join . | Allow Others to Join ( @)
Wi-Fi Password Wi-Fi Password
g5hlty3#X0Xi9 g5hlty3#X0Xi9
Allow other users or devices not Allow other users or devices not
signed into iCloud to look for your signed into iCloud to look for your
shared network “iPhone” when you are shared network “iPhone” when you are
in Personal Hotspot settings or when in Personal Hotspot settings or when
you turn it on in Control Center. you turn it on in Control Center.
% TO CONNECT USING WI-FI
1 Choose "iPhone" from the Wi-Fi
settings on your computer or
other device.
2 Enter the password
i / | i / |

\\ -~ y, \ -~ y,
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6. The Apple device prompts you to acknowledge that you trust the computer (camera).

Trust This Computer?

Your settings and data will be

accessible from this computer

when connected wirelessly or
using a cable.

Don't Trust
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7. From the Apple device, tap the RED Control icon to open the RED Control app.

!l Verizon LTE

REDCONT...
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The RED Control app displays the camera connection icon. The word LINK is visible after the IP address.

a1l Verizon LTE @ 4:38 PM

@ BE0 DIGITAL GOOEMA |y
—
I —

KOMODO-X

8. Tap the icon to open the RED Control app tools for the connected camera.

\\ 55[1[]K

800 A\
£/5.6 HO

-

= [][]1 01 5 T E PROJECT TIME BASE

e - = 35 1/48

CLIP NAME

6K 17:9 ' KOMODO-XA | F507_jooy 951

60 180° 0.07

b s

From here you can use the RED Control Apps to monitor and control the camera.
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USB-C ANDROID CONFIGURATION

The KOMODO-X offers a USB-C 3.0 protocol connection that provides communication support for Android devices.

CONNECTING TO AN ANDROID DEVICE
1. From the Google Play store, download the RED Control App to the Android device.

4 COO - 3 (436 @R @ -
&

RED CONTROL

RED.com, LLC.

Rate this app

Tell others what you think

wOW W W W

Write a review

o o *

Developer contact Authenticator ~ Settings - RED Control

About this app } WDM 1 ; @

Take control of your KOMODO™ Spectrum TV Mobile - My Spectrum Pocket Geek

Photography

4.7% 1K+ | c n @ a
@) <

402reviews Downloads Everyone ©

1] @] < ]

2. Connect the Android device to the camera with a USB-C cable.
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3. Open the Android device settings by tapping the Settings icon (gear).

(436 EE@ - 1134 @ WO o

Settings

a6

Connections
Wi-Fi, Bluetooth, Airplane mode, Data usage

Sounds and vibration
Sound mode, Ringtone, Volume

o 2
Authenticatd RED Control

» o 2 ©

Spectrum TV Mobile My Spectrum -Pocket Geek

Notifications
App notifications, Status bar, Do not disturb

Display

Brightness, Home screen

Wallpaper
Home screen wallpaper, Lock screen
wallpaper

C w”'@"av

I @) <
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4. Select Connections. 5. Select Mobile Hotspot and Tethering.

1134 A9 QO o g N e \ f 11:37 Gd @ [@

< Connections

Wi-Fi
ASUS

Settings

Wi-Fi Calling

Bluetooth

t to nearby Blu

Connections Airplane mode
Wi-Fi, Bluetooth, Airplane mode, Data usage Turn off calling, messaging, and Mobile

data

Sounds and vibration )
Sound mode, Ringtone, Volume Mobile networks

Notifications Data usage

App notifications, Status bar, Do not disturb

Mobile Hotspot and Tethering

Display
Brightness, Home screen

More connection settings
Wallpaper

Home screen wallpaper, Lock screen
wallpaper

Looking for something else?

NOTE: Mobile Hotspot and Tethering is only available on Android devices with cellular capability.
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6. Enable USB Tethering.

11:44 0 @ @& s \ B iy 14:8

< Mobile Hotspot and Tethering

< Mobile Hotspot and Tethering

Mobile Hotspot

Mobile Hotspot

Off

EStootlethenng Bluetooth tethering
= Share your phone's internet connection

using Bluetooth

hone's internet connection

USB tethering @)

Sharing this phone's internet connection
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7. From the Android device, tap the RED Control icon to open the RED Control app.

N Bl

Authenticator

D Koty 2 g : ‘ == |
> - 1 @ KOMODO-X

Spectrum TV Mobile My Spectrum - Pocket Geek

I @ <
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The RED Control app displays the camera connection icon.

“ BED DIGITAL GO0CIEMA .,
R —————— '

KOMODO-X

8. Tap the icon to open the RED Control app tools for the tethered camera.

\,  5600K

fla.6 ° "

00:01:57
p 33 148
6K 17:9 . KOMODO-X A : —
60 180°

From here you can use the RED Control App to monitor and control the camera.
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USB-C ETHERNET CONFIGURATION

The KOMODO-X offers a USB-C 3.0 protocol connection that provides communication support for Ethernet networks.

CONNECTING TO AN ETHERNET NETWORK

You must use a USB-C to Ethernet adapter to connect the camera to an Ethernet network.

1. Connect the camera to the Ethernet network using the USB-C to Ethernet adapter.

2. From a Wi-Fi-enabled device, select the Wi-Fi connection to which the camera is connected.

ol Verizon & 4:16 PM < (=)
< Settings Wi-Fi
Wi-Fi

NETWORKNAME | _ 5

Privacy Warning

MY NETWORKS
NETWORK 2 e @
OTHER NETWORKS
KMDBK000001 s @
Other...
/‘
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3. Open RED Control on the 4. Tap RE-SCAN.
Wi-Fi-enabled device. The camera icon displays.
[ ] [ ]
[ ] [

w1l Verizon LTE @ 4:38 PM

SOUND OFF

RED SUPPORT SLEEP OFF

MANUAL IP... MANUAL IP.

(OMODO-X 6K S35 1.10beta
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5. Tap the camera icon to open the RED Control app tools for the networked camera.

5.6 HO

¢ P 001005 T [ rrommess
e - 35 1/8

6K 179 ' KOMODO-XA | F501_Joo7 957 l’ L

60 180° 0:07

6. Open a browser from a computer connected to the Ethernet network.

7. In the browser address field, enter the camera IP address displayed on the RED Control camera icon or the camera
Communication menus (Ad-Hoc, Infrastructure). The RED Control tools are displayed in the browser.

00:10:15

Clip N/A

Dur 00:00:00

6K 17:9 / R3D HQ
60 FPS

Play Audio

Iris Shutter

Recordmg Frame Rate

KOMODO-X 6K S35
1.0.0beta
KXBK1000000

Camera Type
Camera Firmware Version

Camera PIN
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POWER

The camera accepts power through a DC-IN port and through an attached battery. The camera cannot accept power
through USB, or BNC ports. For more information, refer to 6-pin DC-IN, KOMODO-X™ Power AdaptorREDVOLT®
NANO-V Battery, and REDVOLT® MICRO-V Battery.

ATTACHING THE BATTERY

Attach a compatible V-Lock battery (refer to REDVOLT® NANO-V Battery and REDVOLT® MICRO-V Battery) in the V-
Lock battery mount. Slide the battery down until the locking mechanism clicks.

V-Lock batteries with a width greater than 2.95 in. (75
mm) are not compatible with the camera’s Micro V-
Lock plate and will require a battery adapter.

The camera can charge the installed battery when the
camera is off and the DC power Adaptor is
connected. The camera charges the batteries only
when the camera is off and the power Adaptor is
connected. While the battery is charging the DC
Power LED blinks amber until communication is
established. The LED is solid amber when
communication is established and the battery is
charging. The LED is green when communication is
not established (incompatible battery) and the battery

¢

is not charging.

NOTE: An incompatible battery will not charge on the camera.

REMOVING THE BATTERY

Remove the battery when the charge is low or when you are storing the camera.

1. Turn off the camera.
2. While holding the attached battery, press the battery Eject Button.
3. Slide and lift the battery up.

POWER COMPONENTS

You can power the camera with the KOMODO-X™ Power Adaptor, an External DC Power Source, or with a rear-
mounted REDVOLT® MICRO-V Battery or REDVOLT® NANO-V Battery.

For information about charging, storing, or maintaining the batteries, refer to the manufacturer's instructions.

AUTO BOOT ON POWER

The camera supports the Auto Boot on Power feature. This means that if all power sources are removed, and the Power
Switch is set to ON, then when a power source is attached, the camera turns on.
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POWER CONSUMPTION

The camera draws various levels of power depending on the configuration and operating conditions. When there are no
auxiliary (AUX) power draws on the camera, the power consumption guidelines are:
® 28 Watts of power in the camera's basic recording configuration at room temperature, 6K, and 24 frames per second

® 45 Watts of power when using DSMC3 RED Touch 7", at room temperature, 6K, and 80 frames per second

POWER PRIORITY

When multiple power sources are connected to the camera, power consumption is prioritized in this sequence:
1. Any power supply connected to the DC IN port.

2. Attached V-Lock battery.

WARNING: Always attach the power or battery before attaching the SDI BNC cable. Always remove the SDI BNC cable
before removing the power or battery.

TURNING ON THE CAMERA
1. Attach a power source (REDVOLT® MICRO-V Battery or DC-Input) to the camera.
2. Slide the Power Switch up to the ON position.

m
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I
>
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w
=
o
o
4
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=
o
@
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=i
P
c
(2}
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TURNING OFF THE CAMERA

NOTE: Do not turn off the camera while the camera is recording, or formatting media.
Slide the Power Switch down to the OFF position.

MEDIA MANAGEMENT

This section explains how to use, record, format, and offload media for the camera.

WARNING: Do not attach a label to the media card. The heat generated by the media can weaken the label's adhesive,
causing the label to detach inside of the camera. Labels can also diminish heat dissipation and cause excessive wear to
the internal components. Removing a label from a media card can possibly deform the card body.

The camera supports exFAT as the file system for the media card to accommodate larger files and data rates. exFAT is
supported both on macOS and MS Windows.

Format your media in the camera whenever possible (refer to Media Best Practices).

EJECTING (UNMOUNTING) MEDIA

IMPORTANT: To ensure data integrity, media must always be ejected (unmounted) prior to removal from the camera.
This ensures that power is removed from the media and any open data files are closed. Failure to properly eject
(unmount) media may result in lost data or corrupted files.

To eject (unmount) media from the camera, use the Onboard LCD Touchscreen and select Menu > Media.

MENU

Image / LUT
Project Settings

Audio / TC

Monitoring

Media

User Settings
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Tap the Eject OK button:

MENU > MEDIA

Eject

Media Info

Secure Format

The Success message displays:

MEDIA

Media ejected successfully. It is now safe to
remove the media.

The media is now ejected (unmounted) and all media related items are grayed out in the menu.

MENU > MEDIA
WARNING: The media can get extremely hot. Use caution when removing
media.

Removing a media card without ejecting (unmounting) first does not damage
the media, however, it does increase the risk of file corruption. It is good
practice to eject the media before removing or disconnecting. Ejecting the
media provides the following benefits:

Media Info

- Protects the integrity of your recorded data
- Mounts clips instantly to your workstation in post-production.
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INSERTING THE MEDIA

The camera contains a covered compartment on the right side where you insert the CFexpress media card.

WARNING: Do not attach a label to the CFexpress media card. The heat generated by the media can weaken the
label's adhesive, causing the label to detach inside of the camera. Labels can also diminish heat dissipation and cause
excessive wear to the internal components. Removing a label from a CFexpress media card can possibly deform the
card body.
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INSERTING THE MEDIA CARD

1. Press the media door latch down, and the media door opens.
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2. Insert the CFexpress media card in the slot with the top of the card facing toward the front of the camera. Insert the
card until it is firmly seated.

3. Close the media door and make sure that the door latch clicks.
4. If needed, format the CFexpress media card. Refer to Secure Format for more information.
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REMOVING THE MEDIA CARD

NOTE: Do not remove the CFexpress card while the camera is recording or formatting media. Refer to Media
Management for more information.

WARNING: The media can get extremely hot. Use caution when removing media.
1. If the camera is on, go to Menu > Media and select Eject.

2. Press the media door latch down, and the media door opens.
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3. Press the CFexpress media card until you hear a click, and then release the card and it will slide out.

4. Let the CFexpress media card cool before gently pulling the card out of the slot.

WARNING: The media can get extremely hot. Use caution when removing media.
5. Close the media door and make sure that the door latch clicks.
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SECURE FORMAT

A secure format is a low-level format that rebuilds the media card file system. A secure format erases all data on the
card.

Perform a secure format when the camera is reporting media-related errors.

PERFORMING A SECURE FORMAT

CAUTION: Ensure all data is backed up before formatting a card. Data erased during formatting cannot be
recovered.

WARNING: The media can get extremely hot. Use caution when removing media.
To perform a secure format, follow the instructions below:
1. Go to MENU > MEDIA > SECURE FORMAT:

MENU > MEDIA

Eject

Media Info

Secure Format

2. From the Secure Format menu, select the desired Camera ID, Camera Position, Reel Number and Edgecode. Tap the
Format button to start the Secure Format process:

MENU » MEDIA > SECURE FORMAT

Camera D
Camera Position

Reel Number

Edgecode 01:00:00 |/

Format (0]14
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The confirmation message displays:

/Y

SECURE FORMAT

Formatting will erase all data. This may take
several minutes. Continue?

Co
SISSS IS SIS

3. Tap Yes to begin formatting.

/s

MEDIA FORMAT
) . MEDIA FORMAT
Formatting media...

Media was successfully reformatted and is
_ ready for immediate use.

FORMATTING MEDIA ON A COMPUTER

RED recommends that you only format your media card from a computer when you cannot mount the media to the
camera (refer to Media Best Practices for more information).

MEDIA INFORMATION

Use the Media Info menu to display the media card information.
Media information includes the following:

SETTING DETAILS

Status Displays the media card status

Model Number Displays the media card model number

Serial Number Displays the media card serial number

Firmware Version Displays the media card firmware version

Percentage Remaining Displays the media card's remaining storage*

Time Remaining Displays the recording time remaining on the media card*

* with the current project settings
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FILE SYSTEM

The camera formats the media card using the exFAT file system. Both Mac® and Windows®-based computers support
media cards with this system. Refer to the documentation for your operating system to determine whether there are any
limitations to its file system support.

CLIP NAMING CONVENTION

When you record a clip, the camera creates a unique name for the clip folder that uses the format described in the table
below:

ITEM DETAILS EXAMPLE

Camera ID The letter assigned to the camera (refer to Camera ID) A

Reel ID The reel number assigned to the media (refer to Reel Number) 004

Camera Position The camera position letter (A-Z) followed by three digits starting with 001 (refer Coo1
to Camera Position)

Month Month that the clip is recorded (refer to Date / Time) 12

Day Day that the clip is recorded (refer to Date / Time) 04

Two Characters Two random alphanumeric characters generated by the camera to prevent any 6M
possibility of duplicates

.RDC Clip folder extension .RDC

For example, a sequence of clip folders within a media folder on Camera A may look like this:
®* A001_C001_12046M.RDC
* A001_C002_1204CE.RDC
®* A001_C003_1204R5.RDC

CLIP METADATA

The following metadata is recorded for each frame of each clip:

e Audio Data o Lens Name, Brand, ID, Near Focus, Far Focus
e Broadcast Wave File (BWF) e Location
e Clip e LTC User Bits (3 32-bit word reg-dump from ISP)
« Configuration, Camera Name, Network, Model, « Media Serial Number
Model ID, Serial Number e Production Name
« Copyright - REDCODE®
o Date and GMT e Reel
e Filename e Scene
e Firmware Version e Stereo Setup
e Frame Guides e Take
e Jamsync Setting e Timecode
e Lens and Shutter Speed/Angle Parameters e Unit

N
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MEDIA BEST PRACTICES

This section describes best practices to ensure that your media cards continue to provide reliable storage and fast data
rates. Following these best practices may prevent your media card from becoming fragmented, which can lead to data
integrity errors.

®* The only files that should be saved from your computer to your media card are Preset files, Firmware Upgrade files,
and LUTs. DO NOT save other files, folders, or applications to your media.

® DO NOT back up your hard drive to the media card. When using a Mac, the system may ask if you want to back up
your files to the media card using Time Machine; DO NOT use the media card as a backup disk.

®* DO NOT delete clips off of your media card using a computer. Delete clips only by formatting your media card in-
camera. For more information about formatting your media card, refer to Secure Format.

®* DO NOT format your media card using a computer, unless the media card cannot mount to the camera. For more
information, refer to Secure Format.

®* When ejecting the media card from a computer, ensure that the icon has completely disappeared from the Finder
window (Mac) or from Windows Explorer (Windows) before removing the media card. Sometimes, the pop-up saying
that the media card has ejected displays too early.

®* When the reader has a write-protect switch (such as the CFexpress Type B Media reader), it is recommended that
you set the card reader to write-protect when uploading clips to prevent connected devices from adding any
unwanted data to your media card.

INDEXING ON A MAC
NOTE: You can use the RED media reader with Write-Protect to prevent the Mac OS from indexing your media card.

Most newer versions of the Mac OS automatically index all external drives when you connect them. This includes when
you connect media cards.

Indexing makes the connection process take longer. While the media card connects to the Mac, DO NOT remove the
card. Indexing writes hidden files to the media card. When you insert an indexed media card in the camera, it can take
the camera a while to recognize the hidden files and connect to the media card. While waiting for the media card to
connect, DO NOT remove the card or turn off the camera. After the camera successfully connects to the media card,
perform a secure format to remove the hidden files. For more information, refer to Secure Format.
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RED MONITOR INTERFACE CABLE

The DSMC3™ RED® Touch 7.0" LCD monitor includes a custom RED Monitor Interface (RMI) cable that provides
communication between the RMI and the monitor.

Where this cable attaches to the RMI and the monitor, there are special locking features that keep the cable from
accidentally detaching.

NOTE: The RMI cable is attached to the monitor at an angle, as shown in the image.
To unlock the cable locks, rotate the RMI cable lock and slide the monitor cable lock, as shown in the image:

y

NOTE: The USB-C-style DSMC3™ RMI cable is a custom-Pinned cable, which is not compatible with standard USB-C
cable ports (including the rear camera USB-C port). The EXP ports on the RMI are for future use and are not currently
supported.

Optional RED Monitor Interface (RMI) cables:

® 10" DSMC3™ RMI Cable

¢ 18" DSMC3™ RMI Cable

® 39" DSMC3™ RMI Cable
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MONITORING

The camera provides several methods for monitoring the image. These monitoring methods include:
® Onboard LCD touchscreen

DSMC3™ RED® Touch 7.0" LCD

SDI output to a monitor

RED Control over Wi-Fi to iOS or Android devices

USB-C to Ethernet adapter to a computer

1080 M-JPEG Live Stream

ONBOARD LCD TOUCHSCREEN

The Onboard LCD touchscreen provides a live image from the camera sensor. By using the Monitoring Tools menu, you
can display guides, exposure tools, focus tools, and a magnified image.

®e ¢ o o o

Tap on the Exposure meter to open the Monitoring tools.

15:39:00 2 . MAGNIFY ! EDGE EXPOSURE

P: A023_C001
UR: 00:00:00
6K 17:9 / R3D MQ
30 FPS

PRESS TO RECORD

IE n - s
FOCUS n ZEBRAS n
ONBOARD ONBOARD
/ 180° 5600« < LoD LoD To0Ls
IRIS SHUTTER WB GUIDES TOOLS

In this example the LCD magnification and LCD guides are enabled. The Autofocus rectangle is also displayed.
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SDI OUTPUT TO A MONITOR

The SDI port provides a 12G SDI signal, which allows you to view the camera image on a 4K SDI monitor at up to 60
fps.
Use the Monitor menu to select the settings for SDI output, Tools, and Guides (refer to Monitoring Menu

WARNING: Under certain circumstances, it is possible for an SDI connector to incur damage when connected to an
accessory and powered without using shielded cables. RED recommends only using high quality, shielded BNC cables
that are rated for 12G-SDI signals and only using shielded power cables for powering SDI accessories.

Make sure power is connected to the SDI accessory at all times before you connect the BNC to the camera.
Ungrounded power from SDI accessories can damage the camera’s SDI port. To avoid this possible damage, attach the
power source to the accessory before attaching it to the BNC cable. When using RED Approved Third Party battery
plates, unplug the BNC cable prior to hot swapping.

When possible, avoid using P-Tap (also known as D-Tap) cables to power accessories. To avoid damage when using P-
Tap/D-Tap, it’s imperative that the connect/disconnect sequence (below) is followed precisely.

BNC ATTACHMENT INSTRUCTIONS
When attaching SDI accessories:
1. Connect a power source to the SDI accessory; power on the SDI accessory.

2. Ensure a power source is connected to the camera. This ensures both are grounded prior to connecting the BNC.
The camera's power state does not have an impact on SDI attachment sequence.

3. Connect the BNC cable to the accessory, then to the camera.

When detaching an accessory mounted to an SDI output, ensure that you remove the BNC connection to the camera
before removing power to the SDI device:

1. Shutdown the SDI accessory.
2. Disconnect the BNC cable from the camera.
3. Disconnect the power source from the SDI accessory.

When you need to swap out a battery on an accessory mounted to the camera’s SDI port, you must:
1. Shutdown the SDI accessory.

2. Disconnect the BNC cable from the camera.
3. Replace the battery on the SDI accessory.
4. Connect the BNC cable to the camera.

5. Power on the SDI accessory.

For more information, refer to Preventing Damage to SDI Outputs.
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23.98FPs 1s0800 5600k

DC-IN 15.1V 6K 17:9 erria.
BAT-198%  R3D MQ+ 422 HQ | ||| 15:52:01:05

Figure: SDI monitor with SDI Advanced Mode enabled

SDI port specifications:

Integrated 12G-SDI with 6G-SDI, 3G-SDI, and 1.5G-SDI modes

12G-SDI: Up to 4096 x 2160 10-bit 4:2:2 for 60p

6G-SDI: Up to 4096 x 2160 10-bit 4:2:2 for 30p

3G-SDI: Up to 2048 x 1080 10-bit 4:2:2 for 60p

1.5G-SDI: Up to 2048 x 1080 10-bit 4:2:2 for 30p and 24p

SMPTE Timecode

HANC Metadata

24-bit 48 kHz Audio

You can enable or disable the image magnification, the focus and exposure tools, and the guides displayed on images
sent to the SDI monitor by using the Monitoring tools (refer to Monitoring Tools).

e o o o o o o o
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Tap on the Exposure meter to open the Monitoring tools.

. 15:39:00 1 T

LIP: A023_C001
TAP  DUR: 00:00:00
6K 17:9/ R3D MQ
30 FPS CAM

PEAKING

PRESS TO RECORD

Iy 180° 5600k
IRIS SHUTTER WB

You can enable the following monitoring tools on SDI:
® Magnify

¢ SDI Guides (refer to Guides)

® SDI Tools (refer to Tools)

RED CONTROL

RED Control allows you to use Wi-Fi to connect to the camera and send monitor images to iOS and Android devices.
NOTE: You must enable live streaming under MENU > MONITORING > LIVE STREAM to enable the image feed.

KOMODO-X F

230

Figure: RED Control phone monitor over Wi-Fi
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With the use of an Ethernet to USB-C adapter, you can also connect Ethernet devices.

00:10:15

Clip N/A

Dur 00:00:00

6K 17:9 / R3D HQ
60 FPS

Play Audio

Recordlng Frame Rate |I’IS Shutter Color Temperature

Camera Type KOMODO-X 6K S35
Camera Firmware Version 1.0.0beta
Camera PIN KXBK1000000

Figure: USB-C Adaptor connected to an Ethernet web browser

You can add :9090 to the end of the URL in your browser to bring up an image-only feed for remote viewing.
NOTE: You must enable live streaming under MENU > MONITORING > LIVE STREAM to enable the image feed.
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EXPOSURE

The camera offers multiple tools to determine the current image exposure levels and provides the tools to adjust the
exposure to the desired levels.

When using the R3D file format, you can correct color temperature and ISO settings at any time. The aperture and
exposure time however, are two of the parameters that you cannot corrected later in R3D files.

NOTE: ProRes file format burns in ISO and White Balance, and does not allow you to adjust these settings post-
recording like you can with the R3D format.

While the correct exposure is always an artistic decision, there are best practices for capturing the most dynamic range
while also allowing post production to preserve the intended image information.

The goal is to reduce clipping in the bright and dark parts of the image as much as possible. Otherwise the sensor
information is lost in the overexposed and underexposed areas.

The primary tool for determining the exposure levels is the histogram. It shows the exact luminance levels of the red,
green, and blue pixels after you apply the ISO and White Balance settings. Monitors have their own color gamuts and
brightness levels which makes the monitor less than optimal for determining the camera's exposure levels.

This camera includes a full Histogram and a simple RGB raw pixel exposure meter, which allows you to determine
proper exposure regardless of the set ISO or camera look (for more information refer to Onboard LCD Touchscreen).

The full histogram provides information about how the brightness is distributed in the image. This allows you to see how
close a scene is to clipping in the light and dark areas, which makes it easy to choose aperture, exposure, and ND
filters solutions accordingly.

Example of overexposure Example of underexposure Example of a balanced exposure
with histogram and exposure meter: with histogram and exposure meter: with histogram and exposure meter:

PRESS TO RECORD #
PRESS TO RECORD #

CAM

a
=
Q
o
e
«
)
2
0
(7]
w
o«
a

800 3.5 180° 5600k 800 22,6 180° 5600« 800 o 180° 5400«
1so IRIS SHUTTER WB PS IS0 IRIS SHUTTER wB FPS Iso RIS SHUTTER WB
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FALSE COLOR EXPOSURE TOOLS

While the histogram provides information about the brightness distribution and clipping of the image, it does not show
you the areas in the image that are near, or that have reached, clipping. For this, the camera provides image overlays
that provide false colors to indicate precise exposure levels.

FALSE COLOR EXPOSURE MODE

The False Color Exposure mode overlay provides information where the image is close to clipping or already clipping in
the highlights (red), midtones (green), and shadows (purple). For more information, refer to False Color Exposure Mode.

Example of Exposure Mode:

FALSE COLOR VIDEO MODE

The False Color Video mode provides more gradual information about the brightness in different parts of the image. This
is helpful when you want to expose skin color at the right level, while ignoring the fact that backgrounds might be
overexposed or underexposed (refer to False Color Video Mode).

Example of Video Mode:

FALSE COLOR GIO SCOPE MODE

Gio Scope mode displays a color overlay on top of a desaturated RAW sensor image, identifying 16 increments within
the dynamic range of the sensor. The RGB settings (color temperature, ISO, LUT, etc.) are not used by this mode.

Each number (1 to 16) indicates a different increment of dynamic range. Number 16 represents the top increment, and is
broken up into 1/8th sub-increments to show highlight roll-off. Each 1/8th increment is represented by a different shade
of red, ranging from light red (less light) to dark red (most light, clipping).
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FOCUS

Focus, like Exposure and Recording Frame Rate is a property that cannot be fixed easily in post-production. To make
sure the camera is focused correctly when you begin recording, it is important to rely on focus tools that do not rely on
the visibility on the LCD Touchscreen or a monitor.

The camera interface includes the focus tools you can use to reach the desired image focus (refer to Peaking).

FOCUS PEAKING MODE

The Focus Peaking mode applies a sharpening filter to the image that emphasizes edges of the subject in focus.

Example of Focus Peaking:

EDGE PEAKING MODE

The Edge Peaking mode hides the image and only shows the edges. This provides the best visual representation of the
subject that is currently in focus.

Example of Edge Peaking mode:

PEAKING PEAKING MODE

The Peaking Peaking mode emphasizes the edges, and it also highlights them by using a selectable color.

Example of Peaking Peaking mode:
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TIMECODE

Timecode provides a mechanism to reference frames from the camera's recorded clips to other devices like cameras
and audio recorders. Some devices can also gather other data like lens metadata or camera orientation that is
referenced by Timecode to merge the data back together in post-processing.

KOMODO provides two separate Timecode concepts: Time of Day (TOD) and Edgecode. Both TOD and Edgecode are
stored in the R3D file. The user can select which Timecode displays on the Onboard LCD Touchscreen by setting the
preference in Timecode Display Mode.

TIME OF DAY

TOD Timecode reflects the time and date the camera recorded each frame. KOMODO synchronizes the TOD Timecode
to an external Timecode generator (when one is connected to the Extension Port) or synchronizes to the internal real-
time clock of the camera.

SETTING UP TOD TIMECODE

To set up TOD Timecode on the camera, perform the following:
1. Open the Audio / Timecode menu: MENU > AUDIO / TC:

MENU » AUDIO / TC

Audio Source Internal Microphone ...

Internal Microphone (Ch 1/2)

External (Ch 3/4)

Headphone
Timecode Source Internal TOD ¥

Auto Jam I

2. Select Timecode Source. The Timecode Source menu opens:
MENU » AUDIO / TC

Timecode Source

> Internal TOD <

Internal Manual

External

OK Cancel

3. Select Internal TOD to use the camera's internal real time clock, select Internal Manual to specify a starting time for
the internal clock, or select External to use an external Timecode generator connected to the Extension Port.
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4. When you select Internal TOD, you can use the Auto Jam switch to enable the camera to automatically synchronize

the Timecode to the camera's internal clock.

MENU > AUDIO / TC

Headphone >

Timecode Source Internal TOD ¥

Auto Jam |

Timecode Display Mode TOD Vv

The camera displays the Timecode on the Onboard LCD Touchscreen

00:00:00
6K 17:9 / R3D MQ
30 FPS CAM

PRESS TO RECORD #

800 Iy 180° 5600k
IRIS SHUTTER WB

1S0

NOTE: The timecode is reset when the camera is turned off, unless an external power source remains connected and

powered.

EDGECODE

Edgecode only advances while the camera is recording frames. Each frame is sequential. When the media is replaced,
the new media starts the timer over. You can set the Edgecode timer manually by using the Secure Format menu.

SETTING UP EDGECODE TIMECODE

To set up Edgecode Timecode on the camera, perform the following:
1. Open the Audio / Timecode menu: MENU > AUDIO / TC:

MENU > AUDIO/ TC

Audio Source Internal Microphone ...
Internal Microphone (Ch 1/2)
External (Ch 3/4)

Headphone

Timecode Source Internal TOD ¥

Auto Jam |
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2. Swipe the touchscreen up to scroll down to Timecode Display Mode:

MENU > AUDIO / TC

Headphone >

Timecode Source Internal TOD ¥

Auto Jam |

Timecode Display Mode

3. Select Timecode Display Mode. The Timecode Display Mode menu opens:
MENU » AUDIO / TC

Timecode Display Mode

> TOD <

Edge

(0]1¢ Cancel

4. Select Edge and tap OK to use Edgecode. The camera displays the Edgecode on the Onboard LCD Touchscreen
01:00:12

CLIP: A023_C001
DUR: 00:00:00
6K 17:9 / R3D MQ
30 FPS

PRESS TO RECORD #

180° 5600k
SHUTTER WB
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ZEBRA MODES

Use Zebra mode to enable and adjust the upper and lower values for two (2) independent zebra indicators. Use Zebra 1
for highlight exposure, and use Zebra 2 for mid-tones or shadows. Zebras are disabled by default.

For more information, refer to the Exposure with RED Cameras: False Color and Zebra Tools article, available at
www.red.com/red-101/exposure-false-color-zebra-tools.

ENABLING THE ZEBRA 1 INDICATOR

1. Go to MENU > MONITORING > TOOLS and select ZEBRA 1.
2. Set a Low IRE of 98.

3. Set a High IRE of 100.

Areas of the image exposed within the IRE range are indicated by red diagonal lines at —45°.
The default settings are Low IRE = 98 and High IRE = 100.

ENABLING THE ZEBRA 2 INDICATOR

1. Go to MENU > MONITORING > TOOLS and select ZEBRA 2.
2. Set a Low IRE of 41.

3. Set a High IRE of 48.

Areas of the image exposed within the IRE range are indicated by green diagonal lines at 45°.
The default settings are Low IRE = 41 and High IRE = 48.

ZEBRA OVERVIEW

Zebra is a specialty mode that is capable of showing up to two customized overlays with arbitrary IRE ranges. Unlike
the other two modes, Zebra indicators appear as diagonal stripes, they are fully configurable, and they have the
advantage of preserving a full-color base image.

With traditional video cameras, many used a single zebra to indicate highlight detail. It would often be set at 70% (70
IRE), in part because this is where a white piece of paper would begin to have minimal texture when rendered using a
typical contrast curve. Skin tones or skies would be exposed to appear just darker or brighter than these lines. If
enabled, a second zebra would typically indicate either mid-tones or shadows. For deep shadows, you can set the
second indicator to below 10% intensity or 10 IRE, and set the first indicator to highlights above 85 IRE.

However, as with other IRE-based modes, Zebra mode is only applicable for the current ISO settings (such as with SDI
output), not for the raw image data. If anything is changed in post-production, the indicators won't be representative of
the final output tones. In those situations, Zebra mode is more of a preview and output brightness tool than an exposure
tool.
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PRE-RECORDING CONTENT

This section explains how to use the Pre-Record feature.
To start pre-recording, press the Record button.

The LCD changes from the Ready appearance to the Pre-Record appearance:

15:39:00
LIP: A023_C001
UR: 00:00:00
6K 17:9/ R3D MQ
30 FPS CAM

15:39:00 5
CLIP: A023_C001 ==
DUR: 00:00:00

6K 17:9 / R3D HQ

23.98 FPS

PRESS TO RECORD #

PRE-RECORDING » )

800 iy 180° 5600« 4 5.6 /48 5700k
150 RIS SHUTTER WB FPS ) RIS SHUTTER TINT

Press the Record button again to start recording.

When you start recording, the appearance of the LCD changes from the Pre-Record appearance to the Record
appearance:

2 15:39:00

CLIP: A023_C001

alimle DUR: 00:00:00
6K 17:9 / R3D HQ
23.98 FPS

(]
CLIP: A023_C001
——— DUR: 00:00:04
6K 17:9 / R3D HQ
23.98 FPS

.
A
S
17
o
=
2
a
@
o
o

PRE-RECORDING » )

23.98 800 5.6 48 5700«
FPS 1so IRIS TINT

SHUTTER

23.98 800 5.6 48 5700«
FPS 1s0 IRIS TINT

SHUTTER

The camera adds the Pre-Record clip to the beginning of your recording.

You can touch and hold the record button on the Onboard LCD to stop Pre-Record. You can also assign physical
buttons on the camera to Pre-Record Stop to stop and erase the current Pre-Record segment, or Pre-Record Toggle to
completely disable or enable the Pre-Record function.

For information about enabling and configuring Pre-Record, refer to Pre-Record.
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CALIBRATING THE SENSOR

Sensor calibration is a process during which the camera optimizes image quality by ensuring that pixel sensitivity
remains consistent throughout the sensor.

WHEN TO CALIBRATE THE SENSOR

Calibration is recommended:

® When shooting in an environment where the temperature is significantly different (+/- 30° F...) from the current
calibration. The T in the T/E Status Bar indicator will turn yellow (refer to Status Bar for more information)

® After an extreme change in exposure time (+/- 1/2 sec). The E in the T/E Status Bar indicator will turn yellow (refer to
Status Bar for more information)

® After each firmware upgrade
* When you have any image quality concerns

UPGRADING THE FIRMWARE

You can receive the best performance from your camera by installing the latest firmware. Make a habit of frequently
visiting RED Downloads at www.red.com/downloads to check for new versions of camera firmware, updated operation
guides, and post-production software.

VERIFYING THE FIRMWARE VERSION

To view the firmware version that is currently installed on your camera, open Menu > System Settings > System
Status > Camera Info:

... > SYSTEM STATUS > CAMERA INFO Version displays the currently installed camera firmware. A higher number
reflects a newer release.

Camera Type KOMODO-X 6K S35

Camera PIN

Version

Runtime

UPGRADING THE FIRMWARE

Install the most recent firmware. Unless otherwise specified in the release notes, you do not need to upgrade to any
firmware in between your current version and the most recent version available online.

You can upgrade the firmware by using an upgrade folder copied to a media card, or you can upgrade over an Ethernet
connection.

NOTE: You must calibrate the sensor after upgrading the camera. For more information, refer to Calibrating the Sensor.
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UPGRADING FROM A MEDIA CARD

1. Download the most recent firmware for your camera from RED Downloads at www.red.com/downloads.

2. Unzip the firmware zip file.
3. In the unzipped folder, navigate to the upgrade folder.
4. Copy the upgrade folder and its contents to the root level of the media card directory.

5. Unmount the media card from your computer and remove the media card from the media reader.
6. Insert the media card in the camera. The camera detects the upgrade folder and prompts you to upgrade the

firmware.
7. From the camera Ul, navigate to Menu > Maintenance.

MENU

User Settings

Autofocus

Communication

System Settings

Language English ¥

Maintenance >

8. From the Maintenance menu, navigate down to Upgrade and tap OK.

MENU > MAINTENANCE

Calibrate OK
Calibration Factory 'V
Save Log OK
Reset Defaults (014
Factory Reset (0]3¢

Upgrade (0]:¢

The Firmware Upgrade confirmation screen displays:

FIRMWARE UPGRADE
This upgrade will require a system restart.
Would you like to upgrade?
Current version: X.X.1
Upgrade version: X.X.2
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9. Tap Upgrade to confirm. The Firmware Upgrade progress screen displays:

FIRMWARE UPGRADE
Preparing for firmware upgrade; this may take
several minutes.

Do not power down during this process.

During the upgrade, the fans run at high speed and the following occurs:
The camera displays the SHUTTING DOWN screen and reboots

The camera restarts and displays the UPGRADING screen

The camera displays the INITIALIZING screen

The camera displays the FIRMWARE UPGRADE progress screen:

[ ]

FIRMWARE UPGRADE

Performing final firmware upgrade step; this
may take several minutes.

Do not power down during this process.

The Firmware Upgrade success message screen displays with a RESTART button:

FIRMWARE UPGRADE

Firmware upgrade successful.

Restart

10. Tap Restart. The camera displays the SHUTTING DOWN screen and reboots again.
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11. The camera restarts displaying the Start screen, the INITIALIZING screen, and then the Software License
Agreement (SLA) displays:

SOFTWARE LISCENCE AGREEMENT
IMPORTANT - READ CAREFULLY: This
Software License Agreement (“SLA”) is a legal
agreement between you (either an individual
or a single entity) and RED.COM, LLC (“RED")
for software owned by RED and its affiliated
companies and its third party suppliers and
licensors that accompanies this SLA, which
includes software, documentation, interfaces,
fonts and any data that comes with the RED
Camera and/or Camera Module and updates
(“Software”). The Software is licensed, not

Do Not Agree

12. Tap Agree. If you do not agree to the SLA, the camera cannot be used. The SLA continues to display until it is
accepted.

13. Recalibrate the camera before recording. Refer to the Calibration section and Calibrating the Sensor for more
information.

UPGRADING THE DSMC3™ RED® TOUCH 7.0" LCD FIRMWARE

You can receive the best performance from your DSMC3™ RED® Touch 7.0" LCD monitor by installing the latest
firmware. Make a habit of frequently visiting RED Downloads at www.red.com/downloads to check for new versions of
DSMC3™ RED® Touch 7.0" LCD firmware, updated operation guides, and post-production software.

UPDATING AUTOMATICALLY THROUGH THE CAMERA

When a newer firmware is detected on the camera, the DSMC3™ RED® Touch 7.0" LCD will prompt you on each boot
to update the monitor. Follow the on-screen prompts to update the monitor.

UPDATING MANUALLY THROUGH SmallHD

When a newer monitor firmware is available directly from SmallHD, there are two ways you can upgrade the DSMC3™
RED® Touch 7.0" LCD firmware.

UPGRADE DIRECTLY FROM THE DSMC3™ RED® TOUCH 7.0" LCD

1. Download the DSMC3™ RED® Touch 7.0" LCD upgrade .bin file directly from downloads.smallhd.com, to the root
directory of a 2, 4, 8, or 16 GB SD card.

2. Insert the SD card in the monitor.
3. From the DSMC3™ RED® Touch 7.0" LCD Settings Panel, initiate the update.

UPGRADE THROUGH THE CAMERA
1. Download the DSMC3™ RED® Touch 7.0" LCD upgrade .bin file directly from downloads.smallhd.com.

2. Create a folder named “smallhd” on the root of the camera’s media card.
3. Copy the firmware file to the "smallhd" folder.

4. Insert the card in the camera, and initiate the update through the Settings Panel of the DSMC3™ RED® Touch 7.0"
LCD.

NOTE: This method requires that the monitor be on at least firmware version 5.0.0 to work. If the monitor is on 0S4,
use the Directly from the DSMC3™ RED® Touch 7.0" LCD firmware upgrade method.
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SYSTEM MAINTENANCE

All RED products are designed for rugged durability, but precision instruments demand proper care. Follow the
instructions in this section to clean, maintain, and store your devices.

WARNING: DO NOT rinse or immerse the camera or other accessories in water. Keep dry at all times.

WARNING: DO NOT use soaps, detergents, ammonia, acetone, alkaline cleaners, abrasive cleaning compounds, or
solvents. These substances may damage lens coatings and electronic circuitry.

WARNING: DO NOT use an excess of cleaning solution.
WARNING: DO NOT reuse swabs or wipes.

WARNING: DO NOT attempt to clean the sensor or optical cavity for any reason. If the sensor becomes dirty, submit a
Support ticket at https://support.red.com.

WARNING: DO NOT attempt to modify, dismantle, or open the camera, lens, or other accessory as doing so may
expose you to electric shock and serious injury. There are no user-serviceable parts inside. Alteration or repairs made to
the camera or accessories, except by a RED authorized service facility, voids all warranties.

WARNING: Use caution with compressed air and gas dusters, since the high pressure, oily residue, cold air,
particulates, and moisture may cause damage. You may use a filtered, non-residue gas duster to clean non-critical
areas, such as around the fans and other recesses on the exterior of the camera. Damage to the camera or other
components of the camera system caused by using compressed air or gas dusters is not covered under warranty.

WARNING: DO NOT use compressed air and gas dusters on the sensor or on any optics.

WARNING: DO NOT use compressed air and gas dusters on or around the integrated microphones on the front of the
camera.

EXTERIOR SURFACES

Use a filtered, non-residue gas duster to clean non-critical areas, such as around the fans and other recesses on the
exterior of the camera.

Clean with a dry lint-free cloth. When cleaning your camera and accessories, remember that the devices are not
waterproof and moisture can damage electronic circuitry.

STORAGE

WARNING: DO NOT store the camera or accessories in any place with extreme temperatures, direct sunlight, high
humidity, severe vibration, or strong magnetic fields.
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ONBOARD LCD SCREEN

This section explains how to clean the Onboard LCD screen.

APPROVED LCD SCREEN CLEANERS

Use only the following products to clean the Onboard LCD screen:
® |onized rubber air bulb
® Delkin Devices Sensor Solution®

® |ens swabs
® Dry optical wipes

NOTE: Before cleaning the screen with swabs or wipes and a cleaning solution, ALWAYS use an ionized rubber air bulb
to remove any solid particles. Cleaning the screen without removing solid particles increases the risk of scratching the
screen.

PROHIBITED LCD SCREEN CLEANERS

DO NOT use any of the items listed below to clean the Onboard LCD screen. These products have not been tested on
RED products and may cause damage or streaking.

e Windex e Solvents e Gas dusters e Compressed air ¢ Rubbing alcohol e Isopropyl alcohol
¢ Third-party cleaning kits e Pancro Professional Lens Cleaner (or equivalent)
® Pre-packaged lens cleaner containing any additives, such as detergent, anti-static compounds, or fragrance.

WARNING: Damage to the Onboard LCD screen or other components of the camera system caused by using
prohibited cleaners is not covered under warranty.

WATER DAMAGE

If your device has come in contact with water or you suspect water damage, submit a Support ticket at
https://support.red.com immediately.

WARNING: DO NOT attempt to power any device that may have water damage.

WARNING: DO NOT place the device in a container of rice, silica gel, or desiccant packets in an attempt to dry the
device.

COPYRIGHT © 2023 RED.COM, LLC 955-0218, REV B | 240


https://support.red.com/hc/en-us/requests/new

KOMODO-X" OPERATION GUIDE

6. TROUBLESHOOTING

GENERAL TROUBLESHOOTING TIPS

This section describes general troubleshooting tips:

1. Confirm the Firmware version currently installed on your camera. Each firmware release contains bug fixes and other
improvements. You may be experiencing a bug resolved in a later release.

e You can find this under Menu>System Settings>System Status>Camera Info.

e To confirm and download the latest firmware version, visit red.com/downloads.

e If your current firmware is out-of-date, please upgrade to the latest release build found on red.com/downloads.
. Reboot the camera by powering it off and back on.
. Test the camera by installing an alternate or recently formatted media card.
. Ensure that all of the cables and connections are fully seated and locked in place (if applicable).

. Remove all attached accessories, RED and third-party. Ensure all contacts are clean, undamaged, and free of debris
before remounting. Try booting the camera using the AC power adaptor without any accessories attached to
determine whether the issue persists before reattaching any accessories.

a b~ ODN

6. Try rebooting the camera again after reattaching the accessories. If the camera boots without accessories and the
symptom reoccurs after reattaching, try adding the accessories one at a time to isolate the root cause. This helps
narrow down root causes to specific accessories and helps to ensure that a bad connection is not the source of the
issues.

7. Perform a Reset Defaults. This will restore all camera settings back to factory default settings and reduce the
possibility that applied settings caused the issue.

You can find this under Menu>Maintenance>Reset Defaults.

8. As a last resort, perform a Hard Restore. This will restore all camera settings back to factory default settings but
goes a step further to clear camera internal memory.

a. Remove all attached accessories, RED and third-party, leaving only an AC power adaptor attached.

b. Turn the camera off.

c. Press and hold the REC button and at the same time switch the power ON.

d. Continue to hold the REC button until the camera finishes booting and the license agreement displays.

This completes the hard restore.

CONTACT SUPPORT

If your camera continues to misbehave after you have performed these troubleshooting steps, submit a request for
Technical Support. Include the following with the request:

® A detailed description of the issue and events that led up to its occurrence, including steps to replicate.

® A description of the rate of occurrence confirming whether the symptom is rare, intermittent, or continuous.

® A freshly saved camera Log File. The Log File can be saved through Menu>Maintenance>Save Log. Refer to Save
Log for more information.

® Please confirm the firmware version currently installed. You can find the firmware version number under
Menu>System Settings>System Status>Camera Info.

® A short video detailing the issue that is occurring, showing your camera setup and all attached accessories.
® A detailed list of accessories (RED and third-party), lens, and modules attached at the time the issue occurred.
® A description of how the camera and attached accessories were powered when the issue first occurred.
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STATUS ICONS

The following is a table of the camera's status icons.

ICON DESCRIPTION

The CFexpress Type B media card is good (- and recording time remaining)

The media card is missing

The media card is incompatible

The sensor temperature (T) and exposure (E) calibration are good

The sensor temperature (T) requires calibration

1 ;/ E The sensor exposure (E) requires calibration

Gray indicates that no Timecode generator signal is detected

Green indicates that the Timecode source is connected and jammed

Red indicates that the Timecode source is connected and not jammed

White indicates that the Timecode source is jammed and not connected

Gray indicates that no Genlock signal is detected

Yellow indicates that the Timecode source is cross-jammed (at a different Project Time Base)

Green indicates that the camera is receiving and is locked to a Genlock signal

Red indicates that the camera is receiving and is not locked to a Genlock signal

Gray indicates that no synchronization is detected

Green indicates that the camera's sensor is synchronized with Timecode and that the camera's output
is synchronized with a Genlock signal

Yellow indicates that the camera's sensor is NOT synchronized with Timecode and that the camera's
output is synchronized with a single camera or a Genlock signal

Gray indicates that no 3D LUTs are in use

White indicates that the camera is using a 3D LUT

Camera temperature is good

Camera overheating warning

Camera overheating

.El%lﬁ
2
O
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ICON DESCRIPTION

tg‘ Camera shutting down

Gray indicates no FTPS data is transferring

Green arrows indicate FTPS data is transferring

Gray and open indicates that the camera LCD is unlocked

White and closed indicates that the camera LCD is locked

Gray and empty indicates that no Wi-Fi signal is detected

White bars indicate the strength of the Wi-Fi signal detected (Infrastructure)

D) | | = =

White antenna indicates that Wi-Fi signal is broadcasting (Ad-hoc)

—
2

~

Gray indicates that no DC power is connected

Z
>

Green indicates that the camera is receiving DC power

Gray indicates that no battery is connected

White indicates that the battery is connected and green shows the relative level of charge remaining

Yellow indicates 10 minutes of power remaining

Red indicates less than 5 minutes of power remaining

Gray question mark indicates no communication with the battery and no power

White question mark indicates no communication with the battery and power

Gray exclamation point indicates error communicating with the battery and no power

I | (5 | | o | o) | ) | o |

N

COPYRIGHT © 2023 RED.COM, LLC 955-0218, REV B | 243

~



KOMODO-X® OPERATION GUIDE

A. MECHANICAL DRAWINGS

NOTE: Dimensions are shown in mm.

FRONT VIEW

95.25

BEDM MIGITAL GOLIEMIAY

47.63

47.63

< 101.26 =

Figure: Camera Front View
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BACK VIEW
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Figure: Camera Back View
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RIGHT SIDE VIEW
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Figure: Camera Side View (Right)
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LEFT SIDE VIEW
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Figure: Camera Side View (Left)

COPYRIGHT © 2023 RED.COM, LLC 955-0218, REVB | 247



KOMODO-X® OPERATION GUIDE

TOP VIEW
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Figure: Camera Top View

COPYRIGHT © 2023 RED.COM, LLC

955-0218, REVB | 248



KOMODO-X® OPERATION GUIDE

BOTTOM VIEW
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Figure: Camera Bottom View
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FEMALE RP SMA PORT

The female RP SMA connector provides an attachment for the male RP SMA Wi-Fi antenna.

Figure: Front face of the female RP SMA port (looking at the back of the camera).

NOTE: Mating connector is a Wi-Fi antenna with a standard male RP SMA connector.
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USB TYPE-C PORT

The USB Type-C port is used primarily for data connections. The USB Type-C port provides 5
volts at 0.5 amps.

)

\—/

Figure: Front face of the USB-C port (looking at the back of the camera).

NOTE: Mating connector is a standard USB-C male connector.
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12G-SDI

The 12G-SDI male 75-ohm BNC port deliver 12, 6, 3, or 1.5 Gbps of image bandwidth ideal for
the 4Kp60 format. Other features include:

® Up to Four (4) channels of embedded audio

® Time of Day and Edge Timecode

® Record Tally flag

® Clip name information (as SMPTE RP-188 VITC2 HANC metadata)

Figure: Front face of the 12G-SDI male BNC connector (looking at the back of the camera).

12G-SDI 75-OHM MALE BNC CONNECTOR

PIN SIGNAL DESCRIPTION DIRECTION
Center 12/6/3/1.5 G-SDI Up to 4096 x 2160: 422 for 60p - Log view or LUT view (SMPTE ST  Out

Signal 2082)
Shell Ground Common ground (camera ground) N/A

NOTE: Mating connector is standard 75-ohm female BNC connector rated for 12G-SDI.

WARNING: Under certain circumstances, it is possible for an SDI connector to incur damage when connected to an
accessory and powered without using shielded cables. RED recommends only using high quality, shielded BNC cables
that are rated for 12G-SDI signals and only using shielded power cables for powering SDI accessories.

Make sure power is connected to the SDI accessory at all times before you connect the BNC to the camera.
Ungrounded power from SDI accessories can damage the camera’s SDI port. To avoid this possible damage, attach the
power source to the accessory before attaching it to the BNC cable. When using RED Approved Third Party battery
plates, unplug the BNC cable prior to hot swapping.

When possible, avoid using P-Tap (also known as D-Tap) cables to power accessories. To avoid damage when using P-
Tap/D-Tap, it’s imperative that the connect/disconnect sequence (below) is followed precisely.
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BNC ATTACHMENT INSTRUCTIONS
When attaching SDI accessories:
1. Connect a power source to the SDI accessory; power on the SDI accessory.

2. Ensure a power source is connected to the camera. This ensures both are grounded prior to connecting the BNC.
The camera's power state does not have an impact on SDI attachment sequence.

3. Connect the BNC cable to the accessory, then to the camera.

When detaching an accessory mounted to an SDI output, ensure that you remove the BNC connection to the camera
before removing power to the SDI device:
1. Shutdown the SDI accessory.

2. Disconnect the BNC cable from the camera.
3. Disconnect the power source from the SDI accessory.

When you need to swap out a battery on an accessory mounted to the camera’s SDI port, you must:
1. Shutdown the SDI accessory.

2. Disconnect the BNC cable from the camera.
3. Replace the battery on the SDI accessory.
4. Connect the BNC cable to the camera.

5. Power on the SDI accessory.

For more information, refer to Preventing Damage to SDI Outputs.
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HEADPHONE JACK

The female stereo 3.5 mm headphone port provides an attachment for stereo headphones.

NOTE: Only use headphones with a 3-conductor jack. If you try to use a headset with a mic
and 4-conductor jack, it will produce unpredictable results.

Figure: Front face of the female 3.5 mm headphone port (looking at the back of the camera).

NOTE: Mating connector is a 3.5 mm stereo headphone plug.
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AUDIO PORT

The female LEMO 5-Pin 00B audio connector accepts 2-channel audio, Line, Mic, and +48V
Phantom Power.

Figure: Front face of the female 5-Pin 00B audio connector (looking at the back of the camera).

LEMO 5-PIN 00B FEMALE AUDIO CONNECTOR

PIN SIGNAL DESCRIPTION
1 Ground Ground to camera
2 Ch3+ Channel 3 signal (positive)
3 Ch3- Channel 3 negative
4 Ch4 + Channel 4 signal (positive)
5 Ch 4 - Channel 4 negative

NOTE: Mating connectors are FGG.00.305.CLAD35Z (5-Pin 00 circular push-pull connector, straight plug) and
FHG.00.305.CLAD35Z (5-Pin 00 circular push-pull connector, right-angle plug).

Accessories:
® DSMC3™ RED® 5-Pin to Single 3.5 mm Adapter
® DSMC3™ RED® 5-Pin to Dual XLR Adapter
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EXTENSION PORT

The female 9-contact 0B ODU Extension port supports serial (RS-232 RX and TX), a General
Purpose Input (GPI) trigger (active-low switch closure), General Purpose Output (GPO),
Timecode, and Genlock. The connector also offers auxiliary 5-Volt power out, with a maximum
sustained current draw of 500 mA.

To operate the GPI contact closure style trigger, short Pin 6 (GPI) to Pin 9 (ground).

Figure: Front face of the female 9-contact Extension port (looking at the back of the camera).

NOTE: The required mating connector is 9-Pin OL Straight Plug Connector (ODU, part#
SXO0LOX-PO9MCCO0-0001).

9-PIN 0B ODU EXTENSION PORT PINOUT

PIN SIGNAL DETAILS
1 5V AUX 5 Volt AUX (500 mA Max) enabled using the Power menu
2 Timecode Out Timecode Out - SMPTE 12M!
3 GPO General Purpose Out: Recording Indicator Out, Sensor Sync Out using 3.3 volt
logic level
4 UART TX Serial RS-232 transmit (refer to the Serial menu)
5 UART RX Serial RS-232 receive (refer to the Serial menu)
6 GPI General Purpose In, 3.3-Volt logic level?
7 Timecode In Timecode In - SMPTE 12M
8 Genlock Tri-Level Genlock In (SMPTE 296M and 274M)
9 GND Signal and power ground

1. Not currently supported.

2. The signal path includes a resistor pulling the signal high, which is designed to work with a closure switch connected to GND.

COMPATIBLE CABLES
® 790-0685: RED 9-Pin EXT to Flying Lead 1.3’
® 790-0674: RED EXT to Timecode 3'
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6-PIN DC-IN

The male 6-Pin 1B DC-IN connector accepts DC input power from 11 V DC to 17 V DC. A
built-in power conditioner protects against reverse-polarity connections, electrostatic
discharge (ESD), undervoltage, overvoltage, and overcurrent.

WARNING: Both pairs of +VBATT and GROUND pins must be wired. Using a third-party
power cable that wires only one (1) pair of +VBATT and GROUND pins may damage the power
supply or the camera. Damage to the power supply or other components of the camera
system caused by using an inappropriate power cable is not covered under warranty.

@ o
@ @ |
®©®

Figure: Front face of the male 6-Pin 1B DC power input connector (looking at the back of the
camera).

6-PIN 1B DC INPUT CONNECTOR

PIN SIGNAL DESCRIPTION
1 +VBATT Power input, +11.5t0 +17 V DC
2 +VBATT Power input, +11.5 to +17 V DC
3 SCL-BATT Battery SMBus SCL signal (3.3 V)
4 GROUND Power return (camera ground)
5 GROUND Power return (camera ground)
6 SDA-BATT Battery SMBus SDA signal (3.3 V)

NOTE: Mating connector is FGJ.1B.306.CWLD72Z.

COMPATIBLE CABLES

® 790-0638: DSMC AC Power Adaptor Pack
® 790-0164: XLR Power Cable (10
® 790-0291: DSMC Battery Belt Clip
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B. MENU MAP
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AUDIO/TC
1 1 1 1 1 1 1 1 1
AUDIO INTERNAL EXTERNAL HEADPHONE TIMECODE AUTO-JAM JAM MANUAL TIMECODE
SOURCE MIC S EOE N SOURCE TOD TIMECODE TIMECODE DISPLAY
ain nable
» None » Left Gain (Ch 1)  » Ch4 Gain » Volume » Internal TOD » Enable TOTOD » Manual Entry MODE
» Internal Mic ~ » Right Gain (Ch2)  » Link 334 » Source » Internal .
» External » Link L&R » Ch 3 Source Manual » OK » Time of Day
» Internal+ » Ch 3 Limiter » External (TOD)
External » Ch 3 Limiter » PTP » Edge
Level
» Ch 4 Source
» Ch 4 Limiter
» Ch 4 Limiter
Level
MONITORING
1 1 1 1 1 1
ONBOARD TOP SDI LIVE TOOLS GUIDES
TREAM
Lcb LCD » Frequency S » False Color  » Frame Guide 1
» Brightness » Resolution » Resolution » Enable » Peaking » Frame Guide 2
» Look » Look » Look » Quality » Log View » Frame Guide 3
» Custom Display » Custom Display » Custom Display Factor » Zebra 1 » Center Guide
» Guides » Guides » Guides » Zebra 2
» Tools » Tools » Tools
» Magnify LCDs » Magnify LCDs » Magnify
» Magnify Position » Magnify Position » Magnify Position
» Prism Finder Mode  » Flip / Mirror » Overlay
» Overlay Mode
» Overlay Opacity

» Flip / Mirror
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MEDIA

1 1 1
EJECT MEDIAINFO SECURE FORMAT
» Eject » Status » Camera ID
» Model Number » Camera Position
» Serial Number » Reel Number
» Firmware Version » Edgecode
» Capcity » Format
» Available
USER » Time Remaining
SETTINGS
{ |
1 1
PRESETS USER BUTTONS
» Create Preset » Front Button
» On Media Presets  » Front Button Half Press
» In Camera Presets  » Side Button
» Side Button Half Press
AUTOFOCUS
1 1 1 1 1
ENABLE MODE SIZE POSITION = AF TOGGLE
» Enable » Single » Small » Left » Start Autofocus
» Continuous  » Medium » Upper Left Mode
» Large » Lower Left
» Wide » Center Top
» Vertical » Center
» Center Bottom
» Top Right
» Lower Right
COMMUNICATION » Right
1 1 1 1
CAMERA CONNECTIONS CLIENTS & CLOUD
» Camera Name » USB-C SERVICES UPLOAD
> Wi-Fi » FTPS » Enable
» Serial » PTP » Service
» Upload File Types
» Status
» Frame.io
»s3
» Clips Remaining
» Time Remaining
SYSTEM » Upload Remaining
» Upload Speed
SETTINGS pload Spee
1 1 1 1 1 1 1 1 1
DATE/TIME LICENSES LENS POWER SENSOR INDICATORS GPO STATUS SYSTEM
FUNCTION ETTIN TAT!
» Date » On Media Licenses  » Focal Length » DC-IN Voltage » Sync Shift » Enable Sound UNCTIO| S GS d us
» Time » In Camera Licenses P Focus Distance  » DC-IN Amperage » Sync Shift Time » Rec Start Sound » Recording Indicator Out » Shutter Display Mode » Camera Information
» Timezone » Iris » BAT Voltage » Sync Shift Time Unit > Rec Stop Sound ) Sync Out » Aperture Increments » Tomperature
» AF Status » BAT % Remaining » Tally Light » Focus Distance
»Image » BAT Time Remaining » White Balance List Mode
Stabilization » BAT Amperage » ND Display Mode
» RF Iris » Power Out
LANGUAGE Compensation » ND Increments
» Control Ring
» Control Ring
Mode
» /i Data
LANGUAGE
» English
» Chinese
» French
» German
» Japanese
» Spanish
MAINTENANCE
1 1 1 1 1 1
CALIBRATE = CALIBRATION SAVE LOG RESET FACTORY UPGRADE
- p— DEFAULTS RESET
» Calibrate » Calibration » Save Log » Upgrade
» Reset » Factory
Defaults Reset
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C. TECHNICAL SPECIFICATIONS

Technical specifications reflect both current and projected information. Everything is subject to change.

RED KOMODO-X™ CAMERA

SPECIFICATION DESCRIPTION
Sensor Type KOMODO-X™ 19.9 MP Super 35 mm Global Shutter CMOS
Effective Pixels 6144 x 3240

Sensor Size

27.03 mm x 14.26 mm (Diagonal: 30.56 mm)

Dynamic Range

16.5+ stops

Mount Type

Integrated locking RF mount with electronic communication
Supports /i PL lenses with RED RF to PL Adapters
Supports Canon EF adapter with communication and other adapters based on the RF mount

Max Data Rates

Up to 560 MB/s using RED branded or other qualified CFexpress media cards'

REDCODE® RAW
Maximum Frame Rates

80 fps at 6K 17:9 (6144 x 3240)
96 fps at 5K 17:9 (5120 x 2700)
120 fps at 4K 17:9 (4096 x 2160)
240 fps at 2K 17:9 (2048 x 1080)

Playback Frame Rates
(Project Time Base)

23.98, 24, 25, 29.97, 30, 50, 59.94, 60 fps, all resolutions

Best Available REDCODE®
Settings

REDCODE HQ, MQ, LQ, and ELQ at 6K 17:9 (6144 x 3240) up to 80 fps
REDCODE HQ, MQ, LQ, and ELQ at 4K 17:9 (4096 x 2160) up to 120 fps
REDCODE HQ, MQ, LQ, and ELQ at 2K 17:9 (2048 x 1080) up to 240 fps

REDCODE® RAW Acquisition
Formats

6K 17:9 (6144 x 3240), 2:1, 2.4:1, 16:9. 1:1, and Anamorphic 2x, 1.8x, 1.6x, 1.5x, 1.3x, 1.25x
5K 17:9 (5120 x 2700) and 16:9
4K 17:9 (4096 x 2160) and 16:9

2K 17:9 (2048 x 1080)

Apple® ProRes

Dedicated recording in 4K (4096 x 2160) ProRes 4444 XQ up to 60 fps, ProRes 4444 up to 80 fps,
and ProRes 422 HQ, ProRes 422, and ProRes 422 LT up to 120 fps

Construction Aluminum Alloy

Dimensions LxWxH=5.1inx4inx3.8in(129.37 mm x 101.26 mm x 95.26 mm) largest fixed dimensions
Weight 2.62 Ib (without body cap and CFexpress card)

Media Type CFexpress Type B

Battery Type Integrated V-Lock battery interface optimized for Micro V-Lock Batteries’

DC Power 11v-17v through a 6-pin DC-IN

Operating Temperature

0°C to 40°C (32°F to 104°F)

Storage Temperature

-20°C to 50°C (4°F to 122°F)

Relative Humidity

0% to 85% non-condensing

Color Management

Image Processing Pipeline 2 (IPP2)
Supports 33x33x33 3D LUTs
Supports import and adjustment of CDLs
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RED KOMODO-X™ CAMERA

SPECIFICATION DESCRIPTION

Audio Integrated dual channel digital mono microphones, uncompressed, 24-bit 48 kHz
Integrated dual channel (mic/line/+48V) input through a 5-Pin 00B Audio Port, uncompressed, 24-
bit 48 kHz
3.5 mm stereo headphone port

Autofocus Phase Detect and Contrast

Monitor Options Proprietary Top Accessory Port for Monitoring and Control

Integrated 2.9" 1440 x 1440 touchscreen LCD with preview and camera control
Integrated 12G-SDI with 6G-SDI, 3G-SDI and 1.5G-SDI modes

12G-SDI: Up to 4096 x 2160 4:2:2 for 60p

6G-SDI: Up to 4096 x 2160 4:2:2 for 30p

3G-SDI: Up to 2048 x 1080 4:2:2 for 60p

1.5G-SDI: Up to 2048 x 1080 4:2:2 for 30p, 24p

SMPTE Timecode, HANC Metadata, 24-bit 48 kHz Audio

Additional 110 Tri-Level Genlock Input through the 9-Pin EXT port
LTC Timecode Input through the 9-Pin EXT port
RS232 CTRL (using RCP2) through the 9-Pin EXT port

IP Connected Wi-Fi (2.4 GHz / 5 GHz) for camera control, video preview, and media offloading
Ethernet over USB Type-C for camera control, video preview, and media offloading
MJPEG 1080p live stream accessible through Wi-Fi and USB-C
PTP for frame level synchronization
R3D live broadcasting available with RED Connect license and 5Gbps Ethernet adapter

SOFTWARE
RED Control App Access full camera controls and live preview from iOS or Android devices
RED Control Pro App Pro App: Operate one or multiple cameras over an IP connection to synchronize settings, manage

media files locally or upload directly to FramelO, develop custom looks with advanced CDL and
LUT controls, and more

Ideal for control of multi-camera arrays, multi-cam shoots, and live events, all from one central
location

Standard app available from the Apple App Store and Google Play Store

RED Control Pro available via Apple App store only and requires additional purchase

RED Control works wirelessly or wired over USB-C

1. For more information on approved mount adaptors, lenses, batteries, accessories and media cards, refer to RED Third-Party Accessories
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D. ACCESSORIES

The following is a list of camera accessories. Some are optional, depending on the package you purchase:
REDVOLT® NANO-V Battery

REDVOLT® MICRO-V Battery

RED® Compact Dual V-Lock Charger

CFexpress Type B Media

KOMODO-X™ RF to PL Adapter Pack

KOMODO-X™ RF to PL with Electronic ND Adapter Pack
DSMC3™ RED® Touch 7.0" LCD

DSMC3™ RED® Touch 7.0" LCD Hood

KOMODO-X™ Power Adaptor

Outrigger Handle

RED® Compact Top Handle

KOMODO® Wing Grip

DSMC3™ RED® 5-Pin to Single 3.5 mm Adapter
DSMC3™ RED® 5-Pin to Dual XLR Adapter

RED® Pro I/0 Module

RED Control Apps

RED Connect

e 6 e o o o o o o o o o o o oo o o
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REDVOLT® NANO-V BATTERY

The REDVOLT NANO-V battery is a small, lightweight power solution for the KOMODO-X. Weighing in at only 0.63 Ib
(288 @), it is ideal for gimbals, drones, and other setups where form factor and weight matter. The battery's dimensions
(66 mm x 88 mm x 44 mm) ensure the camera retains completely flat surfaces on the top and sides, allowing users to
attach various combinations of cages and plates, without issue.

Featuring a 49 Wh capacity and with a maximum output current of 6 amps, the battery can power the KOMODO-X and
DSMC3™ RED® Touch 7.0” LCD for short durations when you want to shoot in as light a configuration as possible.

ITEM DETAILS
Type Rechargeable Lithium-lon Battery
Capacity 3300 mAh / 49 Wh

Battery output

1210 16.8 V DC

Maximum load

6 Amps at 14 V DC

Operating temperature

50° F ~ 113° F (10° G ~ 45° O)

Charging temperature

32°F ~ 104° F (0° C ~ 40° C)

Storage temperature

68° F ~ 122° F (20° C ~ 50° C)

Charger RED Compact Dual V-Lock charger
Weight Approximately 0.63 Ib (288 g)
Dimensions Height: 3.46 in. (88 mm)

Width: 2.60 in. (66 mm)

Depth: 1.30 in. (44 mm)

REDVOLT NANO-V was designed in partnership with Core SWX and is compatible with most cameras/modules that
accept V-Lock batteries. For issues or troubleshooting, please visit https://coreswx.supportsystem.com.
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REDVOLT® MICRO-V BATTERY

The REDVOLT MICRO-V 14.7 Volt V-Lock battery includes an LED charge level indicator, a P-tap port, and a USB

power port.

ITEM DETAILS

Type Rechargeable Lithium-lon Battery
Capacity 6600 mAh / 98 Wh

Battery output 14.8V DC

P-tap output 12V DC

USB output

5V DC (3 Amps)

Maximum load

12 Amps at 14V DC

Operating temperature

50° F ~ 113° F (10° C ~ 45° O)

Charging temperature

32°F ~ 104° F (0° C ~ 40° C)

Storage temperature

68° F ~ 122° F (20° C ~ 50° C)

Charger RED Compact Dual V-Lock charger
Weight Approximately 1.2 Ib (544.3 g)
Dimensions Height: 3.93 in. (99.8 mm)

Width: 2.82 in. (71.6 mm)

Depth: 1.94 in. (49.3 mm)

COMPATIBLE BATTERIES

Compatible batteries are those that provide enough current (14.4 V with 6 A or greater) to power the RED KOMODO-X,
and that also fit the dimensions on the KOMODO-X's integrated Micro V-Lock plate.

RED chose the Micro V-Lock for the KOMODO-X to keep its form-factor compact. As a result, not all V-Lock batteries
are compatible with the camera.

NOTE:

® V-Lock batteries with a width greater than 2.95 in. (75 mm) are not compatible with the camera’s Micro V-Lock plate
and will require the battery adapter.

® The camera can charge a battery that supports SMBus communication directly. To charge the battery, the camera
must be powered off while connected to DC-IN power. You can also use the optional RED Compact Dual V-Lock
charger.
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RED® COMPACT DUAL V-LOCK CHARGER

The optional RED Compact Dual V-Lock charger allows you to charge two REDVOLT batteries.

ITEM

DETAILS

Input

100 V - 240 V AC 50 Hz to 60 Hz

Charge current

One battery 3 Amps, two batteries 1.5 Amps

Charging temperature

32°F ~ 104° F (0° C ~ 40° C)

Storage temperature

68° F ~ 122° F (20° C ~ 50° C)

Battery compatibility

REDVOLT MICRO-V 14.7 V DC

Weight

Approximately 1 Ib (453.5 g)

Dimensions

Height: 4.5 in. (114.3 mm)

Width: 5.5 in. (139.7 mm)

Depth: 3 in. (76.2 mm)
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CFEXPRESS TYPE B MEDIA

A A A

A A A
IS3NB

HIGH ENDURANCE

[ED)
FEXPRE

HIGH ENDURANCE HIGH CAPAGITY

HIGH CAPACITY

A A A

HIGH CAPACITY

The RED CFexpress Type B Media provides the camera with 660 gigabyte, 1, 1.3, 2, and 4 terabyte recording options.

The 2 TB and 660 GB cards use the same hardware as do the 1.3 TB and 4 TB. The differences come from the software
and firmware, which configure the media differently to prioritize different feature sets. The 1 TB, 2 TB and 4 TB prioritize
capacity while still providing excellent durability under normal use. The 660 GB and 1.3 TB are in an overprovisioned
configuration of the same media to prioritize extended write cycles and improved thermal performance for constant

writing and re-writing of data. The underlying hardware is identical.

ITEM DETAILS

Type CFexpress Type B Media
Capacity - 660 GB High Endurance 660,138,909,696 bytes
Capacity - 1 TB High Capacity 1,099,511,627,776 bytes
Capacity - 1.3 TB High Endurance 1,331,512,536,141 bytes
Capacity - 2 TB High Capacity 2,048,480,824,832 bytes
Capacity - 4 TB High Capacity 4,096,961,649,664 bytes
Operating temperature 14° F to 158° F (-10° C to 70° C)
Operating humidity 5% to 95%, non-condensing
Storage temperature -4° F to 185° F (-20° C to 85° Q)
Shock resistance (operating) 50¢

Vibration resistance (operating) 15 g at 10 Hz to 2000 Hz
Weight Approximately 0.25 oz (7.1 g)
Dimensions Height: 1.52 in. (38.5 mm)

Width: 1.17 in. (29.6 mm)
Depth: 0.15 in. (3.8 mm)
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RED® CFEXPRESS TYPE B READER

The RED CFexpress Type B Card Reader provides a fast USB-C connection with the capability of write-protect.

Set the Write-Protect switch to the Lock position to prevent connected devices from adding any unwanted data to your
CFexpress Type B card.

S

a

/W te-Protect

ITEM DETAILS

Mediaread  CFexpress Type B

Interface USB-C 3.2 cable to CFexpress Type B
Power USB bus power

Cable USB-C 3.2 cable type A to C adapter
Weight Approximately 4.2 oz (120 g)

Dimensions  Height: 3.74 in. (95 mm)
Width: 2.56 in. (65 mm)
Depth: 0.47 in. (12 mm)
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KOMODO-X™ RF TO PL ADAPTER PACK

The RED® KOMODO-X RF to PL Adapter Pack provides a robust PL mount solution for the RED KOMODO-X.
Supporting Cooke /i lens communication, power and record triggering, the RF to PL Adapter expands the functionality
of the camera's native RF lens mount for professional applications. Constructed of a titanium core, the shimmable RF to
PL Adapter is resistant to environmental temperature changes, providing consistent and precise back focus.

The RED KOMODO-X RF to PL Adapter Pack includes both the KOMODO-X Side Ribs and Adapter Support Brackets
to provide additional rigidity and a native-like mount experience.

NOTE: KOMODO-X RF to PL adapter is not compatible with Electronic Filters.
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KOMODO-X™ RF TO PL WITH ELECTRONIC ND ADAPTER PACK

The RED® KOMODO-X RF to PL
with Electronic ND Adapter Pack
includes two filters; A clear filter for
when no ND is needed and an
Electronic ND Filter with a 2-7 stop
range. It features precise control of
Ya, 1/3 or full stop increments which
allows choosing the exact exposure
without compromising the intended

& R T aperture.
e i

Each clear and electronic ND filters
thickness are measured and paired
together to ensure no back focus
shifts when switching between filters.
ND can be controlled via the integrated buttons on the Electronic ND Filter, onboard LCD, DSMC3™ RED® Touch 7.0”
LCD, RED Control, RED Control Pro, web interface, or any other RCP2 compatible remote control, allowing for easy
access to exposure no matter how the camera is configured.

Supporting Cooke /i lens communication and record triggering, the
RF to PL Adapter w/ Electronic ND expands the functionality of the
camera's native RF lens mount for professional applications.
Constructed of a titanium core, the shimmable RF to PL Adapter is
resistant to environmental temperature changes, providing consistent
and precise back focus.

The RED KOMODO RF to PL Adapter w/ Electronic ND Filter Adapter
Pack includes both the KOMODO® Side Ribs and Adapter Support
Brackets to provide additional rigidity and a native-like mount
experience.

COMPATIBILITY: Only compatible with KOMODO and KOMODO-X.
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DSMC3™ RED® TOUCH 7.0" LCD

The optional DSMC3™ RED Touch 7.0" LCD offers an HD viewing experience for recording and viewing footage on the
V-RAPTOR™ XL camera. A 1920 x 1200 resolution display panel with peak brightness of 1300 nits and high pixel
density (at 322 ppi), not only provides the optimal experience when viewing footage, but also features 100% DCI-P3
color gamut coverage for tremendous color accuracy.

This monitor also features full control over the camera through the new responsive menu system powered by SmallHD
PageOS. The features include Waveform, Vectorscope, Histogram, False Color, Color Picker, Pixel Zoom, and more.

The lightweight display mounts to a removable integrated tilt arm with the capability to rotate 180 degrees for versatile
mounting options.

It also boasts the latest generation pogo pins to provide power and video to the monitor, and the ability to connect
through a single-locking USB-C-style DSMC3™ RMI cable for video and power. No additional SDI or power cables are
needed.

Refer to RED Monitor Interface Cable for more information.

NOTE: The USB-C-style DSMC3™ RMI cable is not a standard USB-C cable. The DSMC3™ RED Touch 7.0" LCD is
not compatible with DSMC®, DSMC2®, RED RANGER® or KOMODO® camera systems.

For more information, refer to the DSMC3™ RED® Touch 7.0" LCD User Guide.
SPECIFICATIONS

ITEM DETAILS

Material Aluminum alloy
Resolution 1920 x 1200

Pixel density 322 ppi

Refresh rate 60 Hz

Response time 25ms

Contrast 1250:1

Brightness 1300 cd/m2

Color depth 10-bit (8-bit panel)
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ITEM DETAILS

Colors 100% DCI-P3

Viewing angle + 160° all axes

Display orientation Landscape, 180° rotation

Touch pCap Multi-Touch

Camera connection Power and communication through the RMI cable
Mounting 15 mm ralil

Hood Mounting 4 x M3 mounting points

Buttons 4 buttons function 1, 2, 3 & 4

EXP Ports For future use, not currently supported

Power consumption 15.5 Watts

Operating temperature 32° F to 104° F (0° C to 38° C)

Storage temperature —0° F to 120° F (-18° C to 49° O)

Operating humidity 0% to 85%, non-condensing

Storage humidity 0% to 85%, non-condensing

Firmware requirement Compatible with V-RAPTOR firmware version 1.1 or later
Monitor dimensions Weight approximately 1.25 Ib (568.0 g)

Height: 4.67 in. (118.70 mm)

Width: 7.09 in. (180.10 mm)

Depth: 1.13 in. (28.80 mm)

Arm dimensions Weight approximately 0.07 Ib (30.1 g)

Height: 1.18 in. (30.00 mm)

Width: 2.40 in. (61.00 mm)

Depth: 0.70 in. (17.50 mm)

RED Monitor Interface (RMI) dimensions Weight approximately 0.28 Ib (126 g)

Height: 1.67 in. (42.50 mm)

Width: 4.25 in. (108.00 mm)

Depth: 1.51 in. (38.23 mm)

DSMC3™ RED® TOUCH 7.0" LCD HOOD

The DSMC3™ RED® Touch 7.0” LCD Hood attaches easily and directly to the
DSMC3™ RED® Touch 7.0” LCD and can block out the sun to make viewing the
LCD easier in bright conditions.

COMPATIBILITY: The DSMC3™ RED® Touch 7.0” LCD Hood is only compatible with
the DSMC3™ RED® Touch 7.0” LCD.

COPYRIGHT © 2023 RED.COM, LLC 955-0218, REV B | 271



KOMODO-X" OPERATION GUIDE

KOMODO-X™ POWER ADAPTOR

The KOMODO-X 150-Watt AC power adaptor connects to the camera's port to provide DC
power for operating the camera and for recharging the attached REDVOLT® MICRO-V
Battery.

The camera charges the battery when the camera is off and the power adaptor is connected.

OUTRIGGER HANDLE

The Outrigger Handle offers a low profile, 360° adjustable ergonomic pistol grip and integrated Record Start/Stop
button. Mounted to the Top Handle Port on your camera, the Outrigger Handle provides comfort, stability, and
additional 1/4-20 mounting points for your peripheral camera components. The built-in Record button puts Start/Stop
functionality right at your fingertips. You are always ready to capture the perfect shot.

The Outrigger Handle is ideal for shooters who use one hand on the handle for grip and record button access, and the
other for lens adjustments or support.
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RED® COMPACT TOP HANDLE

The RED® Compact Top Handle easily mounts to the top of the KOMODO, KOMODO-X or V-RAPTOR camera bodies
while offering a combination of comfort and utility for carrying or shooting with your camera.

This top-mounted machined handle features ergonomic Bocote wood inlays with camera trigger control.

The handle includes:

® Handle trigger

® Rear 3” piece

®* Front 1” piece

® 15 mm monitor mount

For issues or troubleshooting, contact support@cs.inc.

COMPATIBILITY: The RED Compact Top Handle is not compatible with DSMC®, DSMC2® or RED RANGER® camera
systems.

INSTALLING THE DSMC3™ RED® TOUCH 7.0" LCD ON THE TOP HANDLE

To install the RED Touch LCD to the Top Handle:

1. Align a Top Handle Extension with front of the Top Handle.

2. Tighten the hex bolt to the Top Handle.

3. Align the 15 mm Monitor Mount extension bolt with the side 3/8-16 mount hole of the Top Handle extension.
4. Tighten the Monitor Mount bolt to the Top Handle extension.

5. Align the 15 mm hole on the Monitor rail to the 15 mm Monitor Mount.

6. Slip the 15 mm Monitor rail collar over the 15 mm Monitor mount post and tighten the knurled knob on the Monitor
rail to the desired monitor position.
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KOMODO® WING GRIP

The KOMODO Wing Grip offers comfort and utility for carrying or shooting with your KOMODO-X.

Featuring an ergonomic machined grip with tactical 1/4-20
mounting points. It is lightweight and offers a seamless low-
profile hand-held option.

The KOMODO Wing Grip is a simple handle and that provides
extra mounting options for your camera.

The DSMC3™ RED® 5-Pin to Single 3.5 mm Adapter is a 11.3” (28.9
cm) cable designed to break out the 5-Pin Audio port to a single 3.5
mm TRS input allowing for 3.5 mm audio devices to be connected.

NOTES:
Length measured from end to end including connectors.

For replacement or additional components, such as screws, contact

support@cs.inc.

COMPATIBILITY: The DSMC3™ RED 5-Pin to Single 3.5 mm Adapter is not compatible with DSMC®, DSMC2®, RED
RANGER® or KOMODO® camera systems.

DSMC3™ RED® 5-PIN TO DUAL XLR ADAPTER

The DSMC3™ RED® 5-Pin to Dual XLR Adapter is a compact
solution for breaking out the 5-Pin Audio port to dual 3-Pin XLR

ports. This adapter provides two industry standard XLR ports
providing 48-volt phantom power, and mic and line input that is easily
mounted to your camera.

The Dual XLR adapter's modular design provides several mounting
options for the camera.

The Dual XLR adapter includes the following:

e Dual XLR adapter

e L-shaped mounting bracket with 2 x 3/16 screws and 4 x
Anti-Rotate pins

o A replacement %-20 mounting screw

¢ 18” Right angle-to-straight 5-Pin cable

To attach the L-shaped mounting bracket:

1. Determine the mounting position on or off of the camera. You may
need to re-position or remove the anti-rotate pins on the bracket depending on the orientation and position you want
to mount the bracket. You can also mount the bracket to the camera by using the replacement %-20 screw.

2. Screw one of the 3/16 screws in the Dual XLR adapter ensuring the anti-rotate pins line up with the desired position
of the Dual XLR adapter. Then attach the other side of the bracket to the position of your choice, confirming that the
anti-rotate pins align with holes on the camera.

NOTE: Make sure that you only pull on the knurled sleeve of the 90° angle connector on the 18” Right angle-to-straight
5-Pin cable when removing it from the Dual XLR adapter.
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RED® PRO I/0 MODULE

The RED® Pro I/0 Module offers a variety of input/ output connections, and it also includes an industry standard V-
Lock or Gold mount to power your KOMODO-X™ with higher capacity batteries. This module mounts directly to the
KOMODO-X’s rear Micro V-Lock plate and 9-Pin EXT Port, and it offers connections for the following:

® DC Power Input (DC-IN)

Genlock (BNC)

® CTRL (4-Pin)

® Timecode (5-pin)

® 1 x 3-Pin 24-volt (regulated) Fischer R/S port (3 A max)

® 2 x 2-Pin 12-volt (unregulated) AUX ports (3 A combined max)

The module also includes an operator-side screen which displays key power voltage and battery percentage information
(with compatible batteries) along with a power switch to cut power to the module when you want to leave a battery on
the module for long durations.

NOTE: The RED Pro V-Lock I/O Module is only compatible with KOMODO-X™. It is recommended to use 12 A Batteries
such a the REDVOLT® MICRO-V or REDVOLT® XL-V when using all AUX outputs simultaneously. When used with
REDVOLT® NANO-V the AUX power outputs will be disabled.

The RED® Pro I/0 Module connects to the camera through the KOMODO-X Extension Port.

CONNECTOR CONNECTOR TYPE DETAILS

24V RS 3-pin Fischer 24-volt (regulated) Fischer R/S port (3 A max)

Timecode 5-pin Connection for external Timecode device

CTRL 4-pin 00B ODU CTRL (RS-232 Control) port for external RS-232
connection

Genlock BNC Connection for external Genlock device

Module cable 9-pin OB ODU Attaches to the Extension Port

DC-IN

6-pin 1B socket

Connection for external DC power
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RED CONTROL APPS

The RED Control apps provides remote and tethered access to the camera from a device. Access is available through
Wi-Fi, USB-C, and Ethernet.

RED CONTROL
The RED Control app is free through the Google Play store and the Apple App store.

RED CONTROL
RED.com, LLC.

Rate this app

Tell others what you think

Yo ¢ Yo A

Galaxy Essentials
Mstha

Write a review

Developer contact

About this app

Take control of your KOMODO

Photography

4.9%

688 reviews

OneDrive  RED Control  Settings

Ratings and reviews ©

4.9 =

Kk kS
688

The RED Control app allows you to control all of the KOMODO features while viewing the image.

6K 179 . KOMODO F
2398 180°
6500K

800

5.6 HO

00:12:53 PROJECT TIME BASE
35 s

146V
=8

For more information about connecting the camera to RED Control, refer to the How To section (USB-C Configuration).

F501_J005
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RED CONTROL PRO

RED Control Professional allows you to control multiple RED DSMC3 cameras from an Apple iPad or an Apple Mac.

RED Control Pro is a licensed application available from the Apple App Store.
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RED control pro
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CLEAR DISC

RED CONNECT

RED Connect is a license enabled features available on either KOMODO-X, V-RAPTOR, or V-RAPTOR XL, which

streams full resolution live R3D video over an IP network by simply connecting the camera control unit (CCU) with an
Ethernet cable for KOMODO-X or with the RED Connect Module for V-RAPTOR and V-RAPTOR XL. This new feature
opens up an extraordinary range of creative applications from live broadcast to virtual production and true 8K VR (V-

RAPTOR, V-RAPTOR XL).

RED Connect Licenses are available with options for one year or perpetual.

For more information, refer to https://www.red.com/red-connect.
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